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Safety and Environmental notices

This section contains information about safety notices that are used in this guide
and environmental notices for this product.

Safety notices
Observe the safety notices when using this product. These safety notices contain
danger and caution notices. These notices are sometimes accompanied by symbols
that represent the severity of the safety condition.

Most danger or caution notices contain a reference number (Dxxx or Cxxx). Use
the reference number to check the translation in the IBM Systems Safety Notices,
G229-9054 manual.

The sections that follow define each type of safety notice and give examples.

Danger notice

A danger notice calls attention to a situation that is potentially lethal or extremely
hazardous to people. A lightning bolt symbol always accompanies a danger notice
to represent a dangerous electrical condition. A sample danger notice follows:

DANGER: An electrical outlet that is not correctly wired could place
hazardous voltage on metal parts of the system or the devices that
attach to the system. It is the responsibility of the customer to ensure
that the outlet is correctly wired and grounded to prevent an electrical
shock. (D004)

Caution notice

A caution notice calls attention to a situation that is potentially hazardous to
people because of some existing condition, or to a potentially dangerous situation
that might develop because of some unsafe practice. A caution notice can be
accompanied by one of several symbols:

If the symbol is... It means...

A generally hazardous condition not represented by other
safety symbols.

This product contains a Class II laser. Do not stare into the
beam. (C029) Laser symbols are always accompanied by the
classification of the laser as defined by the U. S.
Department of Health and Human Services (for example,
Class I, Class II, and so forth).

A hazardous condition due to mechanical movement in or
around the product.
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If the symbol is... It means...

This part or unit is heavy but has a weight smaller than 18
kg (39.7 lb). Use care when lifting, removing, or installing
this part or unit. (C008)

Sample caution notices follow:

Caution
The battery is a lithium ion battery. To avoid possible explosion, do not
burn. Exchange only with the IBM-approved part. Recycle or discard the
battery as instructed by local regulations. In the United States, IBM® has a
process for the collection of this battery. For information, call
1-800-426-4333. Have the IBM part number for the battery unit available
when you call. (C007)

Caution
The system contains circuit cards, assemblies, or both that contain lead
solder. To avoid the release of lead (Pb) into the environment, do not burn.
Discard the circuit card as instructed by local regulations. (C014)

Caution
When removing the Modular Refrigeration Unit (MRU), immediately
remove any oil residue from the MRU support shelf, floor, and any other
area to prevent injuries because of slips or falls. Do not use refrigerant
lines or connectors to lift, move, or remove the MRU. Use handholds as
instructed by service procedures. (C016)

Caution
Do not connect an IBM control unit directly to a public optical network.
The customer must use an additional connectivity device between an IBM
control unit optical adapter (that is, fibre, ESCON, FICON®) and an
external public network . Use a device such as a patch panel, a router, or a
switch. You do not need an additional connectivity device for optical fibre
connectivity that does not pass through a public network.

Power cords
For your safety, IBM provides a power cord with a grounded attachment plug to
use with this IBM product. To avoid electrical shock, always use the power cord
and plug with a properly grounded outlet.

IBM power cords used in the United States and Canada are listed by
Underwriter’s Laboratories (UL) and certified by the Canadian Standards
Association (CSA).

For units intended to be operated at 115 volts: Use a UL-listed and CSA-certified
cord set consisting of a minimum 18 AWG, Type SVT or SJT, three-conductor cord,
a maximum of 15 feet in length and a parallel blade, grounding-type attachment
plug rated 15 amperes, 125 volts.

For units intended to be operated at 230 volts (U.S. use): Use a UL-listed and
CSA-certified cord set consisting of a minimum 18 AWG, Type SVT or SJT,
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three-conductor cord, a maximum of 15 feet in length and a tandem blade,
grounding-type attachment plug rated 15 amperes, 250 volts.

For units intended to be operated at 230 volts (outside the U.S.): Use a cord set
with a grounding-type attachment plug. The cord set should have the appropriate
safety approvals for the country in which the equipment will be installed.

IBM power cords for a specific country or region are usually available only in that
country or region.

Environmental notices
The environmental notices that apply to this product are provided in the
Environmental Notices and User Guide, Z125-5823-xx manual. A copy of this manual
is located on the publications CD.

Safety and Environmental notices xiii
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Homologation statement

Attention: This product may not be certified in your country for connection by
any means whatsoever to interfaces of public telecommunications networks.
Further certification may be required by law prior to making any such connection.
Contact an IBM representative or reseller if you have any questions.
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About this document

This document provides information for using and maintaining the IBM TS7610
and TS7620 ProtecTIER® Deduplication Appliance Express® system.

Terminology
This section provides information about terminology used to describe the IBM
TS7610 and TS7620 ProtecTIER Deduplication Appliance Express system.

TS7610 and TS7620 Appliance Express

Cold-swappable components
Components that cannot be removed or replaced while the system is
running. Input/output (I/O) activity must be stopped and the server must
be disconnected from the A/C power source before removal or
replacement is started.

Attention: Failure to adhere to the above guidelines could result in
component or system damage, data loss, or personal injury.

Customer-replaceable unit (CRU)
CRU components can safely and easily be self-serviced by the customer.

External component
External components are accessible with the server's cover in place.

Field-replaceable unit (FRU)
FRU components require a higher degree of technical expertise and system
knowledge for removal and replacement than CRUs and are to be serviced
by IBM personnel only.

FRU ID
Each component has a unique FRU ID (part number). In the event that you
need to order a replacement CRU, or schedule a service call for a FRU, you
will need to provide the FRU ID to the IBM customer support
representative.

Hot-swappable components
Components that do not require stopping I/O activity or disconnecting the
server from A/C power before removing or replacing.

Internal component
Internal components are located inside the server chassis, and are
accessible only if the server's top cover is removed.

OpenStorage
OpenStorage allows ProtecTIER to be integrated with NetBackup to
provide the means for backup-to-disk without using a virtual tape library
(VTL) emulation. Using a plug-in that is installed on an
OpenStorage-enabled media server, ProtecTIER can implement a
communication protocol that supports data transfer and control between
the backup server and the ProtecTIER server. Therefore, to support the
plug-in, ProtecTIER implements a storage server emulation.

replication
A process that transfers logical objects like cartridges from one ProtecTIER
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repository to another. The replication function allows ProtecTIER
deployment to be distributed across sites. Each site has a single or
clustered ProtecTIER environment. Each ProtecTIER environment has at
least one ProtecTIER server. The ProtecTIER server that is a part of the
replication grid has two dedicated ethernet ports that are used for
replication. Replication ports are connected to the customer's WAN and are
configured on two subnets as default.

replication grid
A set of repositories that share a common ID and can potentially transmit
and receive logical objects through replication. A replication grid defines a
set of ProtecTIER repositories and actions between them. It is configured
by using the ProtecTIER Replication Manager. The ProtecTIER Replication
Manager is a software component installed on a ProtecTIER server or a
dedicated host. The ProtecTIER Replication Manager should be able to
recognize all of the members of the entire network that it handles on both
replication subnets. The ProtecTIER Replication Manager manages the
configuration of multiple replication grids in an organization. An agent on
every node in each ProtecTIER server interacts with the server and
maintains a table of its grid members.

Note: Customers must license the Replication features on all ProtecTIER
systems participating in the replication grid whether the system is sending
or receiving data (or both).

replication grid ID
A number from 0 to 63 that identifies a replication grid within an
organization.

replication grid member
A repository that is a member in a replication grid.

replication policy (FSI and VTL only)
A policy made up of rules that define a set of objects (for example, VTL
cartridges) from a source repository to be replicated to a target repository.

repository unique ID (RID)
A number that uniquely identifies the repository. The RID is created from
the replication grid ID and the repository internal ID in the grid.

replication timeframe (FSI and VTL only)
A scheduled period of time for replication to take place for all policies.

shelf A container of VTL cartridges within a ProtecTIER repository.

TS7610 Appliance Express
The short name for IBM's self-contained virtualization solution with an
integrated server and storage hardware platform, IBM TS7610 ProtecTIER
Deduplication Appliance Express.

TS7620 Appliance Express
The short name for IBM's self-contained virtualization solution with an
integrated server and storage hardware platform, IBM TS7620 ProtecTIER
Deduplication Appliance Express.

virtual tape library (VTL)
The ProtecTIER virtual tape library (VTL) service emulates traditional tape
libraries. By emulating tape libraries, ProtecTIER ProtecTIER VTL allows
you to switch to disk backup without replacing your entire backup
environment. Your existing backup application can access virtual robots to
move virtual cartridges between virtual slots and drives. The backup
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application perceives that the data is being stored on cartridges while
ProtecTIER actually stores data on a deduplicated disk repository.

visibility switching
The automated process that transfers the visibility of a VTL cartridge from
its master to its replica and vice versa. The visibility switching process is
triggered by moving a cartridge to the source library Import/Export (I/E)
slot. The cartridge will then disappear from the I/E slot and appear at the
destination library's I/E slot. To move the cartridge back to the source
library, the cartridge must be ejected to the shelf from the destination
library. The cartridge will then disappear from the destination library and
reappear at the source I/E slot.

FSI

ACL – Access Control List
A list of permissions attached to an object (file, directory, etc). An ACL
specifies which users are allowed to access an object and which operations
are allowed on the object.

AD – Windows Active Directory
Windows-based software that manages user and group authentication and
authorization between multiple servers.

Authentication
The process of presenting credentials (username/password) to a service
and having that service validate you.

Authorization
The process of granting access to resources on a server that is in the
network.

CIFS – Common Internet File System
The Microsoft file sharing protocol that supports remote mounts over
TCP/IP using the SAMBA server message block (SMB) protocol.

DNS – Domain name server
Used to lookup and translate host names and IP addresses.

FSI – File System Interface
This refers to the overall ProtecTIER File System Interface implementation.
When used in this document without any qualifiers it will refer to the
initial release supporting the CIFS interface.

Kerberos
A computer network authentication protocol that allows nodes
communicating over a non-secure network to prove their identity to one
another in a secure manner. When used in this document this term will
generally refer to the authentication protocol.

NAS - Network attached storage
Storage that may be accessed over IP networks using a variety of different
protocols such as CIFS, NFS, and HTTP.

NFS - Networked File system
A file sharing protocol that supports remote mounts over TCP/IP.

Samba
An open source package that provides a CIFS interface on a Linux server.
When used in this document this term will generally refer to the CIFS
interface.
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Stream
Once a connection has been established, the data flowing between a file
within the CIFS exported filesystem and a Windows (host) application is
referred to as a stream. Both a connection and a file can support multiple
streams according to the ProtecTIER FSI implementation.

User file system 
Pertaining to the ProtecTIER file system created by the user and presented
as a CIFS share.

Who should read this document
This publication is intended for customers, system administrators, and personnel
responsible for using and maintaining the IBM TS7610 and TS7620 ProtecTIER
Deduplication Appliance Express system.

Getting information, help, and service
If you need help, service, technical assistance, or just want more information about
IBM products, you will find a wide variety of sources available from IBM to assist
you. Available services, telephone numbers, and Web links are subject to change
without notice.

Information

IBM maintains pages on the World Wide Web where you can get information
about IBM products and services and find the latest technical information. For
more information refer to Table 1.

Table 1. IBM Web sites for help, services, and information

Description Web address (URL)

IBM home page http://www.ibm.com

Directory of worldwide
contacts

http://www.ibm.com/planetwide
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Table 1. IBM Web sites for help, services, and information (continued)

Description Web address (URL)

Support for IBM System
Storage® and TotalStorage
products

http://www.support.ibm.com

The IBM Support Portal page displays. Do the following:

1. In the Product Lookup field, begin typing TS76. As
you type, a list of matching products drops down
below the input field.

2. Select your product from the drop down list. The
product you select appears below the Search field in
the Search supports and downloads section. Items
specific to the product you selected appear in the five
areas below the Search field. You can search for
specific information, or select one of the links in the
Downloads, Product support content, Tools and
resources, Featured links, or Common support links.

3. To view a list of available fixes for your product, for
example, click on → Downloads (drivers, firmware,
PTFs).

Alternatively, you can use the Browse for a product link.

1. Click Browse for a product.

2. Expand ► System Storage.

3. Expand ► Tape systems.

4. Expand ► Tape virtualization. The page shows a list of
products.

5. Select your product from the list. The product you
select appears below the Search field in the Search
supports and downloads section.

IBM TS7610 ProtecTIER
Deduplication Appliance Express
and IBM TS7620 ProtecTIER
Deduplication Appliance Express
Customer Information Center
DVD

http://pic.dhe.ibm.com/infocenter/ts7610/cust/index.jsp

Help and service

You can call 1 (800) IBM SERV for help and service if you are in the U.S. or
Canada. You must choose the software or hardware option when calling for
assistance.

Note: This product is equipped with a Software Call Home feature. When enabled,
it will notify IBM Service of software error events. Not all countries currently
support this feature, contact your next level of support for more information.

Before calling for support, be sure to have your Software Customer Number
available.

Choose the software option if you are uncertain if the problem involves TS7610 or
TS7620 Appliance Express software or TS7610 or TS7620 Appliance Express
hardware. Choose the hardware option only if you are certain the problem solely
involves the TS7610 or TS7620 Appliance Express hardware.
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When calling IBM for service regarding the TS7610 or TS7620 Appliance Express
follow these guidelines for the software and hardware options:

Software option
Identify the TS7610 or TS7620 Appliance Express as your product and
supply your customer number as proof of purchase. The customer number
is a 7-digit numeric (0000000 to 9999999) assigned by IBM when the PID is
purchased and should be located on the customer information worksheet
or on the invoice from the software purchase.

Note: If asked for an operating system, say "Storage"

CAUTION:
If you supply an incorrect customer number you may be denied support
for your software. Please keep track of this important information at the
time of purchase.

Hardware option
Provide the serial number and appropriate 4-digit Machine Type for the
hardware component that displays a problem (for example, 3959).

Getting help online
Provides Web addresses for getting help online.

Be sure to visit the following support page for the TS7610 or TS7620 Appliance
Express, complete with FAQs, parts information, technical hints and tips, technical
publications, and downloadable files, if applicable:

http://www.ibm.com/servers/storage/support/tape

For additional information, see “Websites” on page xxiii.

Before you call for service
Some problems can be solved without outside assistance, by looking in the online
or printed documentation that comes with the TS7610 Appliance Express, or by
consulting the support Web page.

Be sure to read the information in any README files and release notes that come
with the TS7610 Appliance Express.

Getting help by telephone
With the original purchase of the IBM TS7610 and TS7620 ProtecTIER
Deduplication Appliance Express, you have access to extensive support coverage.
During the product warranty period, you can call the IBM Support Center
(1-800-426-7378 in the U.S.) for product assistance covered under the terms of the
hardware IBM warranty or the software maintenance contract that comes with
product purchase.

Important: The TS7610 or TS7620 Appliance Express hardware components have
additional support requirements and restrictions. If you experience problems with
the hardware installation, refer to the IBM TS7620 ProtecTIER Deduplication
Appliance Express Installation and Setup Guide for VTL, and OpenStorage Systems, v3.3,
GA32-0914.

When calling, have the following information available for the component:
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v The machine type and serial number, or the software identifier. The software
identifier can be either the product name (TS7610 or TS7620 Appliance Express)
or the Product Identification (PID) number.

v The serial number or your proof of purchase.
v A description of the problem.
v The exact wording of any error messages.
v The hardware and software configuration information

If possible, have access to your computer when you call.

In the US and Canada, these services are available 24 hours a day, 7 days a week.
In the UK, these services are available Monday through Friday, from 9:00 a.m. to
6:00 p.m. In all other countries, contact your IBM reseller or IBM marketing
representative.

Websites
The most up to date information about the IBM TS7610 ProtecTIER Deduplication
Appliance Express, including documentation and the most recent downloads, can
be found at the following websites:
v The translated publications for this product are included with the product. These

documents and product specification sheets are also available from the following
website:
http://www-947.ibm.com/systems/support/supportsite.wss/
brandmain?brandind=5345868

v You can order publications through the IBM Publications Ordering System at the
following website:
http://www.elink.ibmlink.ibm.com/publications/servlet/pbi.wss

v Access installation and technical support information via the web at:
www.ibm.com/support

v Access the IBM System Storage TS7610 ProtecTIER Deduplication Appliance
Express Customer Information Center at:
http://pic.dhe.ibm.com/infocenter/ts7610/cust/index.jsp

v The IBM HBA search Web site is:
http://www-01.ibm.com/systems/support/storage/config/hba/index.wss

v The IBM Web site for Independent Software Vendor (ISV) support is:
http://www-304.ibm.com/jct01005c/isv/index.html

v To access the IBM TS7650G Interoperability Matrix Web site, go to:
http://www-03.ibm.com/systems/support/storage/config/ssic/
displayesssearchwithoutjs.wss?start_over=yes

v For the latest information about SAN switches and directors, go to the following
Web site:
www.ibm.com/servers/storage/san

v For accessibility information, go to the following Web site:
http://www-03.ibm.com/able/product_accessibility/index.html

v For the latest information about product recycling programs, go to the following
Web site:
www.ibm.com/ibm/environment/products/prp.shtml
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Related IBM publications
The following documents provide information about theIBM TS7610 ProtecTIER
Deduplication Appliance Express system and recommended additional hardware
components.

IBM TS7610 ProtecTIER Deduplication Appliance Express
publications

The following publications provide additional documentation about the TS7610
Appliance Express server:
v IBM TS7610 ProtecTIER Deduplication Appliance Express Introduction and Planning

Guide, v3.3, GA32-0914
v IBM TS7620 ProtecTIER Deduplication Appliance Express Installation and Setup

Guide for VTL, and OpenStorage Systems, v3.3, GA32-0914
v IBM TS7610 and TS7620 ProtecTIER Deduplication Appliance Express Service Guide,

v3.3, GA32-0915
v Best Practices Guide for IBM TS7600 ProtecTIER Deduplication Solutions, v3.3,

GA32-0924
v IBM TS7610 and TS7620 ProtecTIER Deduplication Appliance Express Software

Upgrade Guide, v3.3, SC27-3641

For additional information, see the IBM TS7610 ProtecTIER Deduplication Appliance
Express and IBM TS7620 ProtecTIER Deduplication Appliance Express Customer
Information Center DVD.

How to send your comments
Your feedback is important in helping to provide the most accurate and highest
quality information.

To submit any comments about this book or any other IBM System Storage TS7600
with ProtecTIER documentation:
v Send your comments by email to starpubs@us.ibm.com. Be sure to include the

following information:
– Exact publication title and version
– Publication form number (for example, GC53-1196-03)
– Page, table, or illustration numbers that you are commenting on with a

detailed description of any information that should be changed
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Part 1. Preparing to work with ProtecTIER

This section of the guide describes the steps for completing the ProtecTIER system
setup for new installations and upgrading ProtecTIER servers.

In addition, this part describes how to install and configure the ProtecTIER
Manager software and how to manage repositories.
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Chapter 1. Introduction

The TS7600 ProtecTIER Deduplication Solutions, V3.3.6.1 are advanced disk-based
storage systems.

ProtecTIER is a disk-based data storage system. It uses data deduplication
technology to store data to disk arrays. The ProtecTIER VTL service emulates
traditional automated tape libraries. ProtecTIER OpenStorage implements a storage
server emulation, which enables ProtecTIER to serve as a network-attached storage
(NAS) backup target.

Before you use ProtecTIER and this document, ensure that you complete the
planning, preparation, and installation tasks. These tasks are described in the
following publications:
v IBM TS7610 ProtecTIER Deduplication Appliance Express Introduction and Planning

Guide, v3.3, GA32-0914
v IBM TS7620 ProtecTIER Deduplication Appliance Express Installation and Setup

Guide for VTL, and OpenStorage Systems, v3.3, GA32-0914.

HyperFactor
This topic describes IBM data factoring technology, known as HyperFactor®.

ProtecTIER is the first virtual tape product to contain patented data deduplication
technology that IBM calls HyperFactor. This technology detects recurring data in
multiple backups. The common data is merged into a single instance store, saving
disk space needed to store multiple backups without sacrificing performance or the
availability of backups.

HyperFactor is a breakthrough on several fronts:
v It is scalable up to 1024 TB.
v The algorithm used to find the common data between backups does not affect

the backup performance of the virtual tape engine.
v Data integrity is not compromised, not even statistically.
v Merged data is stored in a format that preserves restore performance.

HyperFactor saves space by taking advantage of the fact that only a small
percentage of data actually changes from backup to backup. Incremental backups
include all files with modification dates that have changed since the last full or
incremental backup. Full backups store all the data, changed or not.

The amount of space saved depends on many factors, mostly of the backup
policies and retention periods and the variance of the data between them. The
more full backups retained on ProtecTIER, and the more intervening incremental
backups, the more overall space saved.

ProtecTIER Virtual Tape
The ProtecTIER Virtual Tape service acts like a traditional tape drive.
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The ProtecTIER Virtual Tape (VT) service emulates traditional tape libraries.
Because ProtecTIER VT emulates tape libraries, you can switch to disk backup
without replacing your entire backup environment. Your existing backup
application can access virtual robots to move virtual cartridges between virtual
slots and drives. The backup application perceives that the data is being stored on
cartridges while ProtecTIER stores data on a deduplicated disk repository on the
storage fabric.

ProtecTIER OpenStorage
This topic provides an overview of the ProtecTIER OpenStorage service.

With OpenStorage (OST), ProtecTIER can be integrated with NetBackup to provide
the means for backup-to-disk without having to emulate traditional tape libraries.
Using a plugin installed on an OST-enabled media server, ProtecTIER can
implement a communication protocol that supports data transfer and control
between the backup server and the ProtecTIER server. To support the plugin,
ProtecTIER implements a storage server emulation.

ProtecTIER File System Interface (FSI)
This topic provides an overview of the ProtecTIER File System Interface (FSI).

With FSI, ProtecTIER emulates a network attached storage (NAS) backup target
capable of using HyperFactor, as well as ProtecTIER Native Replication bandwidth
reduction techniques for storing and replicating deduplicated data. ProtecTIER FSI
enables backup servers running backup applications to connect over IP networks
to ProtecTIER, without the use of FC connectivity and allows customers to use
their existing tools and capabilities to integrate a ProtecTIER NAS-based backup
target into your environment.

ProtecTIER Manager
This topic provides an overview of the ProtecTIER Manager software.

The ProtecTIER Manager application can be installed on one or more workstations,
enabling you to monitor the status of nodes in your ProtecTIER system along with
the accompanying repositories and services. ProtecTIER Manager is used to
initially configure your ProtecTIER system and to change the configuration.
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Figure 1. OpenStorage emulation
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Configuration
The following information provides an overview of the ProtecTIER system
configuration.

The TS7610 or TS7620 Appliance Express system is a one-node system. A one-node
system uses a single server to transfer data from the backup server to the storage
fabric, as illustrated in the following figure:

▌1▐ ProtecTIER Manager workstations (supplied by customer)
▌2▐ Main backup server (supplied by customer)
▌3▐ Fibre Channel cable connection (cable that is supplied by customer) for VTL
and Ethernet cable (cable that is supplied by customer) for OST or FSI
▌4▐ TS7610 Appliance Express server

The TS7610 or TS7620 Appliance Express connects to the backup server. The
backup server connects to one or more ProtecTIER Manager workstations that can
be used to manage the ProtecTIER system.

Native replication
Native replication lets you replicate between repositories connected to a wide area
network (WAN) with TCP/IP protocol.

Replication enables you to set rules (depending on your required replication needs)
for replicating data objects across ProtecTIER repositories. The ProtecTIER
repositories can be different in size as well as physical layout. Since ProtecTIER
deduplicates data before storing it, only the changes are transferred to the remote
site. You define the rules for replicating data objects in replication policies on a
repository.

A replication grid is a logical set of repositories that can replicate from one to the
other. The ProtecTIER Replication Manager is a server that remotely manages the
configuration of the grid (for example, grid creation or deletion, repository
membership in the grid, and so on). In most cases, the ProtecTIER Replication
Manager resides on the ProtecTIER server.
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1

Figure 2. One node system
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Before defining replication policies, however, you must first create physical
connections between the repositories. To create physical connections, you define
replication groups. Depending on your environment, you create replication groups
in either "many-to-one" or "many-to-many" topologies.

In a "many-to-one" topology, you create replication groups in which source
repositories can receive local backups and replicate to a single destination. The
destination repository can then act as a Disaster Recovery site for any number of
the source repositories, and still allow local backups, as well as replication, from
the active source repositories.

In a "many-to-many" topology, you create replication groups where multiple
repositories can replicate to each other. You can define a many-to-many replication
group where each repository assumes the responsibility of a destination repository
and can receive local backups, replicate data to remote repositories, and receive
replicated data from remote repositories.
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Chapter 2. Completing the ProtecTIER system setup for new
installations

This chapter details the prerequisites for completing the ProtecTIER system setup
for new installations. Configuring the node is described in the IBM TS7620
ProtecTIER Deduplication Appliance Express Installation and Setup Guide for VTL, and
OpenStorage Systems, v3.3, GA32-0914.

If you are upgrading the ProtecTIER system, refer to the IBM TS7650 ProtecTIER
Software Upgrade Guide, V3.3.6.1, SC27-3643.

Use the ProtecTIER Service menu to complete the ProtecTIER configuration process
that was started in manufacturing. If you are working on a TS7650G, some or all of
these configurations may have already been done during the node configuration.

Note: Throughout this chapter the terms server and node are used
interchangeably, depending upon the task being performed.

Accessing the ProtecTIER Service menu
Complete this task to access the ProtecTIER Service menu.

Procedure
1. Connect a USB keyboard and graphics-capable monitor to the server.
2. Verify that the server is running:
v If it is, go on to step 3.
v If it is not running: power it on now, wait for the boot cycle to complete, and

then go on to step 3.
3. At the localhost Login prompt, type ptconfig and press Enter.
4. At the Password prompt, type ptconfig and press Enter.

The ProtecTIER Service Menu displays:

------------------------------------------------------------------------------
ProtecTIER Service Menu running on rassmx

------------------------------------------------------------------------------
1) ProtecTIER Configuration (...)
2) Manage ProtecTIER services (...)
3) Health Monitoring (...)
4) Problem Alerting (...)
5) Version Information (...)
6) Generate a service report
7) Generate a system view
8) Update ProtecTIER code

E) Exit
------------------------------------------------------------------------------
>>> Your choice?

5. Go on to “Customizing the ProtecTIER server”

Customizing the ProtecTIER server
Complete this task to customize the ProtecTIER server.
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About this task

Perform the following steps to configure the server by using the ProtecTIER
Service menu:

Procedure
1. On the server, if it is not already displayed, access the ProtecTIER Service

menu. See “Accessing the ProtecTIER Service menu” on page 7.
2. Select the ProtecTIER Configuration (...) option. Type the corresponding

number and press Enter. The ProtecTIER Configuration (...) menu appears.

------------------------------------------------------------------------------
ProtecTIER Service Menu running on rassmx
ProtecTIER Configuration (...)

------------------------------------------------------------------------------
1) Configure ProtecTIER node
2) Recover Configuration for a replaced server
3) Configure enclosure serial number for a replaced enclosure
4) Update Time, Date, Timezone & Timeserver(s)
5) Configure replication (...)
6) IP Network configuration (...)
7) Update Firmware
8) Update the System’s name
9) Validate configuration

10) Single node - code upgrade (For Support Use ONLY)

B) Back
E) Exit

------------------------------------------------------------------------------
>>> Your choice?

3. Select the IP Network configuration (...) option. Type the corresponding
number and press Enter. The IP Network configuration (...) menu appears.

------------------------------------------------------------------------------
ProtecTIER Service Menu running on rassmx
ProtecTIER Configuration (...)
IP Network Configuration (...)

------------------------------------------------------------------------------
1) Configure hostname
2) Configure ProtecTIER’s IP interfaces
3) Configure Static Routes

B) Back
E) Exit

------------------------------------------------------------------------------
>>> Your choice?

4. Select the option Configure ProtecTIER's IP interfaces to configure external.
Type the corresponding number and press Enter.
If asked if you would like to stop the vtfd service, type yes and press Enter.
The following status message displays as the system initiates shutdown:
Stopping VTFD [/]
The shutdown process may take a few minutes to complete.

When shutdown completes, the following status message appears:
Stopping RAS [ Done ]
Stopping VTFD [ Done ]

5. Change the server IP address, netmask, default gateway, and host name
factory-set values, to the values specific to the customer environment.
a. You are prompted, one at a time to enter the following values. At each

prompt, type the new value and then press <Enter>:
v Customer Network IP address
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v Customer Network netmask
v Customer Network default gateway
v Customer Network hostname (The fully qualified hostname of the server.

For example: hostname.domain.com)
After you enter the hostname, the system automatically starts the network
configuration process. The following status messages display:
Configuring network [ Done ]
Updated network configuration successfully
update updateNetwork ended successfully

The system automatically restarts the vtfd service, and you are returned to
the command prompt.

6. Change the system name from the one assigned during manufacturing to one
specific to the customer environment. To do so:
a. From the ProtecTIER Configuration (...) menu, select the Update System

Name option. Type the number of your choice and press Enter.
b. When prompted, type the new system name of the server and press Enter.

Note: The system name that was assigned to the server in manufacturing
appears in brackets after the prompt. For example: [PORTLAND]. After you
enter the system name, the system automatically starts the Update the
System Name process. The following status message appears:
Changing system name [ Done ]
Updated system name successfully
UpdateSystemName ended successfully

End Processing Procedure Successfully

Press Enter to continue and return to the command prompt.
7. When you are finished, go on to Chapter 4, “Installing ProtecTIER Manager,”

on page 25.

Configuring static routes
Complete this task to configure the static routes for replication.

About this task

In this task you will provide information about your source server(s) and the target
server(s), in order to define the static routes.

For assistance with this task, refer to the information on your completed Configure
Static Route for Replication worksheet(s).

Run this procedure on the source server(s) to configure the addresses of all the
destination systems and the node on which the ProtecTIER Replication Manager is
activated. On the destination server(s), run this procedure to configure the
addresses of the source system(s).

On the ProtecTIER Replication Manager node, all the systems (source and
destination) must be configured.

Procedure
1. Access the ProtecTIER Configuration Menu. See “Accessing the ProtecTIER

Service menu” on page 7.
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2. From the ProtecTIER Service Menu, select ProtecTIER Configuration (...).
Type the corresponding number and press Enter. The ProtecTIER
Configuration (...) menu is displayed.

------------------------------------------------------------------------------
ProtecTIER Service Menu running on rassmx
ProtecTIER Configuration (...)

------------------------------------------------------------------------------
1) Configure ProtecTIER node
2) Recover Configuration for a replaced server
3) Configure enclosure serial number for a replaced enclosure
4) Update Time, Date, Timezone & Timeserver(s)
5) Configure replication (...)
6) IP Network configuration (...)
7) Update Firmware
8) Update the System’s name
9) Validate configuration

10) Single node - code upgrade (For Support Use ONLY)

B) Back
E) Exit

------------------------------------------------------------------------------
>>> Your choice?

3. Select Configure replication (...). Type the corresponding number and
press Enter. The Configure replication (...) menu is displayed.

------------------------------------------------------------------------------
ProtecTIER Service Menu running on rassmx
ProtecTIER Configuration (...)
Configure Replication (...)

------------------------------------------------------------------------------

1) Configure/Unconfigure ProtecTIER Replication Manager on this node
2) Configure Static Routes

B) Back
E) Exit

------------------------------------------------------------------------------
>>> Your choice?

4. Select Configure Static routes. Type the corresponding number and press
Enter.
The message: Gathering System information [Done] displays, followed by a
summary of the information that was retrieved for the server on which you
are currently working. For example:

ID
Target Network
Address Target Netmask

Local Gateway
Address

1 10.11.195.0 255.255.255.0 10.11.195.1

2 10.11.197.0 255.255.255.0 10.11.197.1

Following the summary, the Available Options prompt displays:
Available Options:

==================

(a)dd a new record

(e)dit a record

(d)elete a record

(c)ommit changes

(q)uit

Please Choose (a,e,d,c,q):

10 IBM TS7610 and TS7620 ProtecTIER Deduplication Appliance Express: ProtecTIER User's Guide for VTL Systems



5. Select (a)dd a new record. Type a and press Enter.
You are prompted to enter information for the first destination (target) server
and the local network.

6. At each prompt, type the requested information and then press Enter:
Please provide the following information:

Target Network Address:
This is the starting network address of the Target (Hub) server. For example:
10.11.194.0.
Target Netmask:
This is the network netmask address of the Target (Hub) server. For example:
255.255.255.0.
Local Gateway Address:
This is the gateway IP address of the local server you are currently working
on. For example: 10.11.195.1.
A summary of the information you provided, displays. For example:

ID
Target
Network Address Target Netmask

Local Gateway
Address

1 10.11.194.0 255.255.255.0 10.11.195.1

Note: The addresses in the above summary are examples. Your actual values
will vary.
The Available Options prompt displays a second time:
Available Options:

==================

(a)dd a new record

(e)dit a record

(d)elete a record

(c)ommit changes

(q)uit

Please Choose (a,e,d,c,q):

7. Type a and press Enter.
You are prompted for the information for the second destination (target -
ETH2) server and the local network.

8. At each prompt, type the requested information and then press Enter:
Please provide the following information:

Target Network Address:
This is the starting network address of the Target (Hub) server. For example:
10.11.196.0.
Target Netmask:
This is the network netmask address of the Target (Hub) server. For example:
255.255.255.0.
Local Gateway Address:
This is the gateway IP address of the local server you are currently working
on. For example: 10.11.197.1

An updated summary displays:
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ID
Target
Network Address Target Netmask

Local Gateway
Address

1 10.11.194.0 255.255.255.0 10.11.195.1

2 10.11.196.0 255.255.255.0 10.11.197.1

Note: The addresses in the above summary are examples. Your actual values
will vary.
The Available Options prompt displays a third time:
Available Options:

==================

(a)dd a new record

(e)dit a record

(d)elete a record

(c)ommit changes

(q)uit

Please Choose (a,e,d,c,q):

9. Type: q <enter>
The Would you like to commit the changes performed to the routing table
now? (yes|no) message, displays.

10. Type yes and press Enter.
The Successfully committed changes! message displays.

11. Press Enter to return to the ProtecTIER Configuration Menu.
12. Quit the menu to exit. Type q and press Enter. You are returned to the login

prompt.
13. Configuration for one source server and the destination server, is now

complete. Confirm that your replication configuration was successful. To do
so, refer to the instructions in Chapter 9, “Native Replication Management (for
VTL),” on page 89.

Setting the timezone
Use the procedures in this task to change the time zone setting to match that of
your location. You must set the timezone to ensure accurate system timekeeping.

Procedure
1. On the ProtecTIER Configuration (...) menu (see “Setting the timezone”), select

the Update Time, Date, Timezone & Timeserver(s) option. Type the
corresponding number for this selection and press Enter.
The Date, Time, Timezone & Timeserver(s) configuration menu, displays:
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Note: To prevent selections from scrolling off the screen, consider setting the
paging to show fewer lines of information.

2. Select the Set Timezone option. Type the corresponding number and press
Enter.

3. If you are in the United States, when prompted for a country code, type: US
and press Enter.
For locations outside the United States, you must enter an international country
code. Refer to Appendix C, “Worldwide time zone codes,” on page 243 to locate
your information, then return to this task and enter the appropriate country
code in step “Setting the timezone” on page 12.
The time zones for the specified country display. A sample of the US time
zones list is shown in “Setting the timezone” on page 12:

------------------------------------------------------------------------------
ProtecTIER Service Menu running on rassmx

Date, Time, Timezone & Timeserver(s) configuration
------------------------------------------------------------------------------

1. Set date & time
2. Set Timezone
3. Set Timeserver(s)

c. Commit changes and exit
q. Exit without committing changes

------------------------------------------------------------------------------
>>> Please Choose:

Figure 3. Date, Time, Timezone & Timeserver(s) configuration menu

Time zones under US:
====================

1. America/New_York
2. America/Detroit
3. America/Kentucky/Louisville
4. America/Kentucky/Monticello
5. America/Indiana/Indianapolis
6. America/Indiana/Vincennes
7. America/Indiana/Winamac
8. America/Indiana/Marengo
9. America/Indiana/Petersburg
10. America/Indiana/Vevay
11. America/Chicago
12. America/Indiana/Tell_City
13. America/Indiana/Knox
14. America/Menominee
15. America/North_Dakota/Center
16. America/North_Dakota/New_Salem
17. America/Denver
18. America/Boise
19. America/Shiprock
20. America/Phoenix
21. America/Los_Angeles
22. America/Anchorage
23. America/Juneau
24. America/Yakutat
25. America/Nome
26. America/Adak

Press <Enter>

27. Pacific/Honolulu

Please choose a timezone:

Figure 4. Sample of US time zones
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4. If the Press enter to continue prompt displays, the time zone list is too long
to display on the screen at once. Press Enter to advance the list.

5. At the Please choose a timezone: prompt, type the number that corresponds
to your timezone and press Enter to return to the Date, Time, Timezone &
Timeserver(s) configuration menu. Type: c for commit and press Enter.
The current time, date, and timezone settings display for review.

6. At the Do you wish to apply those settings? (yes|no) prompt, type: yes and
press Enter.
The following message appears: The cluster & VTFD services on all nodes
must be stopped in order to continue. Do you wish to continue? (yes|no).
Type: yes and press Enter.
A series of status messages appears as the services are stopped and restarted.
This process might take up to 10 minutes. When the service restart is complete,
the Press the ENTER key to continue... message appears.

7. Press Enter to continue and return to the ProtecTIER Configuration (...) menu.

Setting the date and time
Each server contains a battery that must be calibrated.

About this task

Use the procedures in this task to check the time and date on the server. If
necessary, change the settings to match the time and date at your location.

Important: With Version 3.3.6 and later, you must apply each change you make to
the timezone, date and time, and time server individually before proceeding to the
next task.

Procedure
1. On the ProtecTIER Configuration (...) menu (see “Setting the date and time”),

select the Update Time, Date, Timezone & Timeserver(s) option. Type the
corresponding number for this selection and press Enter.
The Date, Time, Timezone & Timeserver(s) configuration menu, displays:

2. On the Date, Time, Timezone & Timeserver(s) configuration menu (see
“Setting the date and time”), select the Set date & time option. Type the
corresponding number and press Enter.

3. When prompted for the date:
v If the default date [displayed in brackets] is correct, press Enter.
v If the default date is incorrect, type the current date in DD/MM/YYYY

format and press Enter. For example, 09/01/2012.
4. When prompted for the time:
v If the default time [displayed in brackets] is correct, press Enter.
v If the default time is incorrect, type the current time in HH:MM:SS format

and press Enter. For example:08:32:58.
5. At the Please choose: prompt, commit your date and time settings To commit,

type: c and press Enter.
The current time, date, and timezone settings display for review.

6. At the Do you wish to apply those settings? (yes|no) prompt, type: yes and
press Enter.
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You are notified as follows: The cluster & VTFD services on all nodes must
be stopped in order to continue. Do you wish to continue? (yes|no).
Type: yes and press Enter.
A series of status messages appears as the services are stopped and restarted.
This process might take up to 10 minutes. When the service restart is complete,
the Press the ENTER key to continue... message displays.

7. Press Enter to continue and return to the ProtecTIER Configuration (...) menu.

ProtecTIER Network Performance Validation Utility
The objective of the pt_net_perf_util is to test maximal network performance in
order to discover potential performance bottlenecks. On VTL systems, the utility
tests maximal replication performance between two future ProtecTIER VTL
repositories by emulating the network usage patterns of the ProtecTIER Native
Replication component. On OpenStorage systems, the utility tests network
performance between an OpenStorage host and a ProtecTIER server to identify
possible bottlenecks in a backup and restore scenario.

ProtecTIER Replication Network Performance Validation Utility for VTL
Systems

The objective of the VTL pt_net_perf_util utility is to test maximal replication
performance between two future ProtecTIER VTL repositories by emulating the
network usage patterns of the ProtecTIER Native Replication component. This
utility can not predict replication performance, but it can discover performance
bottlenecks.

Before you begin

The requirements of this utility are as follows:
v Red Hat Linux version 5.6 or Red Hat Linux version 5.4
v Standard external utilities expected to be in the current path: ping, netstat,

getopt, echo.

The pt_net_perf_util utility and the iperf tool are part of the ProtecTIER software
installation. To test the replication performance, use the following tool:
v iperf 2.0.4

/usr/local/bin/iperf

This utility has two modes of operation, client and server. The server has to be
started before the client. Before running the utility, shut down all other programs
on both the client and server ProtecTIER systems. The client is the ProtecTIER
system that transmits the test data and the server is the ProtecTIER system that
receives the data (also known as the target server). Based on the data sent by the
client and received by the server, the script outputs key network parameter values
which indicate certain attributes of the network. The goal of these tests is to
benchmark the throughput of the network. The most important benchmark is the
direction that replication actually takes place, that is, test the target as the server
since the flow of data will be to that server from the client. However, it is also
important to also test the reverse direction to measure the bandwidth performance
during disaster recovery failback. Network bandwidth is not always the same in
both directions.
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Before you can run the utility you must configure the replication ports on both the
source and destination servers and define static routes between them in both
directions.

About this task

In the following procedure, the goal is to test network performance between two
machines on a WAN, server1 and server2. Each test runs for five minutes. Since
there are five tests, the process takes a total of 25 minutes.

Repeat these tests for each server and for each replication port on the server (two
tests total per server, one for each replication port).

Procedure
1. At the login prompt, log in with user name ptconfig and password ptconfig.

Press Enter. On the command line, type menu and press Enter. The ProtecTIER
Service Menu is displayed.

------------------------------------------------------------------------------
ProtecTIER Service Menu running on rassmx

------------------------------------------------------------------------------
1) ProtecTIER Configuration (...)
2) Manage ProtecTIER services (...)
3) Health Monitoring (...)
4) Problem Alerting (...)
5) Version Information (...)
6) Generate a service report
7) Generate a system view
8) Update ProtecTIER code

E) Exit
------------------------------------------------------------------------------
>>> Your choice?

2. Stop the VTFD services.
a. Select the option to Manage ProtecTIER services.
b. The Manage ProtecTIER services menu is displayed.

------------------------------------------------------------------------------
ProtecTIER Service Menu running on rassmx
Manage ProtecTIER Services (...)

------------------------------------------------------------------------------
1) Display services status
2) Start all services
3) Stop all services
4) Stop ProtecTIER services only (including GFS)
5) Stope VTFD service only (indluding GFS)
6) Poweroff This Node
7) Reboot This Node

B) Back
E) Exit

------------------------------------------------------------------------------
>>> Your choice?

c. Select the option to Stop ProtecTIER services only (including GFS).

Note: You can also stop the VTFD services from the command line. From the
command line on the server, type the following command and press Enter:
service vtfd stop

3. Wait for the services to stop. A message similar to the following displays:
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Shutting down vtfd: [ OK ]

Please wait ...........................................................
[root@austin ~]#

4. Start the server mode of the utility on server1 by entering the following
commands on the command line:
cd /opt/dtc/app/sbin
./pt_net_perf_util -s

5. Start the client mode of the utility on server2 by entering the following
command on the command line:
cd /opt/dtc/app/sbin
./pt_net_perf_util -c <x.x.x.x> -t 300

Where <x.x.x.x> is the IP address of the server replication port.
6. The utility automatically performs the tests in sequence. The client output

(server2 in the example shown) looks similar to the following:

Note: In the sample output below the test ran for only 5 seconds instead of
300.
*** Latency
PING 9.5.53.33 (9.5.53.33) 56(84) bytes of data.

--- 9.5.53.33 ping statistics ---
5 packets transmitted, 5 received, 0% packet loss, time 4001ms
rtt min/avg/max/mdev = 0.257/0.406/0.484/0.079 ms

*** Throughput - Default TCP
[ 3] 0.0- 5.0 sec 56.6 MBytes 94.8 Mbits/sec

*** Throughput - 1 TCP stream(s), 1MB send buffer
[ 3] 0.0- 5.0 sec 57.0 MBytes 95.0 Mbits/sec

*** Throughput - 16 TCP stream(s), 1MB send buffer
[SUM] 0.0- 5.8 sec 65.0 MBytes 94.3 Mbits/sec

*** Throughput - 127 TCP stream(s), 1MB send buffer
[SUM] 0.0-11.3 sec 127 MBytes 94.1 Mbits/sec

Number of TCP segments sent: 230536
Number of TCP retransmissions detected: 21 (0%)

Done.

See the next section for information about interpreting the results of the tests.

Interpreting the results

The utility performs five foreground tests (Tests 1-5 below), and one background
test (Test 6 below). The example outputs shown are from the client side. Each of
the first five tests ran for 300 seconds (-t 300), while the last test monitored TCP
performance during that time.

Test 1: Latency

This test checks the nominal network link latency and packet loss. Example result:
*** Latency
PING 10.0.13.194 (10.0.13.194) 56(84) bytes of data.
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--- 10.0.13.194 ping statistics ---
120 packets transmitted, 120 received, 0% packet loss, time 119060ms
rtt min/avg/max/mdev = 57.403/78.491/104.451/9.872 ms

Interpreting the results:
v The average round-trip-time (rtt) was 78.4 ms and there was 0% packet loss.
v The latency in WAN topologies can vary, but should never exceed 200 ms.

Contact your network administrator if latency reports more than 200 ms, as it
can significantly decrease replication throughput.

v Higher latency values can cause a major deterioration in replication throughput.
v Packet loss should be 0%. Any other value indicates a major network problem.

Test 2: Throughput - default settings

This test checks maximal TCP throughput of a single data stream with default TCP
settings. Example result:

*** Throughput - Default TCP
[ 3] 0.0-120.1 sec 2.41 GBytes 173 Mbits/sec

Interpreting the results:
v The test ran for 120.1 seconds, transferred 2.41 GB (2.24 GiB), with an average

throughput of 173 Mbits/sec.

Note: 1 MByte = 1,048,576 bytes. 1 Mbit/sec = 1,000,000 bits/sec.

Test 3: Throughput - single stream, 1 MB send buffer

This test checks maximal TCP throughput of a single data stream with a 1 MB
(0.95 MiB) send buffer. Example result:

*** Throughput - 1 TCP stream(s), 1MB send buffer
[ 3] 0.0-120.0 sec 2.51 GBytes 180 Mbits/sec

Interpreting the results:
v The test ran for 120.0 seconds, transferred 2.51 GB (2.34 GiB), with an average

throughput of 180 Mbits/sec.
v There might be an improvement here on high-latency links.

Test 4: Throughput - 16 streams, 1 MB send buffer

Example result:
*** Throughput - 16 TCP stream(s), 1MB send buffer
[SUM] 0.0-121.4 sec 5.91 GBytes 418 Mbits/sec

Interpreting the results:
v The test ran for 121.4 seconds, transferred 5.91 GB (5.5 GiB), with an average

throughput of 418 Mbits/sec.
v The extra streams yielded higher utilization of the connection.
v The Mbits/sec reported in this test is the maximum replication performance

your system will achieve if your is using up to 2-3 cartridges in parallel.

Test 5: Throughput - 127 streams, 1 MB send buffer

Example result:
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*** Throughput - 127 TCP stream(s), 1MB send buffer
[SUM] 0.0-126.1 sec 8.08 GBytes 550 Mbits/sec

Interpreting the results:
v The test ran for 126.1 seconds, transferred 8.08 GB (7.53 GiB), with an average

throughput of 550 Mbits/sec.
v TCP takes a while to reach its maximal throughput. Longer testing times, 300

seconds or more, produces more accurate results.
v The throughput value given by this test is the potential physical replication

throughput for this system. It is directly affected by the available bandwidth,
latency, packet loss, and retransmission rate.

v The Mbits/sec reported in this test is the maximum replication performance
your system might achieve. If this number is lower than anticipated, contact
your network administrator.

Test 6: TCP Retransmissions versus Total TCP segments sent

Example result:
Number of TCP segments sent: 1619061
Number of TCP retransmissions detected: 201038 (12%)

Interpreting the results:
v A total of 1619061 TCP segments were sent during the five tests, out of which,

201038 were lost and retransmitted.
v The retransmission rate imposes a direct penalty on the throughput, as the

retransmission of these packets takes up bandwidth. The retransmission can be
caused by the underlying network (for example, packet dropping by an
overflowed router) or by the TCP layer itself (for example, retransmission due to
packet reordering).

v Segment loss can be caused by each of the network layers.
v TCP retransmission larger than 2% can cause performance degradation and

unstable network connectivity. Contact your network administrator to resolve
this issue and reduce it to approximately 0%.

What to do next

You might want to run these tests again to test the reverse throughput in the
network. To run the tests in reverse, change server1 to the client and server2 to the
server and repeat the procedures.
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Chapter 3. Configuring replication

Use the applicable options on the ProtecTIER Service Menu to configure your
system for replication.

About this task

Once basic system configuration is complete, you can perform the tasks required to
configure your system for replication. To do so, you will need to complete the
pre-configuration tasks outlined in “Before you begin,” as well as “Accessing the
ProtecTIER Service Menu” through “Configuring static routes” on page 9, if
necessary.

Before you begin
This topic describes the prerequisites for configuring replication.

About this task

Replication configuration requires careful planning, decision-making, and
coordination of effort. Before you get started, it is strongly recommended that you
complete these tasks:
v Make sure that TCP ports 6520, 6530, 6540, 6550 are open in your firewall. Each

ProtecTIER server being used for replication must allow TCP access through
these ports.

v Ensure that the replication ports are on a different subnet than the external local
area network (LAN) port. Having the replication ports and the external LAN
port on the same subnet may cause replication errors.
In addition, IBM recommends that on all ProtecTIER nodes or servers involved
in Native Replication, you configure all eth3 ports on one subnet, and you
configure all eth4 ports on a different subnet.

v Identify the person (or persons) responsible for completing the planning
worksheets.
It is strongly recommended that the worksheets be filled out in advance by
someone with extensive knowledge of your organization's network and TCP/IP
configuration. This will ensure that the information is technically accurate and
readily available during replication setup.

v Identify the person (or persons) responsible for configuring the TARGET(S) and
SOURCE(S) servers for replication, depending on the replication topology you
are using.
This may or may not be the same person (or persons) who completed the
worksheets.

After completing the above tasks, return to this page and go to “Accessing the
ProtecTIER Service Menu.”

Accessing the ProtecTIER Service Menu
Complete this task to access the ProtecTIER Service menu.
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Procedure
1. If necessary, power-on the server and the monitor, and wait for the login

prompt to display.
2. At the login prompt, type: ptconfig and press Enter.
3. At the Password prompt, type: ptconfig and press Enter.

The ProtecTIER Service Menu displays:

------------------------------------------------------------------------------
ProtecTIER Service Menu running on rassmx

------------------------------------------------------------------------------
1) ProtecTIER Configuration (...)
2) Manage ProtecTIER services (...)
3) Health Monitoring (...)
4) Problem Alerting (...)
5) Version Information (...)
6) Generate a service report
7) Generate a system view
8) Update ProtecTIER code

E) Exit
------------------------------------------------------------------------------
>>> Your choice?

4. Go on to “Configuring ProtecTIER Replication Manager.”

Configuring ProtecTIER Replication Manager
Use this procedure to configure the ProtecTIER Replication Manager application on
the designated server in your replication grid.

About this task

You must configure the Replication Manager application on the server that
remotely manages the replication grid or grids within your organization. IBM
recommends configuring the ProtecTIER Replication Manager application on the
TARGET server at the remote (destination) site. By doing so, the Replication
Manager will remain available in a disaster recovery situation.

Note: This task may be completed at any time during the replication configuration
process. However, creation of the replication grid and verification of the replication
configuration, cannot take place until ProtecTIER Replication Manager is up and
running on the designated server.

Procedure
1. On the designated ProtecTIER Replication Manager server, if it is not already

displayed, access the ProtecTIER Service Menu. See “Accessing the ProtecTIER
Service Menu” on page 21.

2. From the ProtecTIER Service Menu, select ProtecTIER Configuration (...).
Type the corresponding number and press Enter. The ProtecTIER
Configuration (...) menu is displayed.
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------------------------------------------------------------------------------
ProtecTIER Service Menu running on rassmx
ProtecTIER Configuration (...)

------------------------------------------------------------------------------
1) Configure ProtecTIER node
2) Recover Configuration for a replaced server
3) Configure enclosure serial number for a replaced enclosure
4) Update Time, Date, Timezone & Timeserver(s)
5) Configure replication (...)
6) IP Network configuration (...)
7) Update Firmware
8) Update the System’s name
9) Validate configuration

10) Single node - code upgrade (For Support Use ONLY)

B) Back
E) Exit

------------------------------------------------------------------------------
>>> Your choice?

3. Select Configure replication (...). Type the corresponding number and press
Enter. The Configure replication (...) menu is displayed.

------------------------------------------------------------------------------
ProtecTIER Service Menu running on rassmx
ProtecTIER Configuration (...)
Configure Replication (...)

------------------------------------------------------------------------------

1) Configure/Unconfigure ProtecTIER Replication Manager on this node
2) Configure Static Routes

B) Back
E) Exit

------------------------------------------------------------------------------
>>> Your choice?

4. Select Config/Unconfig ProtecTIER Replication Manager on this node. Type
the corresponding number and press Enter.

5. When the Replication Manager is currently unconfigured, do you wish to
configue it? (yes|no) prompt displays, type: yes and press Enter.
The warning below displays:
Warning: You should not configure Replication Manager on more than one
server in a grid, as doing so may cause conflicts within the grid. It is
recommended that you designate the Target server (Hub) as the
Replication Manager.

6. When the Are you sure you want to configure the ProtecTIER Replication
Manager on this node? (yes|no) prompt displays, type: yes and press Enter.
The status messages below, display:
Gathering information [ Done ]

The configurePTReplicationManager ended successfully message displays.
7. When the Press the ENTER key to continue... prompt displays, press Enter.

You are returned to the Configure replication (...) menu.
8. If the static routes have not been previously configured, continue to

“Configuring static routes” on page 9.
9. Type E and press Enter to exit.
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Chapter 4. Installing ProtecTIER Manager

The topics in this chapter describe how to install, configure, and uninstall the
ProtecTIER Manager software.

The ProtecTIER system is managed with the ProtecTIER Manager software. It is
recommended that you install the ProtecTIER Manager software on one or more
workstations and not directly on the ProtecTIER TS7610 Appliance Express.

ProtecTIER Manager enables you to:
v Configure ProtecTIER
v Monitor the status of the TS7610 Appliance Express
v Manage file systems, repositories, and services
v Change the system configuration
v Manage Native Replication activities with the ProtecTIER Replication Manager

software

Prerequisites for the ProtecTIER Manager workstation
This topic describes the workstation prerequisites for installing and running the
ProtecTIER Manager.

The ProtecTIER Manager workstation must meet the following prerequisites in
order to install and run ProtecTIER Manager effectively:
v One of the following operating systems:

– Windows 32/64 bit (XP Professional, 2003, Windows 7)
– Linux Red Hat 32/64 bit (Red Hat Enterprise 4 or 5)

v At least 1.2 GB of available disk space
v At least 256 MB of RAM
v Workstation access to the ProtecTIER service nodes IP addresses (ports 3501 and

3503 are open on the firewall).

IBM recommends that you use the following settings to configure the monitor for
ProtecTIER Manager:
v Resolution of 1024 x 768 pixels or higher (this resolution is the minimum

supported, however, 1280 x 1024 is recommended).
v 24 bit color or higher

Note: If you are planning to run ProtecTIER Manager on a UNIX system,
configure your graphics card and X Window System. You can perform this task
either manually or by use of the Xconfigurator utility. For instructions, refer to the
appropriate Linux documentation.

Installing the ProtecTIER Manager software
Use the procedures in this chapter to install the latest version of ProtecTIER
Manager software on the ProtecTIER Manager Workstation.

Important: Before starting the installation, make sure that the currently installed
ProtecTIER Manager application is closed.
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The ProtecTIER Manager installer is provided on your IBM ProtecTIER Manager
V3.3.6.1 DVD.

Different ProtecTIER Manager installers are used for Windows and Linux. Ensure
that the installer that you are using is correct for the operating system running on
your workstation.
v If you are installing ProtecTIER Manager on a workstation running Windows,

see “Installing on Windows.”
v If you are installing ProtecTIER Manager on a workstation running Linux, see

“Installing on Linux” on page 27.

If you are installing ProtecTIER Manager on a workstation on which an older
version of ProtecTIER Manager is already installed, uninstall the older version first.
For more information, see “Uninstalling the ProtecTIER Manager software” on
page 28.

Installing on Windows
Complete this task to install ProtecTIER Manager on a Windows system.

About this task

Perform the following steps to install ProtecTIER Manager on a Windows system:

Procedure
1. Insert the IBM ProtecTIER Manager V3.3.6.1 DVD into the CD-ROM drive of the

designated ProtecTIER Manager workstation.
v If the ProtecTIER Manager installer launches and starts the installation, go on

to step 2.
v If the ProtecTIER Manager installer process does not launch automatically, do

the following:
a. On the Windows task bar, click: Start > Run. The Run dialog box opens.
b. In the Open box, type: D: (where D: is the CD-ROM drive of the server).
c. Click OK.

The contents of the IBM ProtecTIER Manager V3.3.6.1 DVD displays.
d. From the list of files, locate the ProtecTIER Manager for Windows

installation file and double-click the file to start the installation.
2. Read the Introduction screen, and then click Next.
3. Read and accept the license agreement provided, and click Next.

The Choose Install Folder screen is displayed.
4. Specify the folder where the ProtecTIER Manager program files are to be

installed, and click Next.
The Choose Shortcut Folder screen is displayed.

5. Select the location where the program icons are to be created:
v In a new Program Group - Creates a program group in the Program list of

the Start menu.
v In an existing Program Group - Adds the shortcut to an existing program

group in the Program list of the Start menu.
v In the Start Menu

v On the Desktop

v In the Quick Launch Bar
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v Other - Enables you to enter a path location for the shortcut, or to browse
for a location by clicking Choose.

v Don't create icons - No shortcuts are created.

Note: When relevant, you can select Create Icons for All Users to create a
shortcut in the defined location for all user accounts on the workstation.

6. Click Next.
The Pre-Installation Summary screen displays the Install and Shortcut folder
locations and the disk space information of the target for installation.

7. Review the Summary screen, and click Install to start the installation.
The Installing ProtecTIER Manager screen is displayed.

8. When the installation is complete and ProtecTIER Manager has been
successfully installed, click Done.
The ProtecTIER Installation wizard closes and the installation process is
complete.

What to do next

Go on to the next chapter.

Installing on Linux
Complete this task to install ProtecTIER Manager on a Linux system.

About this task

Perform the following steps to install ProtecTIER Manager on Linux:

Procedure
1. Insert the IBM ProtecTIER Manager V3.3.6.1 DVD into the CD-ROM drive of

the designated ProtecTIER Manager workstation.
2. Run the ProtecTIER Manager installer.

Note: This procedure presumes that the workstation has a Linux graphical
interface which is required for ProtecTIER Manager.
a. From the Linux Desktop, select and open the CD drive icon.
b. Select and open the folder for your Linux version: Linux for version 64 or

Linux32 for version 32.
c. When the folder opens, drag the InstallLinuxXX.bin file from the folder to

the Desktop. (XX=either 32 or 64, depending on the Linux folder that you
selected.)

d. Close the open windows.
e. Right-click on an open area of the Desktop, and from the menu options

displayed, select Open Terminal.
f. At the Terminal command prompt, use the following command to change

to the Desktop directory (Note: Desktop is case-sensitive. Type it using a
capital "D".):
cd Desktop

and press Enter.
g. From the Desktop directory in the Terminal window, run the ProtecTIER

Manager installer:
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./InstallLinuxXX.bin

and press Enter.
(XX= either 32 or 64)
If the message: Permission Denied displays, enter the following
commands:
chmod +x InstallLinuxXX.bin
./InstallLinuxXX.bin

after typing each command press Enter.
The IBM ProtecTIER Manager wizard Introduction screen is displayed.

3. Click Next. Two separate Software License Agreement screens display.
4. Read the terms for each license agreement, select I accept both the IBM and

non-IBM terms of the License Agreement and click Next. The Choose Install
Folder screen is displayed.

5. Enter the path to the location where you want the ProtecTIER Manager
program files installed. Click Choose to browse for a location.

Note: Click Restore Default Folder to revert to the default installation path.
6. Click Next. The Choose Link Folder screen is displayed.
7. Select the location where you want the program links created::
v In your Home folder – Creates the links in the directory where the user

files are typically stored. For example: /home/bill.
v Other – Creates the links in the default location (/opt/IBM/PTManager). To

specify a different location, click Choose and select a directory on the
workstation hard disk drive.

v Don't create links – No links are created.
8. Click Next. The Pre-Installation Summary screen is displayed.
9. Click Install. The Installing ProtecTIER Manager screen is displayed and

ProtecTIER Manager is installed on your computer. When the installation is
complete, the Install Complete screen is displayed.

10. Click Done. The ProtecTIER Manager wizard closes. When the command
prompt returns in the Terminal window, type exit to close the window.

Uninstalling the ProtecTIER Manager software
This topic describes how to uninstall the ProtecTIER Manager software.

Procedure

To uninstall the ProtecTIER Manager software:
1. From the ProtecTIER Manager directory, run the ProtecTIER Manager

uninstaller. The Uninstall ProtecTIER Manager wizard Introduction screen is
displayed.

2. Click Uninstall. The Uninstalling screen is displayed and the ProtecTIER
Manager software is removed from your computer. The Uninstall Complete
screen is displayed.

3. Click Done. The Uninstall ProtecTIER Manager wizard closes.
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Chapter 5. Getting started with ProtecTIER Manager

Topics in this chapter provide an overview of common ProtecTIER Manager tasks.

After the ProtecTIER Manager software has been installed, familiarize yourself
with these basic ProtecTIER Manager tasks.

Running the ProtecTIER Manager application TS7600 ProtecTIER
Deduplication Solutions, V3.3.6.1

This task describes how to run the ProtecTIER Manager software on the
ProtecTIER Manager workstation.

About this task

The ProtecTIER Manager GUI can be run from either a Windows based, or a Linux
based ProtecTIER Manager workstation.

Procedure

Run the ProtecTIER Manager application:
v On a Windows-based ProtecTIER Manager workstation, run the ProtecTIER

Manager application:
Click Start > Programs > IBM > ProtecTIER Manager > IBM ProtecTIER
Manager.

v On a Linux-based ProtecTIER Manager workstation:
1. Navigate to the directory where you installed ProtecTIER Manager. The

default installation directory is: /opt/IBM/PTManager.
2. Double-click the ProtecTIER Manager icon.

The ProtecTIER Manager window is displayed.

Logging in and out of the ProtecTIER Manager application
Complete this task to log in to and log out of the ProtecTIER Manager application.

About this task

ProtecTIER Manager has default user accounts corresponding to three user
permission levels: Administrator, Operator, and User. For more information, see
“Permission levels” on page 31. The default username and password for each of
these accounts are as follows:

Table 2. Default usernames and passwords

Permission Level Default Username Default Password

Administrator ptadmin ptadmin

Operator ptoper ptoper

User ptuser ptuser
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Procedure
1. Click the Login button. The Login dialog box is displayed.
2. Enter your username and password.
3. Click Ok. The Login dialog box closes and ProtecTIER Manager displays the

information for that node.

Results

IBM recommends that you change or replace these default user accounts. For more
information, see “Managing users” on page 31.

If you log in with Administrator level permission while another Administrator is
already logged in, a message box is displayed with the following message:
Administrator is already logged in from host <host name>, at IP address:
<IP address>.
Would you like to login anyway?

Clicking Yes forces the other Administrator to logout.

Customizing the network configuration of a node
This topic describes how to use the Network Configuration window in ProtecTIER
Manager to customize the IP communication interfaces on a node.

About this task

The Network Configuration window lets you reassign the IP communication
interfaces to group several physical interfaces into a single virtual interface, and
create a bond configuration of several physical interfaces.

Procedure
1. From the Systems Management view, select Node > Network configuration.

The Network configuration window is displayed:
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Figure 5. Configure IP interfaces window
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2. Select a node from the Node to be configured field.
3. Highlight the virtual interface you wish to edit.
4. Click on the dropdown in the L/B Method column to select the load balancing

method. The available load balancing methods are displayed:

RR (Round-robin)
Outgoing traffic is spread evenly across all of the adapter ports in the bond

L2 Outgoing traffic is spread using a default transmit hash policy of layer 2

L2L3
Outgoing traffic is spread using a transmit hash policy of MAC addresses
and IP addresses of the source and the destination

L3L4
Outgoing traffic is spread using a transmit hash policy of IP addresses and
ports of the source and the destination

HA Active-backup policy: only one slave in the bond is active. A different slave
becomes active if, and only if, the active slave fails.

5. Edit the IP Address, Netmask and Gateway addresses, as desired.
6. If you want to reassign a physical interface, select an Ethernet port from the

ports available in the Assign field.
7. If you want to unassign a port, select the port to unassign from the Unassigned

Ethernet Ports dropdown.
8. Click Ok to save the changes and exit the Network Configuration window.

Managing users
The topics in this section describe how to manage users of the ProtecTIER Manager
system.

ProtecTIER Manager enables you to create user accounts with different permission
levels for accessing and configuring your ProtecTIER system.

Permission levels
This topic describes the various user permission levels in the ProtecTIER Manager
system.

The ProtecTIER system supports the following permission levels:
v Administrator has full access to the ProtecTIER system.

Note: Only one Administrator can be logged in to the ProtecTIER system at a
time. If you log in as an administrator while another administrator is already
logged in, the system displays a notification pane. The notification pane lists the
other administrator who is logged in, and offers to force that administrator to
log out.

v Operator can access ProtecTIER Manager monitoring screens and perform
limited tasks.

v User can access only ProtecTIER Manager monitoring screens.

Adding user accounts
This topic describes how to add a user account to ProtecTIER Manager.
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About this task

Complete this task to add a new user account to the ProtecTIER Manager system.

Procedure
1. Log in to the ProtecTIER Manager system and choose System > Manage Users.

The Manage Users dialog is displayed:

2. Click Add. The Add account dialog is displayed.
3. In the User name field, enter a username for the account.
4. In the New password field, enter a password for the account.
5. In the Verify password field, reenter the password that you entered in the New

password field.
6. In the Permission field, select a permission level (Administrator, Operator, or

User) you want to assign to the user account.

Note: Before processing, record this information in a manner that allows you to
notify the new user. Remind the new user to record the password because you
nor the system stores the passwords for later use.

7. Click Ok. The Add account dialog closes and the account is added to the
ProtecTIER Manager system.

8. Click Close to exit the Manage Users window.

Changing the user account password
This topic describes how to change the password of a user account on the
ProtecTIER Manager system.
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Figure 6. Manage Users dialog
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About this task

Complete this task to change the user password in the ProtecTIER Manager
system.

Procedure
1. Choose System > Manage Users. The Manage Users dialog is displayed.
2. Select a user account from the list and click Change password. The Change

password dialog is displayed.
3. Type the current password in the Password field.
4. Type the new password in the New password field.
5. Type the new password again in the Verify password field.
6. Click Ok. The password for the selected user account is changed.
7. Click Close to exit the Manage Users window.

Changing the Support System settings
This topic explains how to change the support system settings.

About this task

The ProtecTIER Manager installation wizard and the ProtecTIER Manager
application are fully compatible with the JAWS screen-reader software. ProtecTIER
Manager also allows you to change other accessibility settings, such as the contrast
resolution mode and color palette. Instructions for installing JAWS and the
Java-based accessibility tools, and for setting the contrast resolution mode and
color palette are available in “Accessibility” on page 257.

Saving and printing data
This task describes how to save or print the data displayed in informational
ProtecTIER Manager windows.

About this task

Follow these steps to save or print data in ProtecTIER Manager informational
windows and panes:

Procedure
1. Select Options in the upper right-hand corner of the window.

Note: The Options menu may not be available on all windows.
2. Select Save to save the information or Print to print the information. Use the

standard saving or printing procedures for your operating system.

Refreshing information displayed by the ProtecTIER Manager software
This task describes how to refresh windows, screens, and panes in the ProtecTIER
Manager application.

Many windows, screens, and panes of ProtecTIER Manager automatically refresh
to display the most current information. However, you need to refresh some
windows manually. Because you can have multiple ProtecTIER Manager
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workstations on the same system, changes made on another workstation are not
automatically reflected on your workstation. To ensure that you have the most up
to date information, you should periodically refresh the ProtecTIER Manager
Navigation pane and View pane.

Select the Refresh navigation pane button to refresh the Navigation pane.

Select the Refresh current view button to refresh the View pane.

Running operations in the background
This topic describes enabling operations to run in the background while you are
run another operation.

You can use the same instance of ProtecTIER Manager to work with multiple
ProtecTIER systems while a specific ProtecTIER Manager operation runs in the
background. You cannot, however, run multiple operations in the same ProtecTIER
system.

For instance, if you are running a Delete library operation, the wizard prompts
you to wait while the system goes offline to run the required operation. That
system will be busy until it completes, thereby not allowing further administration
of other operations.

By selecting Run in background, you return control to the user. If additional
systems are configured in ProtecTIER Manager, those systems are accessible and
can be worked on, even while the required operation is running.
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Figure 7. ProtecTIER Manager
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Chapter 6. Managing repositories

The topics in this chapter describe how to use the ProtecTIER Manager software to
create and manage repositories in TS7600 ProtecTIER Deduplication Solutions,
V3.3.6.1.

The Appliance Express server has one repository on which data is stored.

Use the ProtecTIER Manager software for repository management tasks, including:
v Enabling replication
v Increasing the capacity of repositories
v Configuring the virtual libraries in VTL systems on the ProtecTIER server
v Creating and configuring CIFS shares in FSI systems
v Defragmenting a repository
v Reserving space on a repository

Enabling replication
Perform the following procedure on ProtecTIER Manager to enable replication on
systems that have not already been configured for replication.

Before you begin

Note: It is possible that replication has already been enabled on your system. For
example, if you performed the Increase Capacity operation with ProtecTIER v2.3
or above, replication was automatically enabled.

By default, replication is enabled on new repositories created with ProtecTIER v2.3
and above. Replication is disabled on repositories upgraded from v2.2 (and below)
versions. When you enable replication, you must assign files systems, set the
estimated factoring ratio, MD raid configuration, and disk size. The procedure
allocates metadata for replication and then you can add file systems to the
repository as needed. If more storage is required, you can select additional file
systems (if they exist) to add to the metadata.

About this task

Enabling replication on the Appliance Express might require additional metadata,
pending the actual metadata deployment on the specific repository.

To enable replication:

Procedure
1. From the Systems management view, select Replication > Enable replication.

The Enable replication wizard welcome screen is displayed.
2. Click Next. The Properties dialog is displayed.
3. Select the Estimated factoring ratio, the MD raid configuration, and the Disk

size (in GB) of the metadata disks.

Note: The size of the repository cannot be changed when enabling replication.
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4. Click Next. The Repository resources dialog displays the total amount of
metadata and user data (in GB) allocated for the repository.

5. If more storage is required, click Advanced. The Repository resources window
is displayed with a list of available file systems (if they exist).

6. Select what file systems to use for metadata or user data. Click Ok. The
resources window closes.

7. Click Finish. The summary report is displayed and replication is enabled on
ProtecTIER Manager.

Expanding repositories
Complete the tasks in this topic to increase the capacity of a repository.

About this task

Attention: This section provides instructions for increasing the capacity of a
repository.

After the repository is created, the ProtecTIER system enables you to increase the
capacity of the repository. Much like creating the repository, expanding the
repository requires the guidance of a trained ProtecTIER specialist and use of a
wizard for planning repository expansions. You might need to expand the
repository if:
v Your factoring ratio is higher than originally expected and you are running out

of meta data space.
v Your repository needs have expanded beyond the original growth projections

and you are running out of user data space.

The increase capacity steps described in this task appear in the order in which they
should be performed:
1. Plan the expansion using ProtecTIER Manager.
2. Create new file systems or extend existing ones on the backend storage using

the ProtecTIER Service menu and verify that the devices are displayed.
3. Run the Increase Capacity wizard.
4. Complete the operation .

Guidelines for increasing the repository and the virtual
capacity of a cartridge

Increasing the capacity of a repository impacts the virtual capacity of cartridges.

Increasing the capacity of a repository has a direct impact on the way the
ProtecTIER system calculates the logical maximum size of the defined virtual
cartridges. When you increase the repository, the maximum size of the cartridges is
updated and recalculated based on the new repository size (that is, the size of the
cartridges is increased).

When you create a repository, the nominal size of the repository is equal to the
factoring and compression ratios multiplied by its physical size. The following
calculation is used:
[nominal size]=[factoring and compression ratio]*[physical size]

36 IBM TS7610 and TS7620 ProtecTIER Deduplication Appliance Express: ProtecTIER User's Guide for VTL Systems



ProtecTIER emulates real cartridges with a given virtual capacity. When adding
cartridges to the repository, the virtual capacity of the cartridge is equal to the
nominal size of the repository divided by the number of cartridges in the system,
as shown in the following calculation:
[cartridge virtual capacity]=[nominal size]/[number of cartridges in the system]

The resulting value of the virtual capacity of the cartridge is dynamic, such that:
v If you add more cartridges to the system, the virtual capacity of the cartridge

decreases.
v If you delete cartridges from the system, the virtual capacity of the cartridge

increases.
v If the factoring ratio decreases, the nominal size of the repository decreases,

therefore causing the virtual capacity of the cartridge to decrease.
v If more capacity is added to the repository, the nominal size of the repository

increases, therefore causing the virtual capacity of the cartridge to increase.

When the virtual capacity size of the cartridge is full, the backup application
receives an Early Warning (EW) message, and the cartridge is marked full in
ProtecTIER Manager. If the capacity of the cartridge increases, the cartridges stay
marked as full. You must expire cartridges that have reached EW to use the
remaining capacity.

If the full cartridges cannot be expired, you must add cartridges after increasing
the capacity so that the virtual capacity of each cartridge is less than, or equal to
the previous capacity.

Planning an expansion
Complete this task to plan for a repository expansion.

About this task

With the guidance of a trained ProtecTIER specialist, run the Plan repository
increase wizard to determine the optimum repository size and meta data file
system arrangement for your expanded repository.

To plan a repository expansion:

Procedure
1. Choose Repository > Increase capacity planning. The Increase capacity

planning window opens.
2. In the Repository size field, select the total physical size, in TB, for the

repository.

Note: If you are expanding the repository only to increase the amount of meta
data space, increase the estimated factoring ratio value, but leave the repository
physical size value unchanged.

3. In the Estimated factoring ratio field, enter the updated factoring ratio estimate
for the repository.

4. In the MD Raid configuration field, select a configuration option from the
drop-down list.

5. In the Disk size field, select the physical disk size, in GB, from the drop-down
list.
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6. Click Ok. The Increase capacity planning dialog closes and the Repository
meta data storage requirements window is displayed listing the minimum
meta data file system expansion options that are suitable for your expansion
needs.

7. Click Options to print or save as a .csv file the information in the Repository
meta data storage requirements dialog using the standard procedures for your
operating system.

8. Click Plan again to go back to the Increase capacity planning window and
change the configuration options, or click Close. The Repository meta data
storage requirements dialog closes.

Defragmentation on a repository
Defragmentation is the process to allocate fragmented space on a repository as
defragmented so that this space can be used to write new data.

Important: Contact a trained ProtecTIER specialist before performing this
operation.

A ProtecTIER repository becomes fragmented over time. The Defragmentation
control operation gathers the fragmented (i.e. free, but unusable) space together in
order to improve the speed of reading and writing new data to the repository.

Reserve space for backup for VTL
This topic describes the Reserve space for backup feature for a VTL which
provides the ability to exclusively assign a portion of a repository's capacity for
local backups.

In some situations, the replication process may fill, or nearly fill, all the space in
the hub repository, leaving insufficient space for backup data. Since the assumption
is that backup has precedence over replication, this feature ensures that the
designated capacity is reserved only for local backup during replication, so that
replication cannot be written to the reserved portion of the storage capacity. Error
notifications will appear in the event that the capacity reserved on the repository is
running out of space for the local backup, or for replication.
v If there is no replication, backup data can stream into the repository and fill the

entire storage capacity.
v If there is replication going on, backup data can stream into the repository and

fill the entire reserved space for backup, while replication data streams into the
repository and fills the remainder of the storage capacity. Keep in mind that
replication and backup data compete for this space.

To reserve space for backup on a repository:
1. From the System's Management view, choose the repository from the

navigation pane.
2. Select Reserve space for backup from the Repository menu. The Reserve space

for backup window displays the minimum amount of nominal space that is
currently reserved for backup.
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3. Enter the new minimum nominal space size and click Ok. The operation is
complete and space for backup is reserved on the repository.

Go on to Chapter 8, “Managing the ProtecTIER Virtual Tape service,” on page 61.

Deleting repositories
Complete this task to delete a repository.

About this task

In general, it is not necessary to delete a repository. Using ProtecTIER Manager,
follow the task to delete a repository. To recreate the repository on the existing
storage, you must reinstall the operating system and the ProtecTIER code. For
further instructions, refer to Chapter 15, “ProtecTIER system recovery procedures,”
on page 197.

For more information, contact a trained ProtecTIER specialist.

Attention: Deleting the repository results in the loss of all the data contained in
the repository.

Perform the following steps to delete a repository:

Procedure
1. Select the repository.
2. Choose Repository > Delete repository. A confirmation message box is

displayed.
3. Click Yes. The Data Loss Confirmation dialog box is displayed.
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Figure 8. Reserve space for backup window
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4. In the field, type data loss and click Ok. A confirmation message box is
displayed.

5. Click Yes. The ProtecTIER system temporarily goes offline to delete the
repository.

6. When the system comes back online, you can resume use of your ProtecTIER
system.

Note: Before you can recreate a repository on the existing storage, contact a
trained ProtecTIER specialist for assistance.
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Chapter 7. Managing and monitoring ProtecTIER through the
CLI

This chapter describes how to query and configure the system via the command
line interface (CLI), and to receive various statistics about the ProtecTIER system.
This information can provide valuable insight to the administrator on the
performance, capacity, configuration and operation of the system, and can be
accessed by other management applications.

Understanding the syntax diagrams
A syntax diagram uses symbols to represent the elements of a command and to
specify the rules for using these elements.

Syntax diagrams

Main path line

►► ►◄

Begins on the left with double arrowheads (>>) and ends on the right with
two arrowheads facing each other (><). If a diagram is longer than one
line, each line to be continued ends with a single arrowhead (>) and the
next line begins with a single arrowhead. Read the diagrams from
left-to-right, top-to-bottom, following the main path line.

Keyword

►► ptcli ►◄

Represents the name of a command, flag, parameter, or argument. A
keyword is not in italics. Spell a keyword exactly as it is shown in the
syntax diagram.

Required keywords

►► ./ptcli <command name> <--server options>
<processing options> <--command specific options>

►◄

Indicate the parameters or arguments you must specify for the command.
Required keywords appear on the main path line. Mutually exclusive
required keywords are stacked vertically.

Optional keywords

►►
-h -help -?

►◄

Indicate the parameters or arguments you can choose to specify for the
command. Optional keywords appear below the main path line. Mutually
exclusive optional keywords are stacked vertically.

Variable
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►► variable ►◄

Represents the value you need to supply for a parameter or argument,
such as a file name, user name, or password. Variables are in italics.

Special characters

- (minus) or -- (double minus)
Flags are prefixed with a - (minus) sign. Flags define the action of a
command or modify the operation of a command. You can use multiple
flags, followed by parameters, when you issue a command.

[ ] square brackets
Optional values are enclosed in square brackets.

| vertical bar
A vertical bar indicates that you have a choice between two or more
options or arguments.

For example, [ a | b ] indicates that you can choose a, b, or nothing.
Similarly, { a | b } indicates that you must choose either a or b.

ptcli
This topic describes how to use ptcli through the command-line interface (CLI) .
The ptcli is loaded during the installation of ProtecTIER software and ProtecTIER
Manager software.

Usage

When ptcli is running, the available ptcli commands are listed according to the
version of ProtecTIER that is installed. If the ptcli for version 3.3.6.1 is running on
older versions of ProtecTIER, several operations might not be supported.

Use ptcli to do any of the following tasks:
v Configure ProtecTIER (including configuration of a ProtecTIER repository and

configuration of ProtecTIER virtual tape [VT] libraries).
v Monitor ProtecTIER (including statistics of ProtecTIER VT and statistics about

the ProtecTIER repository).
v Snapshot and filter ProtecTIER VT cartridges (mostly used for DR (disaster

recovery)_, scenerios) For more information, see “ptcli Inventory commands” on
page 49.

To run ptcli on a ProtecTIER node, move into the following directory:
/opt/dtc/ptcli.

To run ptcli on a host running ProtecTIER Manager, move into the ProtecTIER
Manager directory (in Windows, C:\Program Files\IBM\ProtecTIER Manager).

The ptcli command is issued from the command line as follows:

►► ./ptcli <command name> <--server options>
<processing options> <--command specific options>

►◄

For more information, see:
v “Processing options” on page 43
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v “Server options” on page 44

Creating a profile
This topic describes how to create a profile in order to query the ProtecTIER server
through the command line interface (CLI) using ptcli.

About this task

Creating a profile is an optional task that can be completed prior to accessing the
ptcli. Creating a profile provides for the user name and password to be saved in
a file. You can always enter the user name and password manually if you choose
not to create a profile. For more information on using ptcli, see “ptcli” on page
42.

Procedure
1. Activate ptcli with -p followed by a file name with full path.
2. Once prompted, enter the desired user name and password. This step creates

the user-specified file with the user name and password that is needed for
login.

Example

Note: In the following example, \ptcli is the root directory. Keep in mind that
running the command does not create the directory path. Therefore, for the
command to work, the root directory (in this case \ptcli) must be created before
activating the command.
ptcli -p h:\ptcli\ptuser
User name: ptuser
Password:
<?xml version="1.0" encoding="UTF-8"?
<response command="createprofile" status="success"/>

Processing options
This topic describes how to use the processing options to query the ProtecTIER
server through the command line interface (CLI).

Usage

You can specify the following processing options at the beginning of the command
string:

Table 3. Processing options

Processing options Explanation

--debug <debug level> Specify the debug level to print log messages to the
console. Choices for the debug level are as follows:

v SEVERE

v WARNING

v ALL

[-h (--help)] Prints the Help message to the console and exits.

[-v (--version] Prints the version information and exits.

[-p (--createprofile) FILE] Creates or modifies the user profile file. This file is used
for logging into the management server.
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Server options
This topic describes the server options to use when querying the ProtecTIER server
through the command line interface (CLI). Server options are used for connection
to the management server. They should appear with each query/action - except for
the arguments -h or -v.

Usage

Note: Administrator privileges are required for configuration operations.

You can specify the following server options at the beginning of the command
string:

Table 4. Server options

Server options Explanation

--ip <IP> Specify the IP address of the management server.

This field is required if you are running ptcli from a
server or PC that is not the ProtecTIER server to which
you want to connect.

[--port <PORT>] Specify the port of the management server. The default
is: 3501.
Note: This is optional.

[--loginFile <FILE>] Specify a user profile file for login.
Notes:

v This is optional.

v When specifying --loginFile, using --loginInline is
mutually exclusive.

[--loginInline <USERNAME,PASSWORD>] Specify a login using the user name and password.
Notes:

v This is optional.

v When specifying --loginInline, using --loginFile is
mutually exclusive.

[--force] Force the login if another administrator is already logged
in.
Note: This is optional.

Commands
The following tables contain lists of commands to invoke on the management
server.

For information about ProtecTIER VT commands, see “ProtecTIER VT commands”
on page 46.

For information about ProtecTIER Repository commands, see “ProtecTIER
repository commands.”

ProtecTIER repository commands
The following tables contain lists of commands to invoke on the ProtecTIER
repository.
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Table 5. CreateRepository Command

Command Explanation Command Specific Options

CreateRepository Create a repository Name Explanation

--name <NAME> Repository name

--system <NAME> System name

--size <SIZE> Repository physical
maximum size in TB

--peak <NUM> Peak throughput in MB

--ratio <NUM> Deduplication ratio

--raid <X,Y,Z> Metadata raid configuration
in the form of [X,Y,Z]
where (X = Type), (Y =
Members) and (Z = Disk
size in GB) taken from
"RaidConfiguations" output

[--metadata
<MOUNT_POINTS>]

List of GFS (global file
system) mounted file
systems used to store
ProtecTIER repository
metadata

[--userdata
<MOUNT_POINTS>]

List of GFS mounted file
systems used to store
ProtecTIER repository user
data

Example:

CreateRepository

►► ./ptcli CreateRepository --ip 9.148.220.101 --loginFile h:\ptcli\ptadmin Command Specific Options ►◄

Command Specific Options:

--name PTCLI_REP --system PTCLI_SYS --size 2 --peak 300 --ratio 13 --raid FC-10K,4+4,120 Command specific options

Command specific options:

--metadata <MOUNT_POINTS> --userdata <MOUNT_POINTS>

Table 6. RaidConfigurations Command

Command Explanation

RaidConfigurations Prints information about the supported raid
configurations

Example:

RaidConfigurations

►► ./ptcli RaidConfigurations --ip 9.148.220.101 --loginFile h:\ptcli\ptadmin ►◄
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Table 7. RepositoryStatistics Command

Command Explanation

RepositoryStatistics Prints the repository statistics

Example:

RepositoryStatistics

►► ./ptcli RepositoryStatistics --ip 9.148.220.101 --loginFile h:\ptcli\ptadmin ►◄

Table 8. ServerVersion Command

Command Explanation

ServerVersion Prints the server version

Example:

ServerVersion

►► ./ptcli ServerVersion --ip 9.148.220.101 --loginFile h:\ptcli\ptadmin ►◄

ProtecTIER VT commands
The following tables contain lists of commands to invoke on the virtual tape
library.

ptcli Configuration commands
This topic describes how to configure the ProtecTIER server through the command
line interface (CLI) using Configuration commands.

Table 9. AddCartridges command

Command Explanation Command Specific Options

AddCartridges Add Cartridges Name Explanation

--name <NAME> Library name (taken from
"Libraries" output)

--cartridges <NUM> Number of cartridges

[--maxcartsize <NUM>] Maximum cartridge growth
in MB. If not specified, the
size is not limited.

--seed <SEED> Bar code seed

Example:

AddCartridges

►► ./ptcli AddCartridges --ip 9.148.220.45 --loginFile h:\ptcli\ptadmin Command Specific Options ►◄

Command Specific Options:

--name Lib --cartridges 200 --seed TS0000
[--maxcartsize] NUM
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Table 10. AddLibrary Command

Command Explanation Command Specific Options

AddLibrary Create library Name Explanation

--name <NAME> New library name defined
when creating a library

[--slots <NUM>] Number of slots (defaults
to 0)

--impexp <NUM> Number of import/export
(defaults to 8)

--libtype <NAME> Library type (taken from
"LibraryTypes" output

--robot X,Y List of robot assignments in
the form of [X,Y] where (X
= Node external IP), (Y =
Port)

--drivemodel <NAME> Tape drive model (taken
from "DriveModels" output)

[--drives X,Y,Z] List of drive assignments in
the form of [X,Y,Z] where
(X = Number of drives), (Y
= Node external IP), and (Z
= Port)

Example:

AddLibrary

►► ./ptcli AddLibrary --ip 9.148.220.45 --loginFile h:\ptcli\ptadmin Command Specific Options ►◄

Command Specific Options:

--name Lib1 --impexp 5 --libtype TS3500 --drivemodel ULT3580-TD3
[--slots] 30

--robot 9.148.220.45,0 --robot 7,168.159.150.33,0
[--drives] 5,9.148.220.45,0 [--drives] 7,168.159.150.33,0

ptcli Throughput statistics
This topic describes how to view the ProtecTIER server statistics history through
the command-line interface (CLI).

Table 11. NodeVtlStatistics Command

Command Explanation Command Specific Options

NodeVtlStatistics Prints the statistics history
on the local host

Name Explanation

--hours <NUM> The number of statistics
hours included in the
output. By default, the
output includes four
chronicles (statistic records)
per hour (if uptime >=
hours).
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Table 11. NodeVtlStatistics Command (continued)

Command Explanation Command Specific Options

Example:

NodeVtlStatistics

►► ./ptcli NodeVtlStatistics --ip 9.148.220.101 --loginFile h:\ptcli\ptadmin --hours 1 ►◄

ptcli Library information
The tables in this topic contain lists of commands to invoke on libraries of the
ProtecTIER repository.

Table 12. CartridgeInfo Command

Command Explanation Command Specific Options

CartridgeInfo Print information about
specific cartridges in the
library
Note: The list is sorted by
barcode.

Name Explanation

--name <NAME> Library name (taken from
"Libraries" output)

--from <NUM> The number of cartridges
before the first printed
cartridge in the list of
cartridges (the number of
cartridges can be taken
from
"NumberOfCartridges"
output)

--count <NUM> The maximum number of
cartridges in the output

Example:

CartridgeInfo

►► ./ptcli CartridgeInfo --ip 9.148.220.45 --loginFile h:\ptcli\ptadmin Command Specific Options ►◄

Command Specific Options:

--name Lib --from 0 --count 400

Table 13. DriveModels Command

Command Explanation Command Specific Options

DriveModels Prints information about
the supported tape drive
models

Name Explanation

--libtype <NAME> Library type (taken from
"LibraryTypes" output

Example:

DriveModels

►► ./ptcli DriveModels --ip 9.148.220.101 --loginFile h:\ptcli\ptadmin --libtype TS3500 ►◄
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Table 14. Libraries Command

Command Explanation

Libraries Prints the list of libraries on the repository

Example:

Libraries

►► ./ptcli Libraries --ip 9.148.220.101 --loginInline h:\ptcli\ptadmin ►◄

Table 15. LibraryInformation Command

Command Explanation Command Specific Options

LibraryInfo Prints information about a
specific library in the
repository

Name Explanation

--name <NAME> Library name (taken from
"Libraries" output

Example:

LibraryInformation

►► ./ptcli LibraryInfo --ip 9.148.220.101 --loginInline h:\ptcli\ptadmin --name Lib ►◄

Table 16. LibraryTypes Command

Command Explanation

LibraryTypes Prints information about a specific library in the
repository

Example:

LibraryTypes

►► ./ptcli LibraryTypes --ip 9.148.220.101 --loginFile h:\ptcli\ptadmin ►◄

Table 17. NumberofCartridges Command

Command Explanation Command Specific Options

NumberOfCartridges Prints the number of
cartridges in the library

Name Explanation

--name <NAME> Library name (taken from
"Libraries" output

Example:

NumberOfCartridges

►► ./ptcli NumberOfCartridges --ip 9.148.220.101 --loginFile h:\ptcli\ptadmin --name Lib ►◄

ptcli Inventory commands
This topic describes how to query the ProtecTIER server through the command
line interface (CLI) using Inventory commands.
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Usage

The Inventory command options are used to filter cartridges in a ProtecTIER
repository using a variety of criteria. Also, these options can be used to move
cartridges that match a certain criteria. Before beginning to filter the cartridges,
and/or moving cartridges using the CLI, you must first create a snapshot of the
cartridges using the InventoryRefresh command. (See Table 18.) The snapshot will
include the most updated properties of the cartridges at the time it is created.

Note: Any filter/move operation is executed using the snapshot's contents.
Running such a command without a previous refresh is considered an error. Also,
for larger repositories, a refresh operation may take considerable time and reduce
ProtecTIER's performance during that time.

Moving a cartridge using the CLI may fail if the snapshot is not up to date for the
cartridge (for instance, if the cartridge is moved or deleted after a snapshot is
taken). Operations on libraries for which the snapshot is not up to date may have
undesirable consequences.

Table 18. InventoryRefresh command

Command Explanation

InventoryRefresh Refresh the cartridges inventory snapshot on the server.

Example:

InventoryRefresh

►► ./ptcli InventoryRefresh --ip 9.148.220.101 --loginFile h:\ptcli\ptadmin ►◄

Table 19. InventoryFilter command

Command Explanation Command Specific Options

InventoryFilter Queries the cartridges
inventory snapshot created
by the InventoryRefresh
command.

Name Explanation

--querytype <QUERYTYPE> Type of query to be used
by the command:

v All - All cartridges in the
ProtecTIER repository.

v Replica - All cartridges
that were replicated into
this repository.

v Origin - All cartridges
that were replicated from
this repository.

--query <QUERY> Query to be used by the
filter command. See
“Query” on page 54 for
more information.

[--output <PATH>] The output file path for the
query results.

[--limit <NUM>] The limit for the maximal
number of cartridges the
query may return.
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Table 19. InventoryFilter command (continued)

Command Explanation Command Specific Options

Example:

InventoryFilter

►► ./ptcli InventoryFilter --ip 9.148.220.101 --loginFile h:\ptcli\ptadmin Command Specific Options ►◄

Command Specific Options:

--querytype replica --query "in_sync = true"
[--output] <PATH> [--limit] <NUM>

Table 20. InventoryGetQueryFields command

Command Explanation Command Specific Options

InventoryGetQueryFields Returns the fields
available for the specified
query type

Name Explanation

--querytype <QUERYTYPE> Type of query to be used
by the command:

v All - All cartridges in
the ProtecTIER
repository.

v Replica - All cartridges
that were replicated
into this repository.

v Origin - All cartridges
that were replicated
from this repository.

See “Query” on page 54
for more information.

Example:

InventoryGetQueryFields

►► ./ptcli InventoryGetQueryFields --ip 9.148.220.101 --loginFile h:\ptcli\ptadmin --querytype all ►◄

Chapter 7. Managing and monitoring ProtecTIER through the CLI 51



Table 21. InventoryMoveFile command

Command Explanation Command Specific Options

InventoryMoveFile Move a group of cartridges
expressed as a file (created
manually or using the
InventoryFilter
command).

Name Explanation

--filetype <TYPE> The type of the file to be
used by the command:

v All - All cartridges in the
ProtecTIER repository.

v Replica - All cartridges
that were replicated into
this repository.

v Origin - All cartridges
that were replicated from
this repository.

v barcode - Lists the
barcodes of cartridges in
the repository to be
moved.

--file <PATH> The path to a file
containing a list of
cartridges to be moved

--destination <NAME> The destination library (or
shelf) of the move
command

Example:

InventoryMoveFile

►► ./ptcli InventoryMoveFile --ip 9.148.220.45 --loginFile h:\ptcli\ptadmin Command Specific Options ►◄

Command Specific Options:

--filetype replica --file /temp/inventory/if2.csv --destination shelf

Table 22. InventoryMoveFilter command

Command Explanation Command Specific Options

InventoryMoveFilter Move a group of cartridges
(that match a given query)

Name Explanation

--querytype <QUERYTYPE> The type of the query to be
used by the command:

v All - All cartridges in the
ProtecTIER repository.

v Replica - All cartridges
that were replicated into
this repository.

v Origin - All cartridges
that were replicated from
this repository.

--query <QUERY> The query to be used by
the filter command See
“Query” on page 54 for
more information.

--destination <NAME> The destination library of
the move command.
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Table 22. InventoryMoveFilter command (continued)

Command Explanation Command Specific Options

Example:

InventoryMoveFilter

►► ./ptcli InventoryMoveFilter --ip 9.148.220.45 --loginFile h:\ptcli\ptadmin Command Specific Options ►◄

Command Specific Options:

--querytype replica --query "in_synch = true" --destination shelf

Table 23. InventoryStatistics command

Command Explanation

InventoryStatistics Display the latest information about the cartridges
inventory snapshot

Example:

InventoryStatistics

►► ./ptcli InventoryStatistics --ip 9.148.220.101 --loginFile h:\ptcli\ptadmin ►◄

Table 24. InventoryDeleteFile command

Command Explanation Command Specific Options

InventoryDeleteFile Delete a group of cartridges
(expressed as a file).

Name Explanation

--filetype <TYPE> The type of the file to be
used by the command:

v All - All cartridges in the
ProtecTIER repository.

v Replica - All cartridges
that were replicated into
this repository.

v Origin - All cartridges
that were replicated from
this repository.

v barcode - Lists the
barcodes of cartridges in
the repository to be
deleted.

--file <PATH> The path to a file
containing a list of
cartridges to be deleted

--shelf Flag indicating that the
cartridges are located in
Shelf. Choose this option or
Library option.

--library <NAME> Flag indicating that the
cartridges located in the
library <NAME>. Choose
this option or Shelf option.
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Table 24. InventoryDeleteFile command (continued)

Command Explanation Command Specific Options

Example:

InventoryDeleteFile

►► ./ptcli InventoryDeleteFile --ip 9.148.220.88 --loginFile h:\ptcli\ptadmin Command Specific Options ►◄

Command Specific Options:

--filetype all --file /temp/inventory/if2.csv --shelf

Table 25. InventoryDeleteFilter command

Command Explanation Command Specific Options

InventoryDeleteFilter Delete a group of cartridges
(expressed as a filter).

Name Explanation

--querytype <QUERYTYPE> The type of the file to be
used by the command:

v All - All cartridges in the
ProtecTIER repository.

v Replica - All cartridges
that were replicated into
this repository.

v Origin - All cartridges
that were replicated from
this repository.

--query <QUERY> The query to be used by
the filter command. See
“Query”

--shelf Flag indicating that the
cartridges are located in
Shelf. Choose this option or
Library option.

--library <NAME> Flag indicating that the
cartridges located in the
library <NAME>. Choose
this option or Shelf option.

Example:

InventoryDeleteFilter

►► ./ptcli InventoryDeleteFilter --ip 9.148.220.88 --loginFile h:\ptcli\ptadmin Command Specific Options ►◄

Command Specific Options:

--querytype all --query "barcode>='000811' AND barcode<="000830'" --shelf

Query
This topic describes what a query is and how to use it in Inventory commands.

A query is a statement in which the user can put one of the following:
v White spaces
v Numbers
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v Tokens: and/or/not/is/in/between
v String literals (within single quotes): 'AB0000'
v Boolean: TRUE/FALSE/true/false
v Column names as defined by the column names of the query type
v Date: the date format in a query is as follows: datetime('2009-12-27' 08:23:00)

Results can be saved in a .csv file using the --output command switch.

The .csv file can be used as an input to a CLI move command. This .csv file can be
partially edited by the user by removing lines (each line represents a cartridge).

User can also create his own barcodes file, and to use this as an input to a move
command.

Cartridges set and query type

A filter is always working on the specified set of cartridges:
v All: All cartridges in the ProtecTIER repository.

cart_unique_id 
An internal unique id for a cartridge.

barcode
Barcode number.

nominal_size_in_bytes
Nominal size measured in bytes.

last_access_time
Last access time.

media_type
The media type could be L3 for LTO3, L2 for LTO2 or none for DLT.

read-only
An indication of the write protection status of the cartridge. True means
it is read only and can't be written on. False means it can be written on.

principality_grid_id
The Grid ID of the repository that owns the cartridge.

principality_repository_id
The ID of the repository within the Grid that owns the cartridge.

container_name 
Could be only in a single container in a point in time.

Note: Grid ID will be common to all repositories within a Grid. Repository ID is
unique within a Grid.

v Replica: All cartridges that were replicated into this repository.

Note: This is relevant from the stand point of a Hub, or in 3.1 a Target cartridge

cart_unique_id
An internal unique id for a cartridge.

barcode
Barcode number.
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nominal_size_in_bytes
Nominal size measured in bytes.

last_access_time
Last access time.

media type
The media type could be L3 for LTO3, L2 for LTO2 or none for DLT.

read-only
An indication of the write protection status of the cartridge. True means
it is read only and can't be written on. False means it can be written on.

principality_grid_id
The Grid ID of the repository that owns the cartridge

principality_repository_id
The ID of the repository within the Grid that owns the cartridge

container_name
Shelf or library name. Could be only in a single container in a point in
time.

last_update_time
The last time the nominal size was updated - either by backup (in the
source) or by replication (at the destination).

source_repository_id_for_last_sync_point
The ID of the repository this cartridge was replicated from.

source_grid_id_for_last_sync_point
The ID of the grid this cartridge was replicated from.

source_time_for_last_sync_point
The time this cartridge was last synchronized with the source, in source
clock. For example if the last replication ended at 09:23 according to
source clock, and 11:23 according to destination clock, then this will
show 09:23.

destination_time_for_last_sync_point
The time this cartridge was last synchronized with the source, in
destination clock. For example if the last replication ended at 09:23
according to source clock, and 11:23 according to destination clock, then
this will show 11:23.

in_sync
Shows if this cartridge is the same as in the source or not. When starting
backup at the source this will turn to false. When the replication for this
cartridge ends, it will turn to true. Note: this is synchronized only if
there is a connection between the source and the destionation. To know
what is the time this flag is true, look at the "last sync point" fields
above.

v Origin: All cartridges that were replicated from this repository.

Note: This is relevant from the stand point of a Spoke, or in 3.1, an Origin
cartridge.

cart_unique_id
This is an internal unique id for a cartridge

barcode
Barcode number.
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nominal_size_in_bytes
Nominal size measure in bytes.

last_access_time
Last access time.

media_type
The media type could be L3 for LTO3, L2 for LTO2 or none for DLT.

read-only
An indication of the write protection status of the cartridge. True means
it is read only and can't be written on. False means it can be written on.

principality_grid_id
The Grid ID of the repository that owns the cartridge

principality_repository_id
The ID of the repository within the Grid that owns the cartridge

container_name
Shelf or library name where the cartridge exists.

destination_repository_id
The ID of the repository within the Grid that this cartridge was
replicated into.

destination_grid_id
The Grid ID of the repository that this cartridge was replicated into.

last_replication_time
This is the time when the last DFS file (last data unit) was replicated to
the destination.

last_sync_time
The recent time that the cartridge was being synced with the destination.

replicated_size
The nominal size (in bytes) replicated to that destination for this
cartridge.

backlog_size 
The nominal size of the backlog for this cartridge relative to the
destination. This is how much left to replicate for this cartridge to the
destination - only for cartridges that have triggers (need to replicate or
being replicated).

The set of cartridges is stated in the CLI command as ‘querytype'. So the query
type can be: ‘all', ‘replica', ‘origin'.
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Part 2. Working with ProtecTIER for VTL

This section of the guide describes how to work with ProtecTIER for VTL.
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Chapter 8. Managing the ProtecTIER Virtual Tape service

The ProtecTIER system provides many functions to managing the ProtecTIER
Virtual Tape (VT) service.

About this task

A virtual tape library emulates a physical tape library. The ProtecTIER system
emulates the library installation, library expansion, cartridge management, drive
addition, and drive allocation.

Setting the ProtecTIER VT host connections
This topic describes how the ProtecTIER front-end ports are connected.

Connect the ProtecTIER front-end ports to your backup environment. ProtecTIER
front-end ports can be connected either in FC loop topology or through fibre
channel switches.

Important: When modifying the front-end connectivity, it is recommended that
Loop topology be used for direct connection and P2P when fibre channel switches
are being used. If the topology is set to Loop in a fibre channel switch connection,
the link will go down.

If fibre channel switches are used, you must create zones to set up the appropriate
fibre channel connectivity between the ProtecTIER front-end ports and the fibre
channel ports in your backup environment.

Attention: The switch should be installed and correctly cabled before beginning
the configuration. For details, see the documentation provided with the switch.

Creating the zones
A ProtecTIER server front-end port shares zones with only backup server FC ports.
Each zone contains only one ProtecTIER front-end port.

Zoning can be defined by switch ports or by worldwide Names (WWNs).

Creating libraries
Complete this task to create a library for your ProtecTIER system.

Before you begin

Ensure that the following items are performed before proceeding with this task:
v Check with your administrator about the number of drives and cartridges

supported by your application.
v The virtual devices of the library are assigned to ProtecTIER server ports. Use

the Scan button of the Port attributes pane to verify that the ProtecTIER server
ports are connected to the correct host.
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About this task

Note: Check with your backup application administrator to ensure the number of
drives and cartridges supported by your application.

TS7610 or TS7620
Appliance Express TS7650G TS7650 Appliance

Maximum number of
libraries

4 16 12

Maximum number of
virtual drives

256 256 (dual-node 512) 256 (dual-node 512)

Note: The ProtecTIER server ports to which the virtual devices of the library are
assigned must be connected to the correct host. Use the Scan button of the Port
attributes pane to verify the port connections to the correct host. For more
information, see “Fibre Channel port attributes of a node” on page 126.

If your ProtecTIER node has ports connected to a host that is running HP-UX, you
must verify that the ports are configured as HP-UX ports. Use the Flat addressing
mode function from the Host Initiators Management screen to verify port
configuration. For more information, see “Managing host initiators” on page 81
and “Manually adding host initiators” on page 82. If these conditions are not met,
the host might not be able to detect all of the virtual tape drives.

Perform the following steps to create the library:

Procedure
1. From the toolbar, click the Create new library button. The Create new library

wizard Welcome screen is displayed.
2. Click Next. The Library details screen is displayed.
3. In the VT name field, enter a name for the library.
4. Click Next. The Library type screen is displayed.
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5. Select IBM TS3500 0100 as the type of physical library model that you want
the virtual library to emulate:

Note: For more information, see “Setting the library type” on page 68.
v ATL P3000 0100
v IBM TS3500 0100
You can also configure the virtual library models:
v DTC VTF 0100
v IBM V-TS3500 0100

Note: Verify that the backup application that you are using supports the type
of library model that you select. For more information, refer to the TS7650
Support Matrix at: http://www-03.ibm.com/systems/resources/
TS7650_Support_Matrix.pdf.

6. Click Next. The Tape model screen is displayed.
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7
6
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4

Figure 9. Library type screen
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7. Select the type of tape drive model that you want the virtual library to
emulate. The type of tape drive depends on the library type chosen:
v IBM ULT3580-TD3 (IBM LTO3)

Note: All tape drives in the library are of this type after your selection,
including tape drives added at a later time.

8. Click Next. The Tape drives screen is displayed.
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Figure 10. Tape model screen
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9. In the Number of tape drives field for each node, enter the number of tape
drives to assign to the node. To maximize load balancing, IBM recommends
that you distribute tape drives across the nodes based on the relative power of
the node servers.

10. Click Next. The Assignment screen is displayed.
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Figure 11. Tape drives screen
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Figure 12. Port assignment screen
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11. Select or clear the check boxes next to each port to define which of the node
ports are assigned virtual devices.

Note: If you have chosen an IBM library model, all the ports are selected and
enabled. If you have chosen a library model other than IBM, the ports are not
checked. In either case, you must select at least one port assignment that will
have a robot.

12. In the Drives fields corresponding to each selected port, select the number of
virtual tape drives that are assigned to each port.

Note: Optionally, click Select All to automatically select both ports. Click
Equally divide to evenly divide the number of drives between the ports.

13. Check the Robot check box if you want the library virtual robot to be
accessible through this port.

Note: For high-availability purposes, ProtecTIER supports the assignment of
the virtual robot to multiple ports.

14. Click Next.
15. Click Next. The Cartridges screen is displayed.

16. In the No. of cartridges field, enter the number of cartridges that you want to
have in the library. The Virtual cartridge size field automatically displays the
system for virtual cartridges. Capacity is based on the number of cartridges
entered, the total amount of available storage space in your repository, and the
current HyperFactor ratio.

Note: Optionally, select the Max. cartridge growth check box. When selected,
you can limit the maximum amount of nominal data that a cartridge can
contain.
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Figure 13. Cartridges screen
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The value of the maximum number of cartridges possible on a system
depends on the amount of storage space available on your system. The
maximum possible cartridge limit is 62,000, but many systems will have a
lower maximum limit because of the storage space available.

17. In the Barcode seed field, enter a value for the barcode seed. The barcode
seed is the barcode that is assigned to the first cartridge created. Every
cartridge added after the first cartridge is assigned a barcode following the
initial barcode seed.

Note: The barcode seed must contain only numbers and capital letters.
18. Click Next. The Slots screen is displayed.

19. In the Number of slots field, enter the number of cartridge slots that you
want to have in the library.

Note: The number of cartridge slots must not be less than the number of
cartridges that you are creating. If you expect to increase the number of
cartridges at a later time, it is recommended that you create additional slots.

20. In the Number of import/export slots field, enter the number of
import/export slots that you want to have in the library. You can define up to
a maximum of 1022 import/export slots for each library.

21. Click Next and Finish. The Create new library wizard closes.
22. Click Yes to continue. The ProtecTIER system temporarily goes offline to

create the library. The library is displayed in the Systems Management pane.

Renaming libraries
Complete this task to rename an existing ProtecTIER library.
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Figure 14. Slots screen
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About this task

The ProtecTIER system enables you to rename libraries after they have been
created.

Perform the following steps to rename an existing library.

Procedure

To rename an existing library:
1. Log in to the ProtecTIER Manager software.
2. Select a library from the navigation pane.
3. Choose VT > VT Library > Rename library. The Rename library dialog is

displayed.
4. Enter a new name for the selected library and click Ok. The Rename library

dialog closes and the library's name is changed.

Setting the library type

Note: Verify that the backup application that you are using supports the type of
library model that you select for a virtual tape system. Refer to the TS7620 Support
Matrix at: http://www.indabook.org/preview/
wyXeKaF5oviNlchFeGbhQAG3rhfjYA7IQYIN0pDoGWM,/IBM-System-Storage-
TS7650-TS7650G-TS7620.html?query=IBM-Support-Drivers-Download.

When you set the library type, you can select the type of physical library model
that you want the virtual library to emulate:
v ATL P3000 0100
v IBM TS3500 0100

You can also configure the virtual library models:
v DTC VTF 0100
v IBM V-TS3500 0100

If you chose the TS3500 (or P3000) during the creation of the library and your
backup application does not support that library model type as a virtual tape
system, the Set library type window allows you to change the library type to
V-TS3500 (or VTF). Conversely, if you chose the V-TS3500 (or VTF) during library
creation, and your backup application supports the TS3500 library, use Set library
type to change the library type. (You can interchange between the TS3500 and
V-TS3500 library models and between the P3000 and VTF library models.)

Example

To set the library type:
1. Select the library in the Systems Management pane.
2. Choose VT > VT Library > Set library type. The Set library type window is

displayed.
3. Specify the library type accordingly:
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4. Click Ok.

Editing library parameters
Complete this task to change the parameters of an existing library.

About this task

The ProtecTIER system enables you to change the parameters of libraries,
including the assignment of virtual devices, adding virtual tape drives, and
increasing library capacity.

Note: The Change dimensions wizard does not enable you to assign existing
unassigned tape drives. Use the Re-assign devices wizard to assign unassigned
tape drives. For more information, see “Reassigning devices” on page 72.

Perform the following steps to change the parameters of an existing library:

Procedure
1. Select a library from the Systems Management navigation pane.
2. Choose VT > VT Library > Change dimensions. The Change dimensions

wizard Welcome screen is displayed.
3. Click Next. The Tape drives screen is displayed.
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Figure 15. Set library type dialog
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4. In the Number of tape drives field enter the number of tape drives that you
want to have in the node.

5. Click Next. The Assignment screen is displayed.

6. Select or clear the check boxes next to each port to define which of the node
ports are assigned virtual tape drives.
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Figure 16. Tape drives screen
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Figure 17. Assignment screen
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7. In the Drives fields corresponding to each selected port, select the number of
virtual tape drives that are assigned to each port.

Note: Optionally, click Select All to automatically select both ports. Click
Equally divide to evenly divide the number of drives between the ports.

8. Optionally, click Track Changes to display the modifications that the
ProtecTIER system might need to make in response to the changes you
defined. Then, click Re-assign ports to return to the Assignment screen and
continue assigning virtual tape drives.

9. Check the Robot check box if you want the library virtual robot to be
accessible through this port.

Note: For high-availability purposes, ProtecTIER supports the assignment of
the virtual robot to multiple ports.

10. Repeat steps 6 on page 70 through 9 for the Assignment (2) screen.
11. Click Next. The Slots screen is displayed.

12. In the Number of slots field, enter the number of slots that you want in the
library.

Note: The number of slots must be at least equal to the number of cartridges
in the library.

13. In the Number of import/export slots field, enter the number of
import/export slots that you want in the library.

14. Click Next and Finish. The Change dimensions wizard closes.
15. Click Yes to continue. The ProtecTIER system temporarily goes offline to

update the library.
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Figure 18. Slots screen
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Reassigning devices
Complete this task to reassign the virtual robot and cartridge drives within the
ProtecTIER system.

About this task

The ProtecTIER system enables you to relocate the virtual robot and cartridge
drives between nodes or node ports.

Perform the following steps to reassign the virtual robot or cartridge drives:

Procedure
1. Select a library from the Systems Management navigation pane.
2. Choose VT > VT Library > Re-assign devices. The Re-assign devices wizard

Welcome screen is displayed.
3. Click Next. The Tape drives screen is displayed.

4. In the Number of tape drives field, select the number of tape drives to assign
to the node.

Note: If a node is currently down, you can only remove drives from that
node.

5. Click Next. The Assignment screen is displayed.
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Figure 19. Tape drives screen
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6. Select or deselect the check boxes next to each port to define which of the
node's ports are assigned virtual tape drives.

7. In the Drives fields corresponding to each selected port, select the number of
virtual tape drives that are assigned to each port.

Note: Optionally, click Select All to automatically select both ports. Click
Equally divide to evenly divide the number of drives between the ports.

8. Optionally, click Track Changes to display the modifications that the
ProtecTIER system might need to make in response to the changes that you
defined. Then, click Re-assign ports to return to the Assignment screen and
continue assigning virtual tape drives.

9. Check the Robot checkbox if you want the library virtual robot to be
accessible through this port.

Note: For high-availability purposes, ProtecTIER supports the assignment of
the virtual robot to multiple ports.

10. Click Next. The Summary report is displayed.
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Figure 20. Assignment screen

Chapter 8. Managing the ProtecTIER Virtual Tape service 73



11. Click Finish. The Re-assign devices wizard closes.
12. Click Yes to continue. The ProtecTIER system temporarily goes offline to

reassign the devices.

Control Path Failover (CPF) and Data Path Failover (DPF) support
This topic details the Control Path Failover (CPF) and Data Patch Failover (DPF)
that are supported by the emulated IBM library models.

Before you begin

Setting CPF/DPF within the IBM tape device driver is described in the IBM Tape
Device Drivers Installation and User's Guide located on the following Web site:
https://www-304.ibm.com/support/docview.wss?rs=577&uid=ssg1S7002972.

By default, Data Path Failover is always enabled on the emulated IBM library
models and requires no feature code.

By default, CPF is also enabled on the emulated IBM library models. However,
when troubleshooting host connectivity issues, you might be asked to disable CPF.

About this task

This task describes how to disable CPF:

Procedure
1. Select a library from the Systems Management navigation pane.
2. Select VT > VT Library > Set control path failover mode. The Set control path

failover mode dialog is displayed.
3. Set the CPF mode to Control path failover disabled. CPF is now disabled.
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Figure 21. Summary report screen
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What to do next

For further details on CPF and DPF support, refer to the TS7650 Support Matrix at
the following Web site: http://www-03.ibm.com/systems/resources/
TS7650_Support_Matrix.pdf.

Deleting libraries
Complete this task to delete a ProtecTIER library.

About this task

Attention: Deleting a library results in the loss of all data contained in that
library. Only a person with administrator authority can perform this task.

Perform the following steps to delete a ProtecTIER library.

Procedure

To delete a library:
1. Log in to the ProtecTIER Manager software.
2. Select a library from the Systems Management navigation pane.
3. Choose VT > VT Library > Delete library. A confirmation message box is

displayed.
4. Click Yes. The Data Loss Confirmation dialog is displayed.
5. In the field, type data loss and click Ok. A confirmation message box is

displayed.
6. Click Yes to continue. The ProtecTIER system temporarily goes offline to delete

the library.

Managing cartridges
The topics in this section describe how to manage cartridges from your libraries
within the ProtecTIER system.

Adding cartridges
Complete this task to add cartridges to your ProtecTIER system.

About this task

If your virtual library has enough empty slots to accommodate the additional
cartridges, the adding cartridges process occurs online without disrupting backup.
If the virtual library does not have enough empty slots, adding cartridges causes
the ProtecTIER system to temporarily go offline to create more slots for the
cartridges.

Perform the following steps to add cartridges:

Procedure
1. Select a library from the Systems Management navigation pane.
2. Click the Add cartridges button. The Add cartridges wizard Welcome screen is

displayed.
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3. Click Next. The Cartridges screen is displayed:

4. In the No. of cartridges field, enter the number of cartridges that you want to
have in the library. The Virtual cartridge size field automatically displays the
maximum possible size for virtual cartridges for your system. This number is
based on the number of cartridges entered, the total amount of available
storage space in your repository, and the current HyperFactor ratio.

Note: Optionally select the Max. cartridge growth checkbox. When selected,
you can limit the maximum amount of nominal data that a cartridge can
contain.
The value of the maximum number of cartridges possible on a system depends
on the amount of storage space available on your system.

5. In the Barcode seed field, enter a value for the barcode seed. The default
barcode seed is the continuation of the initial barcode seed assigned when the
library was created.

Note: The barcode seed must contain only numbers and capital letters.
6. Click Next and Finish. The Add cartridges wizard closes.
7. Click Yes to continue and add the cartridges to the library. If the necessary

number of cartridge slots are not already available, the ProtecTIER system
temporarily goes offline to create them. When the system returns online, the
cartridges are added to the library.

8. Continue working with the ProtecTIER system.

Deleting cartridges
Complete this task to delete a cartridge within the ProtecTIER VT system.
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Figure 22. Cartridges screen
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About this task

Deleting a cartridge results in the loss of all data contained in the cartridge.

Note: Deleting cartridges from an existing library increases the capacity size of
cartridges in all libraries in the repository by a percentage proportional to the
percent decrease in the number of cartridges. The change affects future backups.
The Data Size of full cartridges does not change.

Perform the following steps to delete a cartridge:

Note: Alternatively, you can delete a cartridge from the shelf. Deleting a cartridge
from the shelf is a nondisruptive operation (i.e. the VTL stays online). Thus, it is
recommended that you eject the cartridges you want to delete to the local shelf on
the repository, and then delete the cartridge.

Procedure
1. Select the library that contains the cartridge you want to delete. The VT

window is displayed.
2. Click the Cartridges tab. The Cartridges window is displayed.
3. Select a cartridge from the list of the cartridges displayed.
4. Choose VT > VT Cartridge > Delete Cartridges. A confirmation message box is

displayed.
5. Click Yes. The Data Loss Confirmation dialog is displayed.
6. In the field, type data loss and click Ok. A confirmation message box is

displayed.
7. Click Yes. The cartridge is deleted from the list.

Note: If the cartridges are deleted directly from the library (and not the shelf),
a confirmation message will display for the system to go offline.

Switching cartridges to read-only mode
Complete this task to change the cartridge mode to read-only.

About this task

Perform the following steps to change the cartridge mode to read-only:

Procedure
1. From the Systems Management view, select a library from the navigation

pane..
2. Click on the Slots tab.
3. Select a cartridge.
4. Choose VT > VT Cartridge > Read/Write cartridge. A confirmation message

box is displayed.
5. Click Yes. The cartridge switches to read-only mode.

Note: Clicking Read/Write cartridge for a read-only cartridge switches the
cartridge to the read/write mode.
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Verifying cartridge metadata
This task describes how to verify a cartridge's metadata.

About this task

Cartridge metadata is verified by reading the cartridge metadata to ensure that it is
intact and the cartridge is usable.

Follow the procedure to verify cartridge metadata:

Procedure
1. From the Systems Management view, select a library from the navigation pane.
2. Click on the Slots tab.
3. Highlight the cartridges to check.
4. Choose VT > VT Cartridge > Meta-data verification.
5. Click Yes to proceed with the operation. The Verification results display the

status of the selected cartridges, the barcode numbers and file marks.
6. Click Ok to close the window.

Verifying cartridge integrity
This task describes how to verify a cartridge's integrity.

About this task

Cartridge integrity is verified by reading the cartridge actual data while
performing CRC comparisons to ensure that the data is intact and the cartridge is
usable.

Follow the procedure to verify cartridge integrity:

Procedure
1. From the Systems Management view, select a library from the navigation pane.
2. Click on the Slots tab.
3. Highlight the cartridges to check.
4. Choose VT > VT Cartridge > Cartridges integrity verification.
5. Click Yes to proceed with the operation. The Verification results display the

status of the selected cartridges and the barcode numbers.
6. Click Ok to close the window.

Changing cartridge ownership (Principality)
Complete this task to change the ownership of a cartridge.

Before you begin

Using ProtecTIER Manager, you can change the principality of synchronized
cartridges to a different repository in the same replication group (without entering
DR mode). The following conditions must be true:

Both repositories must be available
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Both cartridges (source cartridge and it's replica cartridge) must exist (have not
been deleted) on relevant repositories.

Note: When you run a VTL repository takeover, the principality of the cartridges
from the destroyed repository is automatically changed to the replacing repository.
Refer to “Replacing a destroyed VTL repository ” on page 146 for more
information.

About this task

Cartridge ownership, or "principality", is the privilege to write to a cartridge (set it
to read/write mode). The principality of each cartridge belongs only to one
repository in the grid, and, by default, principality belongs to the source repository.

Follow the procedure below to change the cartridge principality:

Procedure
1. In the Systems Management view, select a VT library from the navigation

pane.
2. Click the Cartridges tab to display detailed information about the virtual tape

cartridges in the library.
3. Highlight the synched cartridges from the VT library on which you want to

change principality and right-click.

Note: Additionally, you can use the Principality Cartridge Query Tool to
select cartridges for principality change by filtering the cartridges that are
"in-sync".
To access the Principality Cartridge Query Tool, choose one of the following
options:
v Right-click and select Cartridge principality change > Principality

Cartridge Query Tool , or
v Select VT > VT Cartridges > Principality Cartridge Query Tool from the

menu.
Refer to “Using the cartridge query tool (for VTL)” on page 164 for more
information.

4. Select Cartridge principality change > Mark selected cartridges to be
processed from the popup menu.
The following message is displayed:
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Figure 23. Cartridge selection details message
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5. Click Switch. You are automatically switched to the ProtecTIER Replication
Manager and the Change principality window is displayed:

Note: Additionally, you can display the Change principality window by
selecting Group > Change principality.

6. From the drop-down lists, select the repository from the Change principality
from: field from which to change the cartridge principality.

Tip: If this window was displayed immediately after selecting cartridges in
the System Management view, the repository displayed in the Change
principality from: field should be correctly displayed by the system. Choosing
a different repository from the drop-down list forces you to use the Import
from a .CSV file option.

7. Select the repository from the To field to which to change the cartridge
principality.

8. Click Run.
9. Click Yes to confirm running the operation.

If the change principality operation is successful, a message will display that
the operation succeeded, how many cartridges were sent for processing, and
how many of the cartridges were valid for principality change.

10. Click Yes to download a summary report.
11. If cartridges were marked for change principality in the Systems Management

view, then the Use cartridges selection button is enabled. Click Details... to
view the cartridges selected.

Note: If no cartridges were marked for change principality in the Systems
Management view, then the only option offered is to import the cartridge
selection from a .csv file created from either the PTCLI, or Cartridge query
tool.
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Figure 24. Change principality window

80 IBM TS7610 and TS7620 ProtecTIER Deduplication Appliance Express: ProtecTIER User's Guide for VTL Systems



Results

Once the change principality operation has succeeded, the Principal column in the
cartridge view will show to which repository the principality has been changed.

What to do next

Go to “Backup properties” on page 134.

About LUN Masking
Use LUN Masking to monitor device visibility. LUN Masking "masks" specific
devices (tape drives or robots) from the view of host initiators while allowing a
selected host initiator group to view them.

LUN Masking allows you to assign specific devices to a specific host running
backup application modules. It enables multiple initiators to share the same target
FC port without having conflicts on the devices being emulated.

The LUN Masking setup can be monitored and modified at all times during
system operation. LUN Masking in ProtecTIER influences the visibility of the
devices by the hosts systems. Keep in mind that every modification in the LUN
Masking in ProtecTIER might affect the host configuration and might require
rescanning by the hosts.

Enabling or disabling LUN Masking
The LUN Masking settings are disabled, by default, but can be either enabled or
disabled. Configuration operations can be done in either mode, but the relevant
changes are applied only when LUN Masking is enabled.

About this task

If LUN Masking is enabled, devices are seen only by the hosts that are defined
with them in the same LUN Masking group. If LUN Masking is disabled, all
devices are seen by all hosts. Follow the steps below to enable or disable LUN
Masking:

Procedure
1. Select VT > LUN Masking > Set LUN Masking enablement.
2. Select Enable LUN masking to turn on LUN Masking, or Disable LUN

masking to turn off LUN Masking.
3. Click Ok.

What to do next

Once you have enabled or disabled the LUN Masking option, IBM recommends
that you re-scan the devices from the host systems. Re-scanning sends the updated
information for the list of visible devices and their associated LUN numbers.

Go on to “Managing host initiators.”

Managing host initiators
The Host Initiators Management option is used to add, modify, or delete host
initiators from the list of host initiators known to ProtecTIER.
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Note: A host initiator must be defined before it can be a part of a LUN Masking
group. Up 1024 host initiators can be defined on a system. See “Working with
LUN Masking groups” on page 85.

To add, modify or delete host initiators, select VT > Host Initiators Management
to access the Host Initiators Management functions. The Host Initiators
Management screen displays the following details of the host initiator:
v WWN
v Alias – a name that is defined other than the WWN
v Group associated – the LUN Masking group to which the host initiator belongs
v Flat addressing mode - a technique used by HP-UX to work around certain SCSI

addressing limitations when accessing many devices over a Fibre Channel
v Link up – displays whether there is an active link between ProtecTIER and the

host initiator

From this screen, go on to adding or scanning host initiators, modifying host
initiator configurations, or deleting host initiators.

Adding Host Initiators
This section describes how to add host initiators with the Host Initiators
Management window.

Host initiators can be added to the host initiators list either manually, or by
scanning the system for new host initiators. Follow either one of the following
procedures below for adding host initiators:
v “Manually adding host initiators”
v “Scanning host initiators” on page 83

Manually adding host initiators:

Host initiators can be added manually by entering the host WWN, alias, and
addressing mode. A host initiator can be added either by accessing the Host
Initiator Management window from the VT menu, or from the LUN Masking
group configuration window.

About this task

Manually adding host initiators is primarily done when hosts are not yet
connected to ProtecTIER.

Note: A host initiator must first be defined before it can be a part of a LUN
Masking group.

Procedure

To add a new host initiator:
1. Select VT > Host initiators management. The Host initiator management

window displays.
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2. Click Add. The Add host initiator screen is displayed.
3. Select a WWN from the WWN dropdown box or type in a new WWN.
4. Enter an alternative name for the WWN in the Alias field.
5. Select the Flat addressing mode check box if the flat addressing technique is to

be used.
6. Click Ok. The new host initiator is listed on the Host initiators management

screen.

What to do next

Go on to add more new host initiators or to modify or delete existing host
initiators. Once you have defined a host initiator, you can create LUN Masking
groups. See “Working with LUN Masking groups” on page 85.

Scanning host initiators:

Host initiators can be added to the configured host initiators list after scanning the
system. Scanning for new host initiators is recommended when the host initiators
are already physically connected, but you have not yet added them to the Host
Initiators list.

About this task

Use the following procedure to scan for new host initiators.

Procedure

To scan for new host initiators:
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Figure 25. Host Initiator management window
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1. Select VT > Host initiators management. The Host initiator management
window displays.

2. Click Re-scan for new initiators to scan for new host initiators. If new host
initiators are found that are not already configured in the Host Initiators list, a
dialog with the available host initiators appears.

3. Select the Host Initiators you want to add.
4. Click Yes to add the new host initiators to the list, or click Cancel to exit

without adding.

What to do next

Go on to “Working with LUN Masking groups” on page 85.

Modifying Host Initiators
You can change the host initiator alias or addressing mode or both.

About this task

Use the following procedure to change the host initiator alias or addressing mode
or both:

Procedure
1. Select Host initiators management from the VT menu. The Host initiators

management screen is displayed.
2. Select a host initiator from the list and click Modify. The Modify host initiator

dialog is displayed.
3. Change the host initiator alias by typing a new name in the Alias field.
4. Change the addressing mode by selecting or clearing the Flat addressing mode

check box.
5. Click Ok to save and close the Modify host initiator dialog, or select a

different host initiator to modify from the drop-down list in the WWN field.

What to do next

Continue working with the options available from the Host Initiators
Management screen to add, remove, modify, or rescan for new initiators.

If you have finished working with the Host Initiators Management screen, click
Save Changes to save your changes and exit, or click Cancel to exit without
saving your changes.

Removing Host Initiators
Configured host initiators cannot be deleted if they act as members of a LUN
Masking group. See Removing a LUN Masking group for more information.

About this task

Use the following procedure to remove a host initiator that is not a member of a
LUN Masking group:

Procedure
1. Select Host initiators management from the VT menu. The Host initiators

management screen is displayed.
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2. Select a host initiator from the list and click Remove. The Remove host
initiator dialog is displayed.

3. Click Yes to remove.

What to do next

Continue working with the options available from the Host Initiators
Management screen to add, remove, modify, or rescan for new initiators. If you
have finished working with the Host Initiators Management screen, click Save
Changes to save your changes and exit, or click Cancel to exit without saving your
changes.

Working with LUN Masking groups
LUN Masking groups define the connection between the host initiators and the VT
library devices (robots or tape drives). Devices which belong to a certain group can
be seen by the host initiators of the group. A device can belong to multiple LUN
Masking groups, but a host initiator can belong to only one LUN Masking group.

Select the Configure LUN Masking groups option from the VT > LUN Masking
menu to begin configuring LUN Masking groups.

You can add LUN Masking groups. If a group exists, configure the group by
adding Host Initiators, adding or modifying libraries, or adding or modifying the
devices within the libraries.

Note: Keep in mind that changes you make in the LUN Masking configuration
requires scanning by the host and by the backup application.

Creating LUN Masking groups

Begin working with LUN Masking groups by adding a group via the LUN
Masking window. A maximum of 512 groups can be configured per system and a
maximum of 512 drives can be configured per group. (A maximum of 1024 host
initiators can be defined on a system.) Each group needs to contain at least one
host initiator and one device (tape drive or robot). Robots can be added as
required.

To add a LUN Masking group:
1. On the left side of the LUN Masking window, click Add at the bottom of the

LUN Masking Groups pane. The group details appear to the right of the
window.
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2. Type a new name for the group in the Group name field.
3. Add host initiators by clicking Add in the Selected Host Initiators pane. The

Add Host Initiators dialog is displayed.
4. Select the Host Initiators to add to the LUN Masking group from the list

displayed and click Ok.
5. Continue adding more host initiators, or go on to add the library devices.

From the Library Mappings pane, you can add the library devices you want to be
visible to the host initiators in the group.
1. To define the devices, click Add at the bottom of the Library Mappings pane in

the LUN Masking group details view. A list of libraries in the system is
displayed.

2. Select the relevant libraries from the list and click Ok

Continue selecting the library devices to be viewed by the host initiators in the
group.

Modifying a LUN Masking group

From the Selected Devices pane, modify the libraries and devices defined in the
LUN Masking group. Once you have finished, click Save changes to save your
modifications and exit the LUN Masking configuration.

After modifying a LUN Masking group, undesired holes might occur within the
LUN numbering sequence. For example, removing a device from an existing group
causes holes in the LUN numbering if this device does not have the highest LUN
number. As a result, the backup application might have trouble scanning the
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Figure 26. LUN Masking window
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devices. If your backup application has trouble scanning the devices, it is
recommended that you reassign or renumber the LUN.
1. Reassign the LUNs by clicking Reassign All LUNs at the bottom of the

Selected Devices pane.
The system displays the Reassign LUNs dialog, which states "You are about to
renumerate the LUN values of the available devices in the group. All the
connected hosts must be rescanned."

2. Click Yes to renumerate.
The LUN values are renumbered and all the devices in the Selected Devices
pane are assigned new LUN numbers, sequentially, starting with “0” (zero).

3. Click Save changes to keep the modifications or Cancel to close the wizard.

Remember: As noted in the dialog opened in step 1, you must rescan drives from
all affected Host Initiators in the specific group.

Continue to the next section.

Removing a LUN Masking group

If a LUN Masking group is removed while LUN Masking is enabled, the host
initiators of that group become ineffective. They are unable to "see" any devices on
this system. The host initiators must be reassigned to a different group to be
reconnected.

To remove a LUN Masking group, click Remove at the bottom of the LUN
Masking groups pane. The LUN Masking group is removed from the list.

Continue configuring the LUN Masking groups as appropriate. Click Save changes
to save your modifications and exit the LUN Masking configuration.

Library-related operations
Some library configuration operations might affect the LUN masking groups. Most
of these operations are blocked by the system, with the exception of operations
where the removal of the devices might directly affect the relevant LUN Masking
group. The Delete library operation and the Change library dimensions operation
to reduce the number of drives are not blocked by the system.

Deleting a library

If devices from a deleted library are members of LUN Masking groups, a warning
is issued to the log file and to the user. If the user proceeds with the operation, the
devices are removed from the relevant LUN Masking groups, and the
configuration file data is updated accordingly.

Removing a library can cause "holes" in the LUN Masking numbering and,
therefore, the backup application might have trouble scanning the devices. In this
case, you must reassign the LUN.

Modifying the dimensions or reassigning devices of a library

The following rules apply when you modify the dimensions of a library or
reassign library devices that belong to a LUN masking group:
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v The device cannot be deleted or reassigned to another FE port. To reassign the
device to a different port, you must remove the device from all of its related
groupings.

v The number of drives in the library cannot be reduced.

Continue to the next chapter.
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Chapter 9. Native Replication Management (for VTL)

This chapter provides the information needed to manage Native Replication
configuration and monitoring of ProtecTIER VTL systems.

Native Replication lets you replicate data objects between ProtecTIER repositories.
In order for a logical set of repositories to replicate from one to another, you must
create a replication grid. The replication grid is remotely created and managed by
the Replication Manager.

The ProtecTIER Replication Manager is a server that remotely manages the
replication grids within an organization. ProtecTIER Manager connects to the
ProtecTIER Replication Manager using the IP address of the ProtecTIER Replication
Manager server. The ProtecTIER Replication Manager is installed on a ProtecTIER
node and can manage up to one grid with 24 repositories.

Each ProtecTIER Replication Manager has a unique identity. A repository, once it
has joined a replication manager cannot join a replication grid managed by a
different replication manager, even if it has left the grid. This restriction prevents
data collision.

In a VTL environment, replication groups are created where multiple source
repositories can replicate to a single target. This target can then act as a Disaster
Recovery site for any number of the sources, while still allowing local backups, as
well as replication, from the active source repositories.

Go on to “Working with ProtecTIER Replication Manager.”

Working with ProtecTIER Replication Manager
This section describes how to manage Native Replication by working with
ProtecTIER Replication Manager.

The ProtecTIER Replication Manager tasks include:
v Managing the repositories in the replication grid that can be replicated to
v Maintaining the IP addresses of all repositories
v Updating of repositories leaving and joining the grid
v High-level monitoring and statistics of traffic in the replication grids

Connecting to a ProtecTIER Replication Manager

To begin adding and working with a replication grid, click the Grids Management
button at the bottom of the navigation pane of ProtecTIER Manager.

Use the following procedure to connect to a new ProtecTIER Replication Manager:
1. Select Replication Manager > Add Replication Manager. The Add ProtecTIER

Replication Manager dialog is displayed.
2. Enter the IP address of the ProtecTIER Replication Manager you want to add

and click Ok. The ProtecTIER Replication Manager Login is displayed.
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Logging in to a ProtecTIER Replication Manager

Log in to a ProtecTIER Replication Manager:
1. Select Replication Manager > Login. The login screen is displayed.
2. Enter the Username: gmadmin and Password: gmadmin.
3. Click Ok. The Replication Manager view is displayed.

Removing a ProtecTIER Replication Manager

Before you remove a ProtecTIER Replication Manager, you must first log out of the
Replication Manager you want to remove.
1. Select the Replication Manager for removal from the Grids Management

navigation pane.
2. Select Replication Manager > Logout. You are now logged out.
3. Select Replication Manager > Remove Replication Manager. The Remove

Replication Manager dialog is displayed asking if you want to remove the
connection to the Replication Manager you selected.

4. Click Yes. The Replication Manager is removed from the list in the Grids
Management navigation pane.

Go on to “Managing the replication grid.”

Managing the replication grid
The topics in this section define tasks used when working with the replication grid
in a VTL environment.

Management and configuration of a replication grid is done through the
ProtecTIER Replication Manager Grids Management view of ProtecTIER Manager.
A replication grid is composed of a set of repositories that share a common ID and
can potentially transmit and receive logical objects through replication. Repositories
do not need physical connections between them. However, all repositories do need
a network connection to the ProtecTIER Replication Manager server. ProtecTIER
Replication Manager is installed on a ProtecTIER node and can manage up to one
grid with a total of 24 repositories.

In a many-to-one environment, a single replication grid can include up to eight
target repositories and, therefore, up to 8 "topology groups". A "topology group" is
a replication group of one target repository with up to 12 source repositories
connected to it.

In a many-to-many environment, a replication grid can have up to 2 groups of 4
target/source repositories replicating to each other per group. So, it can have up to
two "topology groups" for a total of 8 members.

Creating a replication grid

Use the following procedure to create a replication grid:

Note: Grid IDs and repository IDs are numbers that are never recycled. Even if a
repository “leaves” the grid and “re-enters” the grid, it does not receive the same
ID. Thus, actions like leaving a grid are expected to be rare and are not a part of
the normal flow of work.
1. Click Create new grid. The Create new grid dialog is displayed.
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2. Complete the fields to define a grid. Type a unique Grid ID or select a unique
Grid ID number (0 - 63) from the drop-down list and enter a name in the
Name field.

Note: ProtecTIER does not allow you to choose an ID that has already been
used.

3. Click Ok. The new grid is added to the Grids list in the navigation pane of the
Grids Management view.

Deleting a replication grid

Deleting a grid is only allowed if the grid is empty. In addition, once you have
deleted a grid, the Grid ID cannot be reused. Being that there are only 64 grid
numbers (0 - 63), deleting a grid means that you 'lose' one grid ID.

Taking over a VTL repository

If the repository at the production site (source) has been destroyed and cannot be
repaired, you can replace it with a new repository. See “Replacing a destroyed VTL
repository ” on page 146.

Displaying removed repositories

To display a list of removed (unrecoverable) repositories and their replacements,
click Grid > Show removed repositories. A table is displayed showing the list of
removed repositories and their replacements according to their ID numbers and
names.

Go on to “Working with repositories in a replication grid” on page 92.
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Figure 27. Show removed repositories window
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Working with repositories in a replication grid
The topics in this section explain how to manage and work with repositories in a
replication grid.

Note: Repositories can replicate to each other only if they are part of the same
grid. In addition, a repository cannot be a member of more than one grid.

Adding a repository to a replication grid
This task explains how to add a repository to a grid.

About this task

When you add a repository to a replication grid, the repository can be defined as a
source or a destination.

To add a repository to a replication grid:

Procedure
1. From the Grids Management view, select Repository > Add repository to grid.

The Add repository to grid window is displayed.

Note: A repository cannot be a grid member of more than one grid.
2. Type the network replication IP address of the repository in the Replication IP

address field.
3. Enter the username and password of the repository (User name: ptadmin and

Password: ptadmin).
4. Click Ok. The repository is added to the replication grid.
5. If you have additional repositories to add to the replication grid, repeat this

procedure for each one.

What to do next

Go on to “Working with Replication Groups in VTL” on page 93.

Removing a repository from a grid
You can use the ProtecTIER Replication Manager to remove a repository from a
grid.

About this task

Note: Before removing a repository from a grid, carefully consider the potential
effects on the system configuration. Once the repository is removed from the grid,
all the bandwidth reduction and replication deduplication information is deleted.
The relationship between the original and replicated cartridge pair is lost and they
cannot be updated in the same pair. If the repository rejoins the same grid, it looks
like a new repository in the grid with a new ID, and all data should be replicated
from beginning by new policies. Therefore, removing a repository from a grid is an
operation you should plan with a PT specialist.

A repository can be removed from a grid only if it is a stand-alone repository. See
“Modifying a Replication Group for VTL” on page 97.

To remove a repository from a grid:
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Procedure
1. From the Grids Management view, click the repository you want to remove.
2. Select Repository > Remove repository from grid. The Remove repository

from grid window is displayed.
3. Complete the login information by typing the User name and Password of the

repository.
4. Click Ok. The repository is removed from the grid.

What to do next

Note: Remove a repository from a grid, without coordination with the Replication
Manager, only if the ProtecTIER Replication Manager thinks that the repository is
not a part of the grid already, or the Replication Manager was destroyed and is not
meant to be restored. To remove a repository from a grid without coordination, see
“Forcing a repository to leave a grid” on page 208.

Updating the replication IP address of a grid member
Complete this task to update the Replication Manager about a change in the
replication IP address of a grid member.

If the replication IP address of a grid member is changed, you need to update the
ProtecTIER Replication manager with the new IP address.

To update the replication manager about a change in the IP address of a repository,
select Repository > Update repository address. The Update repository address
screen appears. Enter the updated IP address and click Ok.

Working with Replication Groups in VTL
This section describes how to work with replication groups in "many-to-one" and
"many-to-many" VTL environments.

In a "many-to-one" VTL environment, replication groups are created where up to
12 source repositories ("spokes") can receive local backups and replicate to a single
destination ("hub"). The destination repository can, then act as a Disaster Recovery
site for any number of the source repositories, and still allowing local backups, as
well as replication, from the active source repositories.

In a "many-to-many" VTL environment, replication groups are created where
multiple repositories can replicate to each other. A many-to-many replication group
can be defined with up to four repositories, where each repository assumes the
responsibility of a hub repository and can receive local backups, replicate data to
remote hub repositories, as well as receive replicated data from remote hub
repositories.

The same cartridge can be replicated from its principal repository to up to three
destination repositories. Different cartridges can be replicated between multiple
hub repositories in a bidirectional manner.

Note: Source repositories are not supported in a four-way many-to-many
replication grid.

Creating a Replication Group for VTL
This task explains how to create a replication group in a replication grid for VTL.
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About this task

Before defining any replication policy, you must create a replication group with a
physical connection between the repositories. Different steps are followed for
creating a replication group in "many-to-one" and "many-to-many" topologies.
v If you are creating a replication group in a many-to-one topology, see

“Many-to-one topology.”
v If you are creating a replication group in a many-to-many topology, see

“Many-to-many topology” on page 95.

Many-to-one topology
Follow this procedure to connect a source and destination repository in a
many-to-one replication group.

Procedure
1. From the Grids Management view, click a stand-alone repository.
2. Select Group > Replication group management. The Replication group

management wizard is displayed. Click Next.

Tip: The Replication group management wizard can be accessed in a number
of ways, either: right-click on a repository and select Replication group
management, click the Replication group management icon on the toolbar, or
select Group > Replication group management.
The following window is displayed:

3. Select the Many-To-One (VT systems) topology and click Next. The Hub
selection window is displayed.

4. Select a repository to set as the destination from the Hub repository
drop-down list and click Next. The Repositories selection window is
displayed.
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Figure 28. Many-to-one replication method topology window
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5. Select the repositories to connect as spokes for the selected hub and click Next.
The Preview window of the replication group is displayed.

6. Type a Group name in the Replication group settings window and click
Finish. The Replication group management wizard closes and the replication
group is displayed in the Replication Manager.

What to do next

Repeat this procedure or run the “Many-to-many topology” procedure to create
additional replication groups, or go on to define and create replication policies (see
“Replication policies” on page 98). To continue modifying the replication group
(see “Modifying a Replication Group for VTL” on page 97.

Many-to-many topology
Follow this procedure to connect up to 4 destination repositories in a
many-to-many replication group.

Procedure
1. From the Grids Management view, click a stand-alone repository.
2. Select Group > Replication group management. The Replication group

management wizard is displayed. Click Next.

Tip: The Replication group management wizard can be accessed in a number
of ways, either: right-click on a repository and select Replication group
management, click the Replication group management icon on the toolbar, or
select Group > Replication group management.

3. Select the Many-To-Many (VT systems) topology as shown:

4. Click Next. The Repositories selection window is displayed.
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Figure 29. Many-to-many replication method topology window
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5. Select the destination repositories from the list that appears to be part of the
replication group.

6. Click Next. The Preview window of the Replication Group is displayed.
7. Type a Group name in the Replication group settings window and click

Finish. The Replication group management wizard closes and the replication
group is displayed in the Replication Manager.

What to do next

Repeat this procedure or run the “Many-to-one topology” on page 94 to create
additional replication groups, or go on to define and create replication policies (see
“Replication policies” on page 98). To continue modifying the replication group
(see “Modifying a Replication Group for VTL” on page 97.

Adding a stand-alone repository to a replication group
This task explains how to add a stand-alone repository to a replication group.

About this task

Use the Replication group management wizard to add and remove stand-alone
repositories from a replication group.

Procedure
1. From the Grids Management view, click a stand-alone repository.
2. Select Group > Replication group management. The Replication group

management wizard is displayed.

Tip: The Replication group management wizard can be accessed in one of the
following ways:
v Right-click on a repository
v Click the Replication group management icon on the toolbar
v Select Group > Replication group management

3. Click Next. The following options appear:
v Creating a new replication group
v Join an existing replication group

Note: In order to create a replication group, there must be at least two
stand-alone repositories in the grid.
To join an existing replication group, go on to “Adding a stand-alone repository
to an Existing Replication Group” on page 97. If you are adding a repository to
a new replication group, continue with step 4

4. Select Creating a new replication group.
5. Click Next. The Repositories selection window is displayed.
6. Select the repositories to be added to the replication group.
7. Click Next. A preview of the replication group is displayed.
8. Type the appropriate name of the replication group and click Finish. The

Replication group management wizard closes and a new replication group is
created.
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What to do next

Once the operation is complete, go on to define and create replication policies (see
“Replication policies” on page 98), or continue working with replication groups.

Adding a stand-alone repository to an Existing Replication
Group
Procedure
1. From the Grids Management view, click a stand-alone repository.
2. Select Repository > Replication group management. The Replication group

management wizard is displayed.
3. Click Next. The following options appear:
v Creating a new replication group
v Join an existing replication group

4. Select Join an existing replication group.
5. Click Next. The Group selection window is displayed.
6. Choose an existing replication group to join from the Existing replication

group drop-down list. A preview of the existing replication group selected is
displayed.

7. Click Finish. The wizard closed and the repository is added to the existing
replication group.

What to do next

Once the operation is complete, go on to define and create replication policies (see
“Replication policies” on page 98), or continue working with replication groups.

Modifying a Replication Group for VTL
This task explains how to modify an existing replication group by adding or
removing members.

About this task

Use the Replication group management wizard to add and remove repositories
from an existing replication group.

Procedure
1. From the Grids Management view, click a repository in an existing replication

group.
2. Select Group > Replication group management. The Replication group

management wizard is displayed.

Tip: The Replication group management wizard can be accessed in one of the
following ways:
v Right-click on a repository
v Click the Replication group management icon on the toolbar
v Select Group > Replication group management

3. Click Next. The Repositories selection window is displayed. Repositories that
are already members of the replication group are checked and standalone grid
members appear cleared.

Note: In a many-to-one topology, this window will appear as Spokes selection.
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4. Select or clear the repositories to add or remove from the replication group.
Alternatively, Select all adds all the repositories in the selection list to the
replication group. Select none removes all the repositories from the replication
group.

Note: When you clear a check box for a repository, the Group status appears
as Deleted. If you select a repository to add, the Group status appears as New.

5. Click Next. The Preview window of the replication group is displayed.
6. Click Finish. The Replication group management wizard closes. A Confirm

operation window is displayed with a notification that all running and pending
replications will be aborted from the deleted members and that unreachable
repositories will not be updated with the changes.

7. Click Yes to continue with the operation, or No to cancel the operation.

What to do next

Once the operation is complete, go on to define and create replication policies (see
“Replication policies”), or continue working with replication groups.

Replication policies
The topics in this section describe how to manage replication policies in a VTL
environment.

Defined and managed through the Systems Management view of ProtecTIER
Manager, a replication policy can only be created on a repository that is a member
of a replication group and applies only to the repository on which it's defined. A
replication policy defines a set of objects (for example, cartridges) from a repository
that need to be replicated to a remote repository. A replication policy serves as the
only means to transfer de-duplicated data from a source repository to a destination
repository.

Using a set of rules, an event occurs, for example, which indicates that the data
segment on a cartridge has changed and that replication may be needed for the
specific cartridge. Once the event matches with a policy, a "trigger" is created for
replication activity and a job occurs.

In a many-to-many environment, up to 256 policies may be defined per repository
and up to 1023 ranges of cartridges may be defined per replication policy. A source
repository can replicate a range of cartridges to up to three different destination
repositories with different priorities. "Visibility switching" can be enabled on one of
the destination repositories. See “Creating a replication policy” on page 99 for
more information.

Select Replication Policies in the navigation pane to view the policies defined.
Select a policy from the list to view the policy details and replication statistics per
destination.
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The following sections describe how to create and work with replication policies:
v “Setting the weekly replication timeframe” on page 103
v “Setting the replication rate limit” on page 105
v “Limiting the network interface bandwidth” on page 107
v “Creating a replication policy”
v “Enabling and disabling a policy” on page 101
v “Running a policy” on page 101
v “Modifying a policy” on page 102
v “Deleting a policy” on page 103

Creating a replication policy
This section describes how to create a replication policy using the Create policy
wizard in the ProtecTIER Manager software.

When creating a replication policy, the following parameters are defined:
v Replication policy name
v Barcode ranges
v Replication destination
v Visibility change

"Visibility change" is the means by which you can determine “where” cartridges
actually exist. From a backup application standpoint, a specific cartridge or
barcode can “exist” in only one location at a given time. Once exported by the
backup application, cartridges can be placed on a virtual shelf that is visible via
ProtecTIER, providing more flexibility in managing tapes/cartridges and where
they are kept – similar to keeping physical tapes on an actual shelf outside of
the tape library.
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Figure 30. View of replication policy
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About this task

To create a replication policy, complete the following steps:

Procedure
1. Choose Replication > Replication Policy > Create policy. The Welcome

window of the Create policy wizard is displayed.
2. Click Next. The Properties window is displayed. Type a unique policy name

in the Policy name field. You cannot have the same policy name twice. If you
do define the same policy name, an error message is displayed.

3. Select the Policy enabled checkbox to run the policy within the timeframe
defined. All incoming replication events will look to apply their rules to the
policy's definition. If the Policy enabled checkbox is not selected, no
replication activities will take place.

4. Click Next, the Destinations window is displayed.
5. From the Destinations option, select the repositories on which to run the

defined policy.

Note: If a member has left the replication group, the policy destination will be
removed from the list and a warning will display that the member will be
removed from the policy.

6. Select a Priority per destination.
Policies have 3 options of priority: High, Medium, Low. Define the policy's
Priority according to the importance and/or urgency of the data that needs to
be transferred. For example, a policy with a high priority is transferred first,
then a policy with medium priority, followed by low priority. The default is
Low for every policy.

7. Click Next. The Visibility window is displayed.
Visibility controls the location of replicated cartridges at the destination
repository. Destination replica cartridges can be "invisible" (if you choose
shelf) or "visible" (if you choose a library).
v If Visibility enabled is not activated, the destination will be shelf for all of

the repository destinations.
v If Visibility enabled is activated, you can choose a library for one of the

destination repositories. The other destination repository targets will be
shelf.
Upon ejecting a cartridge, it is first moved to the shelf on the local
repository. On the remote repository, the cartridge is moved to the
import/export slot of a library so that the backup application on the remote
site can see it.

8. Select a repository from the Repository dropdown list and the target on the
destination repository, either the shelf or a library, from the Library dropdown
list.

9. Click Next. The Ranges window is displayed. The policy objects, i.e.
cartridges, are defined as barcode ranges. There can be up to 256 ranges in a
single policy.

10. Type the From and To barcodes for a range of cartridges to be replicated.
11. Click Add to view the range in the Ranges table. If a barcode number or

barcode range appears more than once, an error message is displayed with the
conflict.

12. To delete the barcode ranges from the table, click Select all and Remove, or
click Select none to deselect.
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13. Click Next and Finish to commit and save the policy on the server. The
Summary report is displayed with the policy name and the number of
barcode ranges that were defined.

What to do next

Go on to “Enabling and disabling a policy.”

Enabling and disabling a policy
You can enable or disable a policy from ProtecTIER Manager.

A policy can be enabled or disabled per destination. In the detailed view of a
policy, an indication displays whether the policy is enabled, disabled, or enabled
with some of its destinations disabled.

Enabling a policy

Upon successfully creating a policy, by default, the policy is enabled. This means
that all incoming replication events will look to apply their rules to the policy's
definition. If a policy is disabled, you can enable it from ProtecTIER Manager. This
does not affect current running activities. Selecting Policy enabled automatically
runs the policy within the timeframe defined. If Policy enabled is not selected, no
activities will take place.

To enable a policy:
1. From the Systems Management view, select a policy from the Replication

Policies pane.
2. Select Replication > Replication policy > Enable policy. The policy is enabled.
3. Go on to “Running a policy.”

Important: After you enable a policy, it is best to run the new policy quickly to
ensure that all the pending replication activities are included in the replication.
Otherwise, only further backups will be triggered for a replication

Disabling a policy

A policy can be disabled at any time from ProtecTIER Manager. If a policy is
disabled, all incoming replication events will “ignore” the policy from the moment
it is disabled. This does not affect current running and pending activities.

To disable a policy:
1. From the Systems Management view, select a policy from the Replication

Policies pane.
2. Select Replication > Replication policy > Disable policy. The policy is

disabled.
3. Go on to “Running a policy.”

Running a policy
Complete this task to run a policy.

Policies can be run either manually or automatically. Whenever replication events
are received, policies are continuously run. The most common types of triggers for
automatic replication are:
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v backup
v eject
v unload cartridge

Manually run policies create replication jobs for all the valid cartridges in their list,
whether or not they need to be replicated.

Running a policy leads to lining up replication jobs in their respective priority
queues where they wait for resources and the replication timeframe to start
replicating.

To run a policy:
1. Select Replication > Replication Policy > Run replication policy.
2. Select the destination repositories on which to run the repository.
3. Click Run. The replication policy will begin to run.

Note: If you run a policy with a single destination, no destinations need to be
selected. Or, if you select multiple policies to run, no destinations are chosen.

Running a policy on a cartridge

You can also replicate a specific cartridge that is within the range of cartridges in a
specific policy. To manually run the policy on the specific cartridge, select the
Cartridges tab view of the library. Right-click on the cartridge and choose
Cartridge replication. The policy will run on the selected cartridge.

Modifying a policy
You can modify a policy to change the parameters originally defined during policy
creation.

About this task

Complete the following steps to modify a policy:

Procedure
1. Select Replication > Replication Policy > Modify policy. The Modify policy

welcome screen is displayed.
2. Click Next. The Properties window is displayed. Type a unique policy name

in the Policy name field. You cannot have the same policy name twice. If you
do define the same policy name, an error message is displayed.

3. Select the Policy enabled checkbox to run the policy within the timeframe
defined. All incoming replication events will look to apply their rules to the
policy's definition. If the Policy enabled checkbox is not selected, no
replication activities will take place.

4. Click Next, the Destinations window is displayed.
5. From the Destinations option, select the repositories on which to run the

defined policy.

Note: If a member has left the replication group, the policy destination will be
removed from the list and a warning will display that the member will be
removed from the policy.

6. Select a Priority per destination.
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Policies have 3 options of priority: High, Medium, Low. Define the policy's
Priority according to the importance and/or urgency of the data that needs to
be transferred. For example, a policy with a high priority is transferred first,
then a policy with medium priority, followed by low priority. The default is
Low for every policy.

7. Click Next. The Visibility window is displayed.
Visibility controls the location of replicated cartridges at the destination
repository. Destination replica cartridges can be "invisible" (if you choose
shelf) or "visible" (if you choose a library).
v If Visibility enabled is not activated, the destination will be shelf for all of

the repository destinations.
v If Visibility enabled is activated, you can choose a library for one of the

destination repositories. The other destination repository targets will be
shelf.
Upon ejecting a cartridge, it is first moved to the shelf on the local
repository. On the remote repository, the cartridge is moved to the
import/export slot of a library so that the backup application on the remote
site can see it.

8. Select a repository from the Repository dropdown list and the target on the
destination repository, either the shelf or a library, from the Library dropdown
list.

9. Click Next. The Ranges window is displayed. The policy objects, i.e.
cartridges, are defined as barcode ranges. There can be up to 256 ranges in a
single policy.

10. Type the From and To barcodes for a range of cartridges to be replicated.
11. Click Add to view the range in the Ranges table. If a barcode number or

barcode range appears more than once, an error message is displayed with the
conflict.

12. To delete the barcode ranges from the table, click Select all and Remove, or
click Select none to deselect.

13. Click Next and Finish to commit and save the policy on the server. The
Summary report is displayed with the policy name and the number of
barcode ranges that were defined.

Deleting a policy
Deleting a policy removes the policy in its entirety from the repository. All running
and pending activities are aborted.

Complete the following steps to delete a policy:

Select Replication > Replication Policy > Delete policy. A dialog will appear to
confirm the action and a message that all running and pending activities will be
aborted.

For more information on aborting replication activities, see “Stopping replication
activities” on page 108.

Setting the weekly replication timeframe
Scheduling a timeframe for replication to take place for all policies allows you to
maximize your system's resources and prioritize between backups and replication.
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About this task

Defining a replication timeframe gives replication the highest priority with the
maximum system resources used to complete the replication during the
“replication window”. You can define a replication timeframe using the Set
Replication Timeframe dialog. Outside of the set timeframe replication is off and
does not run.

If you choose backup as the priority, or no replication timeframe is defined,
replication runs continuously all day, but on low priority, thereby consuming
minimal resources from the system.

You can also limit the replication throughput through the Replication Rate Limits
window (see “Setting the replication rate limit” on page 105).

Note: If you define a timeframe both on the source and on the destination
repositories, you need to adjust both to the same time settings.

To set the replication timeframe:

Procedure
1. From the Systems Management view, select Replication > Set Replication

timeframe. The Set Replication timeframe dialog box is displayed.

2. Select an option:
v Prioritized backup – Replication is active, but is of low priority.
v No backup priority – Replication is off and only activated during defined

timeframe.
3. Select the Time frame direction from the dropdown list to display the time

frames scheduled for each replication task, or you can schedule a time frame
for incoming, outgoing, or bi-directional (combined) replication tasks.

4. Select the replication window in daily half-hour intervals.
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Figure 31. Set replication time frame window
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5. Click OK. The replication timeframe is set.

What to do next

Go on to “Setting the centralized time frame.”

Setting the centralized time frame
The centralized timeframe shifts the scheduling management of replication policies
from the repository scope to the grid level scope to provide improved management
of different replication windows.

About this task

The centralized time frame allows for alignment of repositories in different time
zones and provides a centralized view for managing the replication time frames for
all repositories in a replication grid. The time frames associated with specific
replication topology groups can be configured individually.

Procedure
1. To set the centralized time frame, select a repository in the Grids Management

view.
2. Right-click on the repository and select Centralized time frame, or select

Centralized time frame from the Group menu. The Centralized Time Frame
window displays with the repositories in the replication grid.

3. Select the Time frame direction from the dropdown list to display the time
frames scheduled for each replication task, or you can schedule a time frame
for incoming, outgoing, or bi-directional replication tasks.

4. Define the task precedence by selecting Replication timeframe to activate
replication within a given time frame, or select Backup precedence to keep
replication active, but with low priority. If no time frame is selected, replication
activities are blocked.

5. Select the replication window in daily half-hour intervals.
If the repository selected is in the same time zone with other repositories, the
time zone will be displayed as Local in the Time zone column. Otherwise, the
time adjustment is displayed.

6. Click Save changes and Close when finished.

Setting the replication rate limit
Setting the replication rate control allows you to limit the nominal and physical
throughput (data flow rate) of replication.

About this task

The values set for the physical and nominal limits have no explicit influence on
one another. That is, the values set in the physical throughput may, but do not
necessarily impact those values set in the nominal throughput, and vice versa.

The physical throughput limit restrains the amount of I/O and resources
replication consumes on the local repository. Implicitly, this reduces the total load
on the replication networks used by the repository (you can have 2 networks) and
the amount of resources needed on the peer repository, as well.
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The nominal throughput directly affects the load on the destination repository. On
the source repositories, the replication nominal rate does not necessarily compete
with the backup. Setting the limit on a source repository guarantees that the
backup gets the total possible throughput minus the nominal limit, but in many
cases this is not needed.

The Replication Rate Limits window displays physical and nominal throughput.
You can define one limit that applies to both incoming and outgoing replication
activity or accept the Default settings mode, Combined settings mode, or you can
define separate limits for incoming and outgoing replication activity by choosing
the Individual settings mode.

Procedure
1. From the Systems Management view, select Set replication rate limits from the

Replication menu.
2. Choose the preferred mode to define the incoming and outgoing replication

rate limits:
v Default settings

v Combined settings

v Individual settings

3. Select the checkbox next to the desired option and enter a value (in MB/Sec). If
a checkbox is not selected, the value will revert to an unlimited replication rate.

Note: When replication time frames are defined and replication is taking place
with the time frame, replication will not be limited. If the system is not within
the replication time frame, no replication will take place.

4. To return to the original replication rate limits that were defined during
installation for the physical and/or nominal throughputs, select Default system
settings as the mode. The values will default to their original settings at setup.
Following are the default values for the combined replication rate limits:

Table 26. Combined replication rate limits

Combined settings Default values (Incoming & Outgoing)

Physical throughput limits (MB/Sec) Unlimited

Limit when no backup or restore load
(MB/Sec)

Max nominal throughput (the value selected
during new repository creation)

Limit during backup or restore load
(MB/Sec)

15% of max nominal throughput

Limit within a replication timeframe
(MB/Sec)

Unlimited

Following are the default values for the individual replication rate limits:

Table 27. Individual replication rate limits

Individual settings Default values (Incoming) Default values (Outgoing)

Physical throughput limits
(MB/Sec)

Unlimited Unlimited

Nominal throughput limit
when no backup or restore
load (MB/Sec)

Max throughput Max throughput
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Table 27. Individual replication rate limits (continued)

Individual settings Default values (Incoming) Default values (Outgoing)

Nominal throughput limit
during backup or restore
load (MB/Sec)

15% of max throughput 15% of max throughput

Nominal throughput limit
within a replication
timeframe (MB/Sec)

Unlimited Unlimited

5. Click Ok to save the changes and close the window.

Limiting the network interface bandwidth
Complete the task in this topic to limit the bandwidth or throughput of a network
interface, such as a port, on a node that is running replication.

About this task

Note: This task should be performed only if it is important to limit each one of the
interfaces separately. If you want to limit the total throughput over the networks,
refer to “Setting the replication rate limit” on page 105 and set the physical
replication rate limit of the repository.

Procedure
1. From the Systems Management view, select a system that is being used for

replication from the navigation pane. The IP network configuration is
displayed.

2. Highlight one of the devices (e.g. eth3 or eth4) under Replication network
appearing in the IP Network configuration pane. The device properties are
displayed to the right.

3. Click Limit bandwidth on the bottom-right of the Device properties window.
The Limit network interface bandwidth window is displayed:
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4. Select the Limit network bandwidth checkbox to redefine the bandwidth speed
(in Mbit/Sec). The bandwidth limit value can range from 1 to 1000. Other
values will not be accepted. If the checkbox is not selected, the value will
default to an unlimited bandwidth speed.

5. Click Ok. The defined limit is displayed in the Limit (Mbit) field of the
Replication network display of the device.

Results

Note: If the bandwidth limitation is changed during replication, the change does
not take effect immediately. If replication begins after the bandwidth limitation
change, the effect is immediate.

Stopping replication activities
This topic describes how to stop cartridge replication activities on a repository.

When monitoring a repository, stop replication activities in one of the following
ways:
v Select Replication > Replication Policy > Stop replication activities

v Click Stop replication activities at the bottom of the policy name configuration
window

Stopping running activities

You can stop running activities from the Activities view in the following ways:
v Right-click on the cartridge on which you want to stop activities and choose

Stop activity.
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Figure 32. Limit network interface bandwidth window
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v Highlight all of the cartridges on which you want to stop activities and select
Replication > Replication Policy > Stop replication activities.

v Highlight all of the cartridges on which you want to stop activities and click the
Stop activity button.

This procedure cancels all the running replication activities on a cartridge without
affecting any pending activities, and not causing any backlog issues.

Stopping replication policies running and pending activities

You can stop running and pending activities of a policy from the Replication
Policies tab in either of the following ways:
v Select the policy on which to abort all replication activities and click the Abort

activities button.
v Select the policy on which to abort all replication activities and select

Replication > Replication Policy > Abort replication activities.
v Right-click on the policy and choose Delete policy.

Aborting replication activities of a policy cancels any running and pending
activities that are generated from the selected policy. This method has an
immediate effect on the running activities. However, the pending activities are
backlogged and aborted over time because the pending triggers are canceled in the
background. Although the effect is not immediate, the backlog is reduced because
the pending activities are canceled one by one in the background.

If you deleting a policy, the system deletes the entire selected policy, as well as all
running and pending activities.
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Chapter 10. Monitoring ProtecTIER Virtual Tape Libraries

The topics in this chapter describe how to use ProtecTIER Manager to monitor the
status and performance of the ProtecTIER VTL system elements. In addition,
information is provided for monitoring system functions and host activity from
within the Linux shell.

Monitoring ProtecTIER systems
This section describes how to use ProtecTIER Manager to monitor all the systems
in the ProtecTIER environment from one common view.

The All systems view displays a list of all the systems in ProtecTIER that are
configured in ProtecTIER Manager, as shown:

Any node that has been added to ProtecTIER Manager using the Add node option
appears in this view.

From the All systems view, you can log in to online systems by clicking on the
hyperlink of the System Name. When you click on the hyperlink, the system's
login window displays. Type in your username and password as you do when
selecting a specific system from the Select a system dropdown list.

If the system is offline, ProtecTIER Manager refreshes the system view, and you
can try to log in again. If the system still remains offline, a message displays that
the system cannot be detected.

Table 28. All systems view description. The All systems view is the first option appearing
in the Select a system dropdown list. From the All systems view, select the Systems tab
to monitor the following system details:

Column name Description

System Name Displays the name of the ProtecTIER system
as it appears in ProtecTIER Manager.

Figure 33. All systems view
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Table 28. All systems view description (continued). The All systems view is the first
option appearing in the Select a system dropdown list. From the All systems view, select
the Systems tab to monitor the following system details:

Column name Description

Status Displays if the system is online, offline, or
upgrading.

Health Displays an exclamation point (!) if there is a
software error, hardware error, or both.

Used (Nom) Displays the total nominal capacity used for
backup and replication.

Allocable (Nom) Displays the amount of nominal space
available for backup and replication.

Storage Saving Displays the percentage of data saved that is
derived from the deduplication ratio. The
storage savings is equal to (1-1/deduplication
ratio) x 100.

Replication Throughput Displays the physical and nominal
throughput of incoming and outgoing
replication activity.

Backup Throughput Displays the read and write throughput
during backup activity.

From the All systems view, select the Upgrading systems tab to monitor the
progress of the ProtecTIER systems undergoing a code upgrade. For more
information on upgrading ProtecTIER software, refer to the IBM TS7650 ProtecTIER
Software Upgrade Guide, V3.3.6.1, SC27-3643.

Monitoring the ProtecTIER VTL system
The topics in this section describe monitoring of the ProtecTIER VTL system.

In the Systems Management view, select a system name from the Select a system
dropdown list in the navigation pane. The System monitoring window is
displayed:
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The System window displays the general system configuration.

In addition, the ProtecTIER Manager status bar displays icons. These icons are for
the total read and write replication and backup throughput rates for the selected
system and the system time. (The status bar is at the bottom of the window.)

The status bar at the bottom of the view pane also displays the Software alerts and
Events log buttons which enable you to view alert and event information for the
nodes of the selected system. (For more information, see .)

The System window consists of the following panes:

“Capacity” displays the breakdown of the physical and nominal data capacity of
the system.

“Repository configuration” on page 114 displays the configuration settings used
to build the repository of the system.

“Total utilization” on page 115 describes the total utilization of the system.

“Replication information” on page 115 displays the replication information about
the system.

Capacity
This topic describes the breakdown of the ProtecTIER physical and nominal data
capacity.

When the physical capacity on a file system, specifically ProtecTIER user data, is
defined, a portion of the physical space is reserved for internal metadata
structures. This metadata contains information such as data block allocation
mapping and reference count (a number depicting how many objects are using, or
referencing, a specific block). For ProtecTIER, it means that the usable capacity is
lower than the physical capacity by approximately 3 percent.

The Capacity pane displays the physical and nominal data breakdown of the
repository of the selected system:
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Figure 34. VTL System monitoring screen
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Physical

v Used refers to the amount of disk space currently containing physical
data

v Fragmented refers to the amount of disk space pending the ProtecTIER
defragmentation operation

v Allocable refers to the amount of free disk space available to contain
physical data

v Total refers to the overall physical space available to the system

Nominal

v Backup refers to the amount of nominal data containing backup data
v Replication refers to the amount of nominal data used for replication
v Pending refers to the amount of nominal data pending deletion and

defragmentation activities
v Allocable refers to the amount of free disk space available to hold

nominal data
v Estimated space refers to the overall estimated nominal space supported

by the system

Note: The Estimated space value is based on the current deduplication
ratio.

Click View resources to open the Storage resources window.

The Storage resources window displays the list of metadata and user data file
systems for the repository of the selected system.

When the physical capacity on a file system, specifically ProtecTIER user data, is
defined, a portion of the physical space is reserved for internal metadata
structures. This metadata contains information such as data block allocation
mapping and reference count (a number depicting how many objects are using, or
referencing, a specific block). For ProtecTIER, it means that the usable capacity is
lower than the physical capacity by approximately 3 percent.

Note: You can open the Storage resources dialog at any time by selecting View
resources from the Repository menu.

Repository configuration
This topic describes how to monitor the configuration settings used to build the
repository on the ProtecTIER system.

The Repository configuration pane displays the following information:

Table 29. Repository information

Field Description

Configured size (in TiB) The physical repository size, in tebibytes,
that was specified when the repository was
created.

Configured factoring ratio The estimated HyperFactor factoring ratio
that was specified when the repository was
created.
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Table 29. Repository information (continued)

Field Description

Configured peak throughput (in MB/Sec) The expected maximum peak throughput
that was specified when the repository was
created.

Minimum nominal space reserved for
backup (in TiB)

The minimum amount of nominal space that
is currently reserved for backup on the
repository.

Configured license capacity (in TiB) The physical capacity of the repository, in
tebibytes, that is specified by the user
license. (The unit is shown in TiB as a
decimal format, which means it is a multiple
of 1024.)

Total utilization
This topic describes how to monitor the total utilization on a ProtecTIER system.

The Total utilization pane displays the following information in both graphical
and numerical format:

Table 30. Total utilization information

Field Definition

Used space The amount of disk space currently containing physical data.

Nominal data
size

The amount of nominal data used for backup and replication.

Deduplication
ratio

The ratio of the nominal data size divided by the used space.

Storage saving The percentage of the data saved derived from the deduplication ratio.
Storage savings = (1-1/deduplication ratio) x 100.

Replication information
This topic describes how to monitor the replication information about a ProtecTIER
system.

The Replication information pane displays the replication properties of the
ProtecTIERsystem:
v ProtecTIER Replication Manager information:

Field Definition

Management address The external IP address of the ProtecTIER
Replication Manager server used by
ProtecTIER Manager to connect to the
Replication Manager.

Replication address The replication IP address of the
ProtecTIER Replication Manager.

v Grid information:

Field Definition

Grid name The name of the grid to which this
repository is assigned.
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Field Definition

Grid ID The identification number of the grid to
which this repository is assigned.

v The Switch to: field enables you to toggle between the ProtecTIER Replication
Manager and the system view, or other ProtecTIER systems in the grid. A
preview pane displays the replication group to which this system belongs.

Monitoring the ProtecTIER VTL system performance statistics
This topic defines how to use ProtecTIER Manager to monitor the VTL system
performance statistics.

From the Systems Management view, select a system from the dropdown list in the
navigation pane and click Statistics. The Statistics monitoring window displays
performance graphs of the repository throughput for both backup and replication.

The Statistics monitoring window consists of the following tabs:
v “Repository statistics”
v “Backup statistics” on page 117
v “Replication statistics” on page 119

Repository statistics
This topic describes the utilization statistics of the repository.

The Repository tab of the Statistics monitoring window displays the following
performance graphs:
v “Nominal data size graph”
v “HyperFactor ratio over time graph”
v “Utilization graph” on page 117

Nominal data size graph
The Nominal data size graph displays the amounts of nominal data contained in
the repository over time.

HyperFactor ratio over time graph
The HyperFactor ratio over time graph displays the cumulative HyperFactor ratio
as it changes over time.
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Figure 35. Nominal data size graph
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Utilization graph
The Utilization graph displays the amounts of physical repository space used over
time.

Backup statistics
This topic describes the system's I/O throughput statistics.

The Backup tab of the Statistics monitoring window displays the following
graphs:
v “Backup read graph”
v “Backup Marginal HyperFactor ratio graph” on page 118
v “Backup write graph” on page 118

Backup read graph
The Backup read graph displays the throughput (in MB/Sec) and streams of data
read from the repository over time.
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Figure 36. HyperFactor ratio over time graph
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Figure 37. Utilization graph
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The view displays the data over a 24-hour period in 1-minute intervals.

Backup Marginal HyperFactor ratio graph
The Marginal HyperFactor ratio graph displays the amount of data written to the
repository, and the physical space it occupies, at each point in time. Comparing
these two values enables you to evaluate the effect of HyperFactor on the data
written.

Backup write graph
The Backup write graph displays the throughput (in MB/Sec) and streams of data
written to the repository over time.
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Figure 38. Backup read graph
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Figure 39. Marginal HyperFactor ratio graph
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The view displays the data over a 24-hour period in 1-minute intervals.

Replication statistics
This topic describes the replication throughput statistics of the system.

The Replication tab of the Statistics monitoring window displays the following
performance graphs:
v “Incoming replication graph”
v “Outgoing replication graph”
v “Backlog replication graph” on page 120

Incoming replication graph
The Incoming replication graph displays the throughput (in MB/Sec) and streams
of data replicated to the local repository from the remote repository, or repositories,
over time.

The view displays the data over a 24-hour period in 1-minute intervals.

Outgoing replication graph
The Outgoing replication graph displays the throughput (in MB/Sec) and streams
of data replicated to the destination repository, or repositories, over time.
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Figure 40. Backup write graph
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Figure 41. Incoming replication graph
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The view displays the data over a 24-hour period in 1-minute intervals.

Backlog replication graph
The Backlog replication graph displays the overall data pending replication over
time.

Monitoring activities
This topic describes how to use ProtecTIER Manager to monitor ongoing activities
(I/O and replication) of a system.

From the Systems Management view, select a system from the dropdown list.
Click Activities in the navigation pane. During replication, the list of objects
undergoing replication activity is displayed. During backup, the drivers will be
displayed. Select an object from the list to view additional activity details.
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Figure 42. Outgoing replication graph
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Figure 43. Backlog replication graph
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Note: The replication activities view is ad hoc. So, if new data is written to a
cartridge while it is being replicated, the progress of the displayed data details
appears in the replication view restarted.

Note: During backup activities, read streams may appear in the backup read
stream graphs, as well as restore activity in the Activities view.
Columns that appear with an asterisk (*) next to the column name display data
that is only relevant to outgoing replication activities.

Type the type of replication activity

Object ID
the barcode of the cartridge or the driver ID

Policy the name of the policy that contains the respective cartridge in its
definition

Throughput
the nominal throughput of replicating or backup data in MB/sec

Dedup*
displays the savings in the bandwidth for replicating this cartridge

Progress*
the progress of replicating the latest changes to their destination

Estimated time left*
the estimated amount of time remaining for the replication process to
complete
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Figure 44. Activities view window
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Overall statistics

The Overall statistics pane displays the nominal throughput of backup and restore
streams.

The Replication tab displays the nominal and physical throughput of incoming
and outgoing replication streams. The Backlog tab displays the nominal replication
backlog data per destination.

Viewing the replication data backlog by source
This topic describes how to monitor the amount of replication data backlog on a
source repository for each system in a replication group.

About this task

The Backlog by source window displays the backlog of nominal replication data
per source repository.

The backlog displayed is updated only when replication is active and at the end of
each cartridge replication. When there is no replication activity, the backlog is not
updated, even if there are changes on the source repository.

Follow the procedure below to view the backlog per source:

Procedure
1. From the Systems Management view, select Replication > Replication Disaster

Recovery > Show backlog by source. The Backlog by source window displays
the backlog of nominal replication data by source repository.

2. Click Close to exit the window.

What to do next

Go on to “Monitoring nodes.”

Monitoring nodes
These topics describe how to monitor a node with ProtecTIER Manager.

From the navigation pane, select a node. The Node monitoring screen displays.
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The Node monitoring screen consists of the following panes:
v “IP Network configuration of a node” on page 124
v “Fibre Channel port attributes of a node” on page 126

Viewing version information
ProtecTIER Manager displays machine information and code levels for the versions
of ProtecTIER and the drivers installed on the node.

To view the version and machine information of a node from ProtecTIER Manager,
select a node in the navigation pane of the Systems Management view. A hyperlink
of the Version: is displayed at the top of the view pane.

Click on the hyperlink and the Show version information window displays the
version numbers for the following information:

Table 31. Version information

Version information Description

Release version Displays the version number of the
ProtecTIER release

ProtecTIER model Displays the ProtecTIER server model type

Linux RPM version Displays the version number of the Linux
package installed on the server

DTC Emulex RPM version Displays the version number of the
ProtecTIER device driver

ProtecTIER Replication Manager version Displays the version of the ProtecTIER
Replication Manager
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Figure 45. Node selection window
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Table 31. Version information (continued)

Version information Description

Machine type model Displays the machine type and the model of
the server

Machine serial number Displays the machine’s serial number

IP Network configuration of a node
This topic describes how to monitor the IP Network configuration.

The IP Network configuration pane displays information about the network
interface card (NIC) setup of the node. Click on the devices to display the device
properties. To customize the network configuration of a node, click on the
Network configuration button at the bottom of the pane.
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Table 32. Network interface card information

Column Definition

Device The devices in the NIC:

Applications network
Displays the OST ports.

Note: Each virtual port can contain
more than one physical interface.
However, since bonding is not
currently supported in this release,
only 1 physical interface is
displayed on each virtual port.

The Slaves properties display the
attributes of the actual physical
ports included on the virtual
device.

External network
Eth0 is the customer network port
that communicates with the
ProtecTIER Manager workstation

Internal network

v Eth1 and Eth4 are the
cluster-internal network ports
used for VTL

v Eth1 is the cluster-internal
network ports used for OST 1 GB

v Eth1 is the cluster-internal
network ports used for OST 10
GB

bond0 is the virtual bond master
device to which the internal
network ports are enslaved
Note: Bond devices are defined as
part of the installation process.

Replication network

v Eth2 and Eth5 are the replication
ports used for VTL

v Eth2 and Eth13 are the
replication ports used for OST 1
GB

v Eth2 and Eth9 are the replication
ports used for OST 10 GB

IP Address IP address of the device.

Usage Indicates whether the device is used for the
cluster-internal network or to communicate
with the ProtecTIER Manager workstation
and the external network.

Master device The master device or bond device, if any, to
which the device is enslaved.

Status Indicates whether the device is functioning
properly.
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Table 32. Network interface card information (continued)

Column Definition

Speed The supported speed of data transfer across
the device in Megabits per second.

MTU Configured maximum transmission unit for
the device.

Load balance mode The load balancing method used within a
bond.

Fibre Channel port attributes of a node
The Fibre channel port attributes pane displays the following information for each
port in the node:

Table 33. Port attribute information

Column Definition

Port Port number and port mode. All ports in the
ProtecTIER system are front-end ports that
connect the node with the backup server(s).
This mode is labeled FE.

WWN Worldwide Name of the port.

Link Speed Transmission speed of the port.

Topology Fiber Channel topology of the port. The
possible values are as follows:

v Point-to-point (P2P)

v Fiber channel-arbitrated loop

v Down - meaning there is no fiber channel
connection

User setup User-assigned link speed and topology.

In addition, for each port you can click the Scan button to open the Scan Port
dialog box.

The Scan Port dialog box displays a numbered list of the Worldwide Names of the
remote ports detected by the port.

Monitoring Virtual Tape Libraries
This topic defines how to monitor VT (Virtual Tape) libraries using ProtecTIER
Manager.

From the Systems Management view, choose a system from the dropdown list.
Select library from the navigation pane to display the statistics, performance, and
configuration of the defined virtual tape libraries.

126 IBM TS7610 and TS7620 ProtecTIER Deduplication Appliance Express: ProtecTIER User's Guide for VTL Systems



The Virtual Tape Library window consists of the following panes:
v Library front-end - Displays the libraries and devices per port for each node.

For more information, see “Library front-end” on page 130.
v VT Nominal repository statistics- Displays the current repository breakdown of

nominal data.
– Backup refers to the amount of nominal data containing backup data
– Replication refers to the amount of nominal data used for replication
– Pending refers to the amount of nominal data pending deletion and

defragmentation activities
– Allocable refers to the amount of free disk space available to hold nominal

data
– Estimated space refers to the overall estimated nominal space supported by

the system

Note: The Estimated space value is based on the current deduplication ratio.
v Libraries performance - Displays the current total performance of the libraries.

For more information, see “VT overview” on page 130.
v Libraries configuration - Displays the total number of drives, slots,

import/export slots, and cartridges for all the libraries. For more information,
see “Configuration” on page 131.

Monitoring replication policies
This topic describes how to monitor replication policies of a system using
ProtecTIER Manager.

From the Systems Management view, click on Replication Policies on the
navigation pane to see the replication policies defined on the repository. The
following information is displayed for each defined policy:
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Figure 46. Virtual Tape Library view
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Policy name
The name that you defined for the policy.

Mode Cartridges are either copied or moved. (Note: In this release, “copy” is the
only mode of operation.)

Enabled
Policy can be enabled or disabled for execution, or partially enabled with
some of the destinations disabled. A policy can also be enabled or disabled
per destination.

Select a policy to see the policy's details, such as: destination repository, range of
barcodes, and current activities.

Additionally, in the policy’s details view, the priority of the policy is displayed. A
policy can be prioritized per destination, meaning that each policy destination can
have a different priority.

Policies have 3 options of priority: High, Medium, Low. The policy's Priority is
defined according to the importance and/or urgency of the data that needs to be
transferred. For example, a policy with a high priority is transferred first, then a
policy with medium priority, followed by low priority. The default is Low for
every policy.

Go on to “Monitoring the ProtecTIER VT service.”

Monitoring the ProtecTIER VT service
The topics in this section describe how to monitor the VT services with ProtecTIER
Manager.
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Figure 47. Replication Policies
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From the Systems Management view, click a library. The Library monitoring screen
displays with the General tab selected by default.

The type of monitoring information that is provided for VT services, or library,
consists of the following types of information:
v General
v Drives
v Cartridges
v Slots
v Import/Export Slots

Go on to the “Monitoring Virtual Tape service - General tab”.

Monitoring Virtual Tape service - General tab
This topic defines the general information provided by ProtecTIER Manager when
it is used for monitoring Virtual Tape (VT) services.

The Library monitoring screen displays the General tab by default. The General
tab displays information about the selected virtual library.

The General tab consists of the following panes:
v “Library front-end” on page 130
v “VT overview” on page 130
v “Configuration” on page 131
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Figure 48. General tab
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Library front-end
The Library front-end pane displays the virtual robots and tape drives assigned to
each port of each node in your ProtecTIER system. You can filter the display to
show all the devices in the library, or to display the devices per robot or tape
drive.

Table 34. Virtual robots and tape drive

Column Definition

Node The node on which the virtual device is
assigned.

Port The port within the node on which the
virtual device is assigned.

Top. The Fiber Channel topology of the port.
Possible values:

v Point-to-point (P2P)

v Fiber channel-arbitrated loop (Loop)

v Down - meaning there is no fiber channel
connection

WWN The Worldwide Name of the port.

LUN The logical unit number of the robot or tape
drive relative to the port. An icon displays if
the device is, or is not, part of a LUN
Masking group.

Serial The drive's serial number of the robot or
tape drive.

Device The type of device (robot or tape drive).

Library The name of the virtual tape library.

Throughput The current rate of data transfer across the
device.

Note: Change the device assignments for your libraries by clicking Reassign
devices. (For more information, see “Reassigning devices” on page 72.)

VT overview
The VT overview pane displays general information about the performance of the
selected library for Read and Write operations.

The following information is displayed:
v Status of each tape drive
v Rate of data transfer in Mbps
v Number of I/O operations per second
v Number of active tape drives

Each tape drive in the library is graphically represented. If the drive is currently
writing, an orange icon is displayed on the graphic. If the drive is currently
reading, a blue icon is displayed. To see the drive number, the current read/write
rate of the drive in Mbps, hover your cursor over the graphic. Hovering your
cursor over the graphic will also display the percentage of time that the tape drive
is idle during backup operations. Idleness in the tape drive is due to low backup
application data transfer rates.
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Configuration
The Configuration pane displays the configuration parameters of the selected
library.

The following information is displayed:

Table 35. Library configuration information

Field Definition

VT version Displays the version number of the
ProtecTIER virtual tape library

Compression mode Displays whether data compression is
enabled or disabled. This field can be
modified using the dropdown list.

HyperFactor mode Displays whether data factoring is enabled
or disabled. This field can be modified using
the dropdown list.

Control path failover mode Displays whether the control path failover
mode is enabled or disabled. This field can
be modified using the dropdown list.

Drives Displays the current number of drives in the
selected library.

Slots Displays the current number of slots in the
selected library.

Import/Export slots Displays the current number of
import/export slots in the selected library.

Cartridges Displays the current number of cartridges in
the selected library.

Vendor name Displays the vendor name of the emulated
virtual library type.

Product Displays the product name of the emulated
virtual library type.

Revision Displays the revision number of the
emulated virtual library type.

The current number of drives, slots, import/export slots, and cartridges in the
selected library are displayed.

Note: Change the number of devices in the library by clicking Re-assign devices
to open the Change dimensions wizard. (For more information, see “Editing
library parameters” on page 69.)

Go on to the “Monitoring Virtual Tape service - Drives tab”.

Monitoring Virtual Tape service - Drives tab
This topic defines the drives information provided by the ProtecTIER Manager
when it is used for monitoring Virtual Tape (VT) services.

The Drives tab displays detailed information about the virtual tape drives in the
selected library.
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The following information is displayed:

Table 36. Drives tab information

Column Definition

Drive No. The drive number. This number is displayed
to the right of the view pane when a specific
virtual tape drive is selected from the Drives
list.

Vendor The name of the vendor whose product the
virtual drive emulates. This information is
displayed to the right of the view pane
when a specific virtual tape drive is selected
from the Drives list.

Product The product name for the product that the
virtual drive emulates. This information is
displayed to the right of the view pane
when a specific virtual tape drive is selected
from the Drives list.

Revision The revision number for the product that the
virtual drive emulates. This information is
displayed to the right of the view pane
when a specific virtual tape drive is selected
from the Drives list.

Address The drive's address within the library

Node The node to which the drive is assigned

Port The port on the node to which the drive is
assigned
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Figure 49. Drives tab

132 IBM TS7610 and TS7620 ProtecTIER Deduplication Appliance Express: ProtecTIER User's Guide for VTL Systems



Table 36. Drives tab information (continued)

Column Definition

LUN The drive's logical unit number relative to
the port

Serial The drive's serial number

Loaded Indicates whether the drive is loaded with a
virtual cartridge. If the drive is loaded with

a virtual cartridge, 

 

is displayed.

Barcode If the drive is loaded with a cartridge, this
column displays the cartridge's barcode.

Go on to the “Cartridges tab.”

Cartridges tab
This topic defines the cartridges information provided by ProtecTIER Manager
when it is used for monitoring Virtual Tape (VT) services.

Go to the Systems Management view of ProtecTIER Manager to see detailed
information about the virtual tape cartridges in a selected library:
1. Select a library in the navigation pane.
2. Click the Cartridges tab to view detailed information about the virtual tape

cartridges in the chosen VT library. The cartridge configuration is displayed:
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Figure 50. Cartridges tab
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If the system is configured for replication, a dropdown list will appear in the
Configuration pane. You can filter the configuration properties view of the
cartridges displayed by selecting one of the following options from the
Configuration dropdown field:
v “Backup properties”
v “Origin properties” on page 135
v “Replica properties” on page 136

Backup properties
This topic illustrates the backup properties of a cartridge.

The Backup properties filter displays the general properties of the cartridge's
configuration (not related to replication).

The following general information is provided for the cartridges of the library you
have chosen:

Table 37. Cartridges backup properties

Column Definition

Barcode The cartridge's barcode.

R/W Whether the cartridge is write enabled. If
the cartridge is write enabled, a green
checkmark is displayed.

Capacity (MB) The cartridge's estimated data capacity in
megabytes. This value varies over time
depending on the HyperFactor ratio and the
number of cartridges configured in the
system.
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Figure 51. Cartridges tab - backup properties
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Table 37. Cartridges backup properties (continued)

Column Definition

Data Size (MB) The amount of nominal data, in megabytes,
currently stored on the cartridge.

Max Size (MB) The maximum amount of nominal data, in
megabytes, the cartridge can contain.

Full Indicates whether the cartridge has reached
Early Warning. If so, the cartridge is
regarded as full and a green checkmark is
displayed.

Principal The repository on which the cartridge was
created and backed up. (For more
information on "principality", see “Changing
cartridge ownership (Principality)” on page
78)

Go on to “Origin properties.”

Origin properties
This topic illustrates the origin properties of a cartridge.

The Origin properties of a cartridge are typically useful when viewed from a
source repository. The origin properties are used to understand the status of
replicating the cartridges to the destination repository. Using this view, you can
understand if cartridges are still pending replication (e.g. backlog > 0) and to what
repository the cartridge was replicated.

Note: The Origin properties view from the destination repository is useful for
situations when the destination has failed back cartridges. See “The failback policy
in DR mode” on page 147.
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The following information about the cartridges' origin is provided for the
cartridges of the library you have chosen:

Table 38. Cartridges origin properties

Column Definition

Barcode The cartridge's barcode.

Data Size (MB) The amount of nominal data, in megabytes,
currently stored on the cartridge.

Destination The name of the destination repository to
which the cartridges will be replicated.

Replicated data size The amount of nominal data that has
already been replicated.

Backlog The data on the cartridge that still needs to
be replicated.

Last sync time The most updated date and time when the
backup data on the cartridge was last
synchronized with the destination repository.

% Replicated The percentage of the cartridge that has
been replicated.

Go on to “Replica properties.”

Replica properties
This topic illustrates the replica properties of a cartridge.

The Replica properties are used to analyze cartridges that were replicated into this
repository. The replica properties are typically useful from the destination
repository. The most useful property of this view is the In-Sync column that
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Figure 52. Cartridges tab - origin properties
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displays whether or not the cartridge is synchronized with the most up-to-date
data from the source.

The following information about cartridge replication is displayed for the
cartridges of the library you have chosen:

Table 39. Cartridges replica properties

Column Definition

Barcode The cartridge's barcode.

Data Size (MB) The amount of nominal data, in megabytes,
currently stored on the cartridge.

Source The name of the source repository from
which the cartridges are being replicated.

Last sync local time The most updated date and time on the
destination repository when the backup data
on the cartridge was last synchronized with
the destination repository.

Last sync remote time The most updated date and time on the
source when the backup data on the
cartridge was last synchronized with the
destination repository.

In-Sync Shows whether or not the cartridge has been
replicated and is synchronized with the
source repository.

Go on to the “Monitoring Virtual Tape service - Slots tab” on page 138.
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Figure 53. Cartridges tab - replica properties
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Monitoring Virtual Tape service - Slots tab
This topic defines the slots information provided by the ProtecTIER Manager when
it is used for monitoring Virtual Tape (VT) services.

The Slots tab displays the following information:

Table 40. Slots tab information

Column Definition

Slot No. Indicates the slot's number in the library.

Address Indicates the slot's address number.

Barcode If the slot contains a cartridge, this column
displays the cartridge's barcode.

Capacity If the slot contains a cartridge, this column
displays the estimated cartridge capacity in
megabytes.

Data Size If the slot contains a cartridge, this column
displays, in megabytes, the amount of
nominal data currently stored on the
cartridge.

Go on to the “Monitoring Virtual Tape service - Import/Export slots tab” on page
139
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Figure 54. Slots tab
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Monitoring Virtual Tape service - Import/Export slots tab
This topic defines the import/export slot information provided by the ProtecTIER
Manager when it is used for monitoring Virtual Tape (VT) services.

TheImports/Exports tab displays detailed information about the import/export
slots in the selected library.

The Imports/Exports tab displays the following information:

Table 41. Imports/Exports tab information

Column Definition

Imp/Exp No. The number of the import/export slot.

Address The import/export slot's address number.

Barcode If the import/export slot contains a
cartridge, this column displays the
cartridge's barcode.

Capacity If the import/export slot contains a
cartridge, this column displays the estimated
cartridge's data capacity in megabytes.

Data Size If the import/export slot contains a
cartridge, this column displays, in
megabytes, the amount of nominal data
currently stored on the cartridge.

Go on to “Monitoring the shelf” on page 140.
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Figure 55. Imports/Exports tab
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Monitoring the shelf
This topic details monitoring the shelf.

The shelf is a container for cartridges that do not belong to any library. Each
repository contains only one shelf and whenever a cartridge in a library is moved
to the library's export slot, it is automatically displaced to the shelf.

The cartridges in the shelf cannot be seen by backup applications and this
facilitates the concept of being out of the library. ProtecTIER Manager displays a
view of the shelf and allows access to the cartridges in the shelf.

From the shelf, cartridges can be moved to a library's import slot, replicated to
another repository, or be deleted. Cartridges can also be automatically moved to a
library's import slot through the visibility switching process. A cartridge that is
moved to an export slot is automatically displaced to the shelf.

Barcode
the barcode of the cartridge

R/W displays if the cartridge can be modified

Principal repository
on which repository the cartridge can be modified

Data size (MB)
the nominal size (in MB) of the cartridge

The monitoring view of the shelf is similar to the monitoring views of cartridges in
a library. For more information, see “Cartridges tab” on page 133.

Monitoring the replication grid
ProtecTIER Manager is used to monitor a replication grid. It is possible to see
current grid members and their status, the relationship between the grid members
and the actual throughput of replication data between the grid members.

The ProtecTIER Replication Manager periodically updates the status of the grid
members and ProtecTIER Manager receives the status updates from the ProtecTIER
Replication Manager. The status includes whether the grid member is online, if the
grid member reports any errors related to replication, and statistics regarding
replication activity currently being run on the grid member.

The grid map feature provides a consolidated view of the entire replication grid
with the actual topology groups deployment. The map provides indications for
local backups, replication rates and allows panning and zooming capabilities.

Select a grid from the navigation pane and click on one of the repositories. The
grid member details are displayed to the right.

The Information tab displays the following:
v Capacity - physical and nominal
v Replication activities - running, pending, and backlog
v Backup activities
v Grid member replication configuration
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The details displayed are a partial view of the full repository view. For more
information, see “Monitoring the ProtecTIER VTL system performance statistics”
on page 116.

Click the Traffic tab to display the replication direction.
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Figure 56. Detailed view of a repository in a replication group

Chapter 10. Monitoring ProtecTIER Virtual Tape Libraries 141



142 IBM TS7610 and TS7620 ProtecTIER Deduplication Appliance Express: ProtecTIER User's Guide for VTL Systems



Chapter 11. Disaster recovery (DR) mode operations

The topics in this section includes tips, guidelines, and tasks for disaster recovery
(DR).

In Disaster Recovery (DR) mode, the disaster recovery site (destination)
temporarily replaces the production site when a “disaster” occurs or the
production site goes offline. The disaster recovery site acts as the production site
until the primary site comes back online or a new one is created.

If you cannot use the primary repository (if it is down or has been destroyed) and
you want to use the remote repository as your backup target, enter DR mode on
the remote repository before you start working with it as the primary site. See
“Entering Disaster Recovery (DR) mode.” Once you enter DR mode, all incoming
replication activities from the production site to the DR site are blocked. When the
primary site is rebuilt or replaced, you can return the data to the primary site and
continue backups and replication. Replicated or newly created tapes can then be
moved back to the main production site.

Working at the DR site
Complete these tasks when working with the disaster recovery site after a disaster
has occurred or when testing disaster recovery.

Begin working at the DR site by entering the DR mode. Cartridges that were
created at the production site are in "read only" mode at the DR site. To work with
the DR site as the new backup target, the backup application must have
read/write (R/W) permission on cartridges originating from the production site so
that the cartridges can be used for backup.

Cartridges at the DR site can be restored for recovery at any time. If you want to
work with the DR site as the new backup target, instead of the primary site, you
can either:
v Create new cartridges at the DR site and work with them
v Run the cartridge ownership takeover procedure to take control of the cartridges

belonging to a down repository in order to have R/W permission at the DR site
(see “Changing cartridge ownership (Principality)” on page 78.)

Entering Disaster Recovery (DR) mode
Complete this task to enter disaster recovery (DR) mode and failover to the DR
site.

Before you begin

Note: You can enter DR mode only on a repository that is defined as the
destination repository in the grid. See Chapter 9, “Native Replication Management
(for VTL),” on page 89.

About this task

Entering DR mode on the DR site destination repository "declares" that the
primary, or source site is now down. Furthermore, all incoming replication
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activities to the DR site are blocked from the selected source. To enter DR mode on
the destination repository:

Procedure
1. From the Systems Management view, click on the destination repository.
2. Select Replication > Replication Disaster Recovery > Enter DR mode.
3. Choose the repository from which you want to block incoming replication

activities.
4. Type yes to confirm that you want to enter DR mode. An automatic procedure

is executed that blocks incoming replication to the DR site from the source
selected.

Note: If replication is not blocked, the safety of the data at the DR site cannot
be guaranteed.

5. Repeat steps 2 through 4 to block incoming replication on additional
repositories.

What to do next

Once you have entered DR mode, go to “Assessing cartridge status and syncing
with the catalog.”

Assessing cartridge status and syncing with the catalog
The following section explains the process for assessing cartridge status on the DR
site and synchronizing the backup application catalog with the cartridges.

Before running a restore for disaster recovery, you must verify that the list of
associated cartridges are marked as "In-Sync" with the primary site, otherwise an
earlier full backup image must be used for recovery. The easiest way to determine
the time of the last full backup is if you have a specific time each day where your
replication backlog is zero (i.e. there is no pending data to replicate and backups
are not running). If this is not the case, you can assess the cartridges by recovering
the backup application catalog and scanning it to find the last full backup where
its associated cartridges completed replication.

Recovering the backup application catalog

There are several ways to obtain a copy of the catalog at the remote site:
v From a catalog backup on a virtual cartridge that will be replicated to the

remote site
v From disk-based replication, or by other means

If the catalog is backed up to a virtual cartridge, check on the DR site that this
cartridge appears as In-Sync with the primary site. If the cartridge is not In-Sync,
you will need to compare the cartridge's last sync time with the time of the last
full backup.

To recover the backup application catalog from a backup on a virtual cartridge,
you must work with the replicated cartridges on the hub to get an updated copy
of the catalog back to the remote site. From the Systems Management window,
select the Replica properties view on the Cartridges tab and use the following
guidelines for each cartridge before running the procedure for recovering the
catalog:
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Note: The procedure for recovering the selected catalog backup depends on the
backup application and is documented in the backup application official
documentation.
v If the cartridge has been replicated, either a red `X` or a green checkmark will

appear in the In-Sync column. If the In-Sync property has a green checkmark,
then nothing further needs to be verified and this cartridge is valid for recovery.

v If the cartridge is not marked In-Sync, refer to the Last sync time column. This
column displays the last time each cartridge's data was fully replicated to the
DR site. The cartridge marked with the most recent Last sync time date should
be used to recover the backup application catalog.

Note: The sync time is updated during replication, and not only when
replication for this cartridge is finished.

Recovering the data

Once recovered, scan the backup application catalog and search for the full backup
image you want to recover:
v Get the start and end backup time of the full backup image.
v View the list of cartridges associated with this full backup.

Use the Cartridge Query Tool (see “Using the cartridge query tool (for VTL)” on
page 164), or the PTCLI inventory filter command to filter the cartridges according
to the following properties (see Table 19 on page 50 for more information on
running the command):
v In-Sync
v Last update time
v Last sync time

All the cartridges marked as In-Sync are valid for recovery. For those cartridges not
marked as In-Sync, compare between the last update time, which represents the
last time the replica was updated, and the last sync point destination time.

If the last update time is less than or equal to the last sync point destination time,
the replica cartridge has consistent point in time. Otherwise, the cartridge is
incomplete, or in-transit. If the cartridge has consistent point in time, ensure this
time stamp is larger than the full backup image end time. This will indicate that
the cartridge contains all the required data for this recovery operation. Otherwise,
you will have to use a previous full backup image for recovery.

You may have a case where the cartridge sync point is after the backup start time,
but before the end of the backup. This may happen in cases where replication is
working in parallel to the backup. If the backup has many cartridges, the first
cartridges may finish replicating before the backup ends and they get a sync point
earlier than the backup end time.

As such, if the last sync time flag on one (or more) of the cartridges indicates a
time later than the backup start time, but earlier than the backup complete time,
those cartridges need further inspection. Scan the backup application catalog for
each of those cartridges and get the backup start time and the backup complete
time. If the last sync time flag on all the cartridges indicates a time later than the
backup complete time, your backup image was fully replicated.
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Remember: When processing the cartridge list to find a complete set of DR tapes,
you must keep track of the date/time discrepancies. Compare the date/time values
of the source master backup server and the source ProtecTIER system. The
destination environment may be in a different time zone or may be set to the
incorrect date/time and as such, is unreliable. Thus, use the source date/time,
rather than the destination sync time when comparing cartridge states to the
backup catalog/database. The destination sync time should only be used to
determine which cartridges are whole.

In addition, there could be a time difference between the source backup server and
the source ProtecTIER server. Your Administrator should be aware of the
discrepancy, measure it regularly and communicate the delta to the DR
Administrator or operator(s). For instance, if the backup server is 2 hours behind, a
cartridge may have a sync time that precedes its backup complete time, i.e. it will
appear as a previous, old backup.

If there is uncertainty regarding the time differences, compare the nominal size of
the cartridge to the Catalog/DB value as an additional (not a substitute) layer of
verification.

Go on to “Reestablishing the production site in DR mode.”

Reestablishing the production site in DR mode
Complete these tasks to reestablish and update the production site.

In order for the production site to come back online, or for a new site to be
established to replace the original production site, these actions are required to
reestablish and update the site with the most recent and up-to-date data.

Follow these procedures for reestablishing and updating the production site:
v Replacing the destroyed repository with a new one
v Creating a failback policy when DR mode is set

Replacing a destroyed VTL repository
Complete this task to initiate a VTL repository takeover that will replace the
destroyed repository at the production site with a new repository.

Before you begin

Note: Be careful when replacing a repository that you do not accidentally replace a
good repository.

If the repository at the production site (source) has been destroyed and cannot be
repaired, you can replace it with a new, or existing, repository that isn't part of
another replication group. The replacing repository must be part of the replication
grid.

About this task

Follow the steps below in the order in which they appear:

Procedure
1. Enter DR mode as described in “Entering Disaster Recovery (DR) mode” on

page 143
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2. From the Grids Management view, select Grid > VTL Repository takeover to
run the VTL Repository takeover wizard.

3. Select the Unrecoverable repository from the dropdown list.
4. From the Replacing repository dropdown list, select the repository with which

you want to replace the unrecoverable repository (the repository should appear
in the dropdown list).

Note: This operation is not reversible.
5. Click Ok to begin.

Results

When you run the Repository takeover wizard, the ProtecTIER Replication
Manager will internally do the following actions:
v Remove the unrecoverable repository from its group and its grid.
v Rebuild the group with the replacing repository at the new primary site.

If the replacing repository is a new repository, then no cartridge ownership is
changed. Otherwise, the "principality" is changed to the replacing repository.

Note: If cartridges remain on other repositories within the group with the
principality of the destroyed repository, the Repository takeover wizard must be
run on the additional repositories.

What to do next

Go on to “The failback policy in DR mode” section for more information on
failback policies and how to create them.

The failback policy in DR mode
This topic explains the failback policy and how to create one.

Failback is the procedure for replicating back new or old updated cartridges from a
DR site to their original restored production site (in order to bring it up-to-date in
case it was down), or to a new production site.

If the primary repository was down and has been restored, you can return to
working with the primary site as the production site and use the DR site as the
secondary site. In order to replicate back new or old updated cartridges from the
DR site, create a failback policy.

Note: The cartridges that originally came from the primary site do not need to be
replicated because they were not changed at the DR site, unless they were deleted
or destroyed at the primary site.

Note: The failback policy, in addition to copying the cartridges, also takes care of
transferring the principality, or ownership, of all the cartridges from the temporary
primary repository at the DR site to the restored primary repository at the
production site.

Go on to “Creating a failback policy.”

Creating a failback policy
Complete this task to create a failback policy.
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Before you begin

Important: Only cartridges on the shelf are valid for failback.

Procedure
1. Select Replication > Replication Disaster recovery > Fail back. The Fail back

wizard welcome screen is displayed.
2. Click Next. The Properties screen is displayed. Type a unique name for the

failback policy in the Policy name field.
3. Select a spoke repository on which to create the failback policy.
4. Click Next. The Barcode ranges screen is displayed.
5. Enter the barcode range of the cartridges that you want to fail back to the old

or replaced primary repository.
6. Click Add to validate and submit the defined barcode range. If the barcode

range is invalid, an error message is displayed.
7. Click Next. The Validation Results window displays the validation results of

the cartridges in range, the cartridges valid for failback, and those that are
invalid for failback.

What to do next

Click the Save report as... button if you want to save the validation summary
report. Click Next to view the validation summary report and exit the Failback
wizard.

Go on to “Completing failback and leaving DR mode.”

Completing failback and leaving DR mode
Complete this task to create the failback policy and leave disaster recovery (DR)
mode.

Before you begin

Once the primary site is rebuilt or replaced, create the failback policy and wait for
it to complete. When the data is returned to the primary site, you can exit DR
mode and continue with backups and replication as usual.

The failback policy is a one-time policy. When failback is complete, the policy still
remains in the Replication policies list. Running and/or modifying this policy is
not allowed, and on trying to do so, an error message is displayed.

Note: Do not run any backup activities on the restored repository until the failback
operation is complete.

About this task

When the failback operation is complete, follow the steps below to exit DR mode:

Procedure
1. Select Replication > Replication Disaster Recovery > Leave DR mode. The

Leave DR mode window is displayed.
2. From the dropdown menu, select the repository from which you want to exit

DR mode.
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3. Click Ok. Once the repository is out of DR mode, any replication policy
defined on the spoke repository can modify the cartridge data.

What to do next

You can now begin working again with the restored repository.
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Part 3. Performance optimization, reporting and
troubleshooting

This part contains information about performance optimization, creating and
generating reports, and troubleshooting procedures using ProtecTIER Manager.
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Chapter 12. Optimization

The topics in this section describe how to optimize the performance of the
ProtecTIER system using ProtecTIER Manager.

Changing the CRC setting
This topic explains how to change the CRC calculation algorithm for optimized
backup and replication activities.

The Change CRC calculation window allows you to change the CRC calculation
algorithm to a different algorithm that consumes less CPU resources and can help
improve the performance of backup, restore, and replication activities.

CRC is also used in replication communication, regardless of the kind of CRC used
for backups, or replication.

Note: It is recommended that all repositories within a replication group have
ProtecTIER version 3.1.8, or higher. If the version level of a member in the
replication group does not support the fast 32-bit CRC calculation, replication will
fail.

Typically, changing the CRC calculation is a onetime event. Once the calculation is
changed from the default value, you are not expected to change the calculation
back to the default setting. When new data is written to the repository, the latest
CRC algorithm selected is used.

"Old" data remains with the CRC calculation that was selected at the time of
backup. Even if the "old" data is replicated, the CRC calculation that was selected
at the time of backup remains the same and is transferred togetherwith the
replicated data.

Note: Changing the CRC calculation does not affect deduplication in any way.

You can change the CRC calculation algorithm from the Systems Management
view in ProtecTIER Manager. To access the CRC calculation window, select
System > Optimization > CRC calculation.

Select a CRC calculation option from the dropdown list:
v Software 64-bit CRC
v Hardware/Software fast 32-bit CRC

Click Ok to save and exit the window.
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Chapter 13. Reporting

The topics in this section describe how to create and generate various reports from
the ProtecTIER system using ProtecTIER Manager.

Simple Network Management Protocol (SNMP), when it is configured on a
ProtecTIER system, can be used to send a problem notification in the event of
hardware or software degradation or failure to designated recipients.

Use the Cartridge Query tool to filter cartridges in a repository for use in
generating service and statistics reports, or to select a range of cartridges for
various ProtecTIER tasks.

Using SNMP traps
About this task

If a hardware or software degradation or failure ocurs, ProtecTIER systems, which
are configured to use Simple Network Management Protocol (SNMP) can send a
problem notification to designated recipients. SNMP notifications, or traps, can be
sent even if the ProtecTIER Manager interface is unavailable.

To use SNMP traps, you need the following items:
v SNMP trap receiver software that is installed on an SNMP trap server. Follow

the instructions from the manufacturer to install and configure the SNMP trap
receiver software.

v The file name and location of the management information base (MIB) file for
the SNMP trap receiver. On the ProtecTIER server, the file name is:
IBM-TS7600-SNMP-MIBV2.mib in: /usr/share/snmp/mibs. The full path is:
/usr/share/snmp/mibs/IBM-TS7600-SNMP-MIBV2.mib.

v The IBM-TS7600-SNMP-MIBV2.mib file needs to be copied onto the SNMP trap
receiver and the trap receiver software must point to the directory location of the
MIB file for translation of the trap messaging.

v SNMP trapping enabled on one or more of your ProtecTIER servers. Use the
ProtecTIER Manager Configuration wizard to enable the SNMP trap option on
3959 SM1 servers. See the IBM TS7620 ProtecTIER Deduplication Appliance Express
Installation and Setup Guide for VTL, and OpenStorage Systems, v3.3, GA32-0914 for
instructions on SNMP configuration. For 3958 AP1 or 3958 DD4 servers, see the
IBM ProtecTIER User's Guide for Enterprise Edition and Appliance Edition, V3.3.6.1,
GA32-0922.

The ProtecTIER servers have the following improvements in SNMP support.
v ProtecTIER software events that send specific notifications that are based on the

error that occurred.
v ProtecTIER hardware events that trigger specific notifications are based on the

error that occurred, such as a processor event or power event.
v Send enough detailed information with the SNMP notification so that you can

understand the problem. The ProtecTIER Manager Configuration menu gives
you the option to filter SNMP traps that are based on severity.
– Error-level severities can be filtered by:

- Error
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- Warning
- Information
- Software error categories include the following:
v VTL
v Replication
v OpenStorage
v FSI
v Repository storage
v Cluster
v System

- Hardware error categories include the following:
v Processor memory module
v Cooling module (fan)
v Internal boot drives
v Ethernet cards
v Power supplies
v RAID card
v RAID battery
v Front-end adapter, if VTL enabled
v General server errors
v General network errors
v Ethernet switch, if cluster enabled with SMC switch (TS7650 or TS7650G

only)
v Network power switch, if cluster enabled with new network power

switch (TS7650 or TS7650G only)
v 3958 AP1 specific
v Back-end adapter (TS7650 or TS7650G only)
v Disk controller (TS7650 or TS7650G only)
v Disk expansion (TS7650 or TS7650G only)
v 3959 SM1 specific
v SAS expander
v SATA hard disk drives

– Warning-level severity includes the following:
- Replication warnings
- VTL warnings
- OpenStorage warnings
- FSI warnings
- Capacity warnings
- RAS warnings

– Information-level severity includes the following:
- VTL configuration change events
- OpenStorage configuration change events
- FSI configuration change events
- Replication events
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v SNMP in ProtecTIER version 3.1 or higher supports threshold monitoring and
allows the user to specify thresholds for the following system runtime behavior:
– Repository space issues

- Nominal capacity
- Physical capacity

– There are two threshold levels a user can set:
- Information level: a trap is sent when the repository regains free space and

rises about the information level.
- Warning level: a trap is sent when the free space in the repository falls

below the warning level
– Going below the informational threshold issues an SNMP trap only if the

warning threshold is crossed. This method is to ensure that the user is not
flooded with alerts when the normal operation crosses the low water mark
threshold frequently.

– Capacity thresholds can be set specifying % from the repository or specifying
space (GBs).

v Using an IBM-registered management information base (MIB) file.
– The MIB file is implemented in a tree structure and has a unique OID for

each message supported.
– The MIB file ships on the ProtecTIER server.

v Provide reporting to the network management application software.
v Improved communication options:

– SNMP traps are sent through the customer network (eth0) by using the UDP
protocol.

– By default, port 162 is used and up to five destinations are supported.
– Customers can optionally select a different port for SNMP traffic by using the

ProtecTIER Manager Configuration menu.

On systems that are configured to use SNMP traps, an agent monitors the
ProtecTIER server and reports fault information to a network management
application. Periodically the data is sent to the designated SNMP server in the
form of an SNMP trap report, a portion of which is shown in Figure 57 on page
158. SNMP trap reports notify you of hardware or software faults even if you do
not have access to the ProtecTIER Manager interface. The display format of the
trap report varies between different trap receiver software applications. Your trap
report might not look exactly like the following example.
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Procedure
1. Run the SNMP trap catcher program on the SNMP server.
2. Open the SNMP report and review the information.
3. Make note of the defective component's name (or type) and FRU ID.

Note: The FRU ID (part number) for both CRU and FRU components, is
expressed as a FRU ID.

4. Verify that the alert received was not caused by an easy to resolved condition,
such as a loose power cord or a defective cable.

Using the ProtecTIER Manager Configuration menu
About this task

This task describes how to use the ProtecTIER Manager Configuration menu to
enable and define the parameters for SNMP reporting.
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Figure 57. SNMP trap report
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Typically, hardware faults are reported in ProtecTIER Manager. However, certain
conditions will prevent the GUI from communicating with the server, and prevent
the reporting of fault information for the failed component. By enabling SNMP
reporting, you will have greater assurance that hardware faults do not go
undetected.

Accessing the Configuration menu
Procedure
1. If it is not already running, launch ProtecTIER Manager and log in to your

system.
2. In the ProtecTIER Manager window, select the Systems Management view.
3. Open the ProtecTIER Manager Configuration menu. From the menu bar at the

top of the ProtecTIER Manager window, click: System > Configuration.
The Configuration menu is displayed with the SNMP Traps option selected
and the Communities window open.

Note: You can complete the menu options in any order. However, for best
results and proper operation of all functions, it is recommended that you start
by configuring SNMP traps in “Configure SNMP Traps” on page 160, and then
complete the remaining tasks in the order in which they are documented.

4. Go on to “Configure SNMP Traps” on page 160.

Entering registration details
Procedure
1. In the Registration window (shown in Figure 58), enter the requested

Company and System Administration information:
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Figure 58. Registration
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i Until you have completed all of the fields in the Registration window,
the pop-up reminder displays each time you log in to ProtecTIER Manager. To
dismiss the reminder, click Ignore.

2. When you have finished entering registration information, go on to “Configure
SNMP Traps.”

Configure SNMP Traps
Procedure
1. From the Configuration menu, select the SNMP Traps option.

The SNMP Traps window opens.

Note: In order to receive and display SNMP trap reports, you must have
SNMP trap receiver software installed on the SNMP trap server. For
instructions about the installation, configuration, and use of your SNMP trap
receiver software, refer to the documentation that came with the product.
In addition, to enable the trap receiver to translate and display the SNMP trap
data, you must specify the filename and location of the management
information base (MIB) files for the SNMP trap receiver. On the TS7600
servers, the MIB filename is: IBM-TS7600-SNMP-MIBV2.mib, located in:
/usr/share/snmp/mibs. The full path is: /usr/share/snmp/mibs/IBM-TS7600-
SNMP-MIBV2.mib.

2. In the Communities pane, click Add.
The Add SNMP Trap Destination dialog box is displayed.

3. In the Host address field, enter the SNMP IP address of the host server.
This is the IP address of the destination server that collects the SNMP traps.

4. In the Community field, select one of the default community names (public
or private), from the dropdown list, or type in a custom community name.
The community name defines a device (or group of devices) that sends traps
to the SNMP trap receiver. The receiver accepts traps from the default public
and private communities, and any custom communities that were manually
added to the communities list in the trap receiver program. Traps from
unrecognized community names are ignored.

5. If the default Port value does not match the port value used by the SNMP
trap receiver for the corresponding community, enter the correct value.

6. Click Add.
You are returned to the SNMP Trap window. The new SNMP trap destination
displays in the Communities list, and a test SNMP trap is automatically sent
to the destination.

7. Repeat steps 2 through 6 to add additional SNMP trap destinations, if needed,
and click Submit.

8. Proceed as appropriate:
v If you selected public or private in step 4, go on to step 9 on page 161.
v If you entered a custom community name in step 4:

a. Add the custom community name(s) to the communities list on the trap
receiver. Refer to the documentation that came with the product for
instructions.

b. Enter the port value(s) that correspond to the ones specified in step 5.
c. Go on to step 9 on page 161.
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9. (Optional, but recommended for any communities that were added with a custom
name.) To manually send an SNMP trap, select an SNMP host server from the
Communities list, and then click Test. The system sends a test SNMP trap to
the selected SNMP server. Repeat this step to manually send test SNMP traps
to other host servers.

Note: To remove an SNMP trap destination from the Communities list, select
the destination and click Remove.

10. When you are finished adding and testing SNMP trap destinations, from the
navigation pane, select the Alert Filtering by Severity option.
The Alert Filtering by Severity window opens.
Use the options in this window to specify the severity level(s) which trigger
the generation of an SNMP trap. The filter levels are listed from most severe
(Error) to least severe (Information).

11. Select the checkbox for each severity level for which an SNMP trap report
should be generated and sent.

Note: To send SNMP traps, you must select at least one check box in the Alert
filtering by severity configuration pane. Also, note that the level(s) of
severity selected apply to all SNMP destinations in the Communities list.

12. When you have finished setting the severity levels, click Submit and from the
navigation pane, select the Physical Space Threshold Alerts option.
The Physical Space Threshold Alerts window opens with the Physical space
threshold alerts configuration options disabled.

13. Read the information provided in the Physical Space Threshold Alerts pane
to determine whether you want to set physical space threshold limits.
v If you do not want to set physical threshold limits, leave the checkbox clear

and go on to step 15 on page 162.
v If you do want to set physical threshold limits, in the Physical space

threshold alerts configuration pane, select the checkbox (as shown in
Figure 59 on page 162) then go on to step 14

Note: The physical threshold limits specified will apply to all SNMP
destinations in the Communities list.

14. Select the threshold unit type (GB or Percent) and enter the corresponding
values for the lower and upper free space threshold limits in the input fields,
as shown in Figure 59 on page 162:
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15. When you have finished setting the physical threshold limits, click Submit
and from the navigation pane, select the Nominal Space Threshold Alerts
option.
The Nominal space threshold alerts configuration window opens.

16. Read the information provided in the Nominal Space Threshold Alerts pane
to determine whether you want to set nominal threshold limits.
v If you do not want to set nominal threshold limits, leave the check box

clear and go on to 18.
v If you do want to set nominal threshold limits, in the Nominal space

threshold alerts configuration pane, select the checkbox (as shown in
Figure 60) then go on to step 17.
The nominal threshold limits specified will apply to all SNMP destinations
in the Communities list.

17. Select the threshold unit type (GB or Percent) and enter the corresponding
values for the lower and upper free space threshold limits in the input fields,
as shown in Figure 60:

18. When you have finished setting the nominal threshold limits, click Submit.
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Figure 59. Physical space threshold alerts configuration options
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Figure 60. Nominal space threshold alerts configuration
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Note: The Backlog Threshold SNMP Alerts option appears on the menu only
if a replication grid has been created on the server. If the Backlog Threshold
SNMP Alerts does not appear in the navigation pane, go on to 24 on page
164.

19. From the navigation pane, select the Backlog Threshold SNMP Alerts option.
The Backlog Threshold SNMP Alerts window opens and displays the
replication backlog threshold settings status of the remote repositories, if any
exist.

20. Read the information provided in the Backlog Threshold SNMP Alerts pane
to determine whether you want to set the replication backlog threshold limits.
v If you do not want to set replication backlog threshold limits, go on to 23.
v If you do want to set replication backlog threshold limits, go on to 21.

21. From the Replication Backlog Thresholds pane, select the remote repository
on which to set the backlog threshold and click Set Threshold. The Set
backlog threshold for repository window is displayed, as shown in Figure 61:

22. Select the checkbox to enable the threshold value input fields and enter the
corresponding values (in GB) for the upper and lower replication backlog
threshold limits.

23. When you have finished setting the replication backlog threshold limits, click
Ok to close the window and click Submit. The threshold settings values for
the selected repository display in the Replication Backlog Thresholds pane.
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Figure 61. Set backlog threshold for repository
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24. From the navigation pane, select the E-mail Alerts option. The E-mail Alerts
window opens displaying the e-mail to which the alerts will be sent.

Note: The e-mail displayed is the e-mail address that was configured during
RAS configuration.

25. The system configuration to enable and define the parameters for SNMP
reporting is now complete.

Using the cartridge query tool (for VTL)
This topic describes how to use the cartridge query tool to filter a specified set of
cartridges in a repository.

About this task

Note: To use the cartridge query tool, an up-to-date repository must be created.

Use this procedure to run a query:

Procedure
1. From the Systems Management view, select Reports > Cartridge Query tool.

A message displays when the repository inventory was last refreshed.

Note: If you are using the Cartridge Query Tool to change the principality of a
cartridge, or a set of cartridges, select VT > VT Cartridges > Principality
Cartridge Query Tool. See “Changing cartridge ownership (Principality)” on
page 78 for more information.

2. Click Yes to refresh the cartridge inventory. When the operation completes, the
following window is displayed:

164 IBM TS7610 and TS7620 ProtecTIER Deduplication Appliance Express: ProtecTIER User's Guide for VTL Systems



3. Select one of the desired predefined query types:
v Origin Cartridge Related Queries

Select the replication status from the dropdown list of the cartridges on the
repository from which they were replicated and their destination.

v Replica Cartridge Related Queries
Select the synchronized status from the dropdown list of the cartridges on
the repository to which they were replicated and the last synchronized time.

v Library General Queries
Select a range of cartridges to query by entering the barcode range (from/to).

4. Depending upon your selections, a predefined query is formulated in the
Query Procedure frame. This procedure can be copied and used to run the
query from a command-line interface using PTCLI (or you can click Run to run
the procedure). Refer to “Query” on page 54 for more information.

5. Choose one of the following options to be performed with the query results:
v Choose a file directory in which you want to create and save a .csv file with

the query results.
v Select a library from the dropdown list to where you want to move the

filtered cartridges resulting from the query.
v Select a library from the dropdown list from where you want to delete the

filtered cartridges resulting from the query.
6. Click Run. The query is generated and the resulting task is performed.

Note: If you chose to delete the cartridges of the resulting query, you will be
prompted to type data loss to confirm running the procedure.
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Figure 62. Cartridge Query Tool window
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Generating a ProtecTIER service report
Complete this task to generate a service report on your ProtecTIER system for use
by IBM Service.

About this task

A trained ProtecTIER specialist might request that you generate a service report
detailing the status of your ProtecTIER system. Service report files can be attached
to a support ticket and sent to a trained ProtecTIER specialist. Service reports can
be generated for only one node at a time. You must be logged in as an
administrator (ptadmin) to perform this function.

Procedure
1. From the Systems Management view, choose Reports > Create service report.

The Create service report window is displayed.

2. From the Selected node: dropdown list, select a node for which to generate a
service report.

3. Complete each of the input fields in the Backup application pane:
v Host operating system
v Backup application name
v Backup application version

4. In the Problem description pane, type a brief description describing the
problem.
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Figure 63. Create service report window
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5. From the Filters pane, select a report profile from the Selected profile:
dropdown list. The following profile options are available:

Profile name Description

Default Collects all system information reports and
all log files from either 4 days prior, or a
maximum of 10 file entries, whichever
comes first

Performance Troubleshoots performance-related issues

Deduplication Troubleshoots deduplication-related issues

Basic Used when a customer has an issue that
requires a quick problem determination

Monitoring Used when IBM Support requires frequent
summaries on the system's health and
behavior

Full Collects all system information reports and
all log files in their entirety

System view Collects system information required to
generate the system view html output

Coredump Collects the vmcore dumps from the system
to determine the cause of a system crash

6. Select the start and end dates to filter the report data by date range.
7. Click Ok. The Service Report file is created on the ProtecTIER server and a

standard save dialog box is displayed.
8. Click Save. The report file is saved to the selected location.

Generating a service report using the ProtecTIER Service menu
Complete this task to generate a service report on your ProtecTIER system using
the ProtecTIER Service menu.

About this task

A trained ProtecTIER specialist might request that you generate a service report
detailing the status of your ProtecTIER system. Service report files can be attached
to a support ticket and sent to a trained ProtecTIER specialist.

Procedure
1. Connect a USB keyboard and graphics-capable monitor to the server.
2. Verify that the server is running:
v If it is, go on to step 3.
v If it is not running: power it on now, wait for the boot cycle to complete,

and then go on to step 3.
3. At the localhost Login prompt, type: ptconfig and press <enter>.
4. At the Password prompt, type: ptconfig and press <enter>

The ProtecTIER System Menu displays:
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------------------------------------------------------------------------------
ProtecTIER Service Menu running on rassmx

------------------------------------------------------------------------------
1) ProtecTIER Configuration (...)
2) Manage ProtecTIER services (...)
3) Health Monitoring (...)
4) Problem Alerting (...)
5) Version Information (...)
6) Generate a service report
7) Generate a system view
8) Update ProtecTIER code

E) Exit
------------------------------------------------------------------------------
>>> Your choice?

5. Select Generate a service report. Type the corresponding number and press
<enter>. The following output is displayed:

Your choice? 6
Begin Processing Procedure

Please choose a profile:
1) Default - Collects all system information reports and all log

files from the either the last 4 days, or a maxiumum of 10 file
entries, whichever comes first

2) Performance - Used to troubleshoot performance-related issues
3) Deduplication - Used to troubleshoot deduplication-related issues
4) Basic - Used when customer has an issue that requires a quick

problem determination
5) Monitoring - Used in cases where Support provides frequent summaries

on the system’s health and behavior
6) Full - Collects all system information reports and all log files

in their entirety
7) Systemview - Collect system information required to generate the

system view html output
8) Coredump - Collects the vmcore dumps from the system
q) Quit

Choose:

6. Choose a profile from the options displayed. Type the corresponding number
and press <enter>. The following output is displayed:

Choose: 1
Please choose from what date to collect log files: (’q’ to quit)
Choose: [YYYYMMDD]

7. Enter the date range to filter the report data. Type the start date in the format
specified [YYYYMMDD] and press <enter>.

8. Type the end date in the format specified [YYYYMMDD]. The following example
output is displayed:

Choose: [YYYYMMDD] 20110401
Please choose until what date to collect log files: (’q’ to quit)
Choose: [YYYYMMDD] 20110410

9. Press <enter>. The service report is generated according to the chosen profile
and a series of prompts are then displayed.

10. Complete the prompts as they appear:
a. Please specify the customer name (less than 10 characters or digits)

Type your customer name and press <enter>.
b. What is the operating system running on the host ? Type the operating

system running on the host and press <enter>.
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c. What backup application (including version) is running on the host ?
Type the backup application and version running on the host and press
<enter>.

d. Please describe the problem briefly. Type a brief description of the
problem and press <enter>.

11. The following example output is displayed:

Please wait...
Creating report...
done

Created /pt_work/ProtecTier_customer_popeye_default_Apr_12_2011_18_37_58_Report.tar.gz

End Processing Procedure with return code=1
+------------------------------------------------------------------------------+
| ProtecTIER Service Menu running on popeye |
+------------------------------------------------------------------------------+
| 1) ProtecTIER Configuration (...) |
| 2) Manage ProtecTIER services (...) |
| 3) Health Monitoring (...) |
| 4) Problem Alerting (...) |
| 5) Version Information (...) |
| 6) Generate a service report |
| 7) Generate a system view |
| 8) Update ProtecTIER code |
| |
| E) Exit |
+------------------------------------------------------------------------------+
Your choice?

The service report is now complete. You can repeat this procedure for
additional nodes, or type e to exit the menu.The service report is now
complete. Type e to exit the menu.

What to do next

When you have finished, contact a trained ProtecTIER specialist.

Creating a long-term statistics report
This task describes how to generate a long-term statistics report using ProtecTIER
Manager.

About this task

Create a long-term statistics report for the nodes in your system when you want to
analyze your system statistics.

Procedure
1. From the Systems Management view, choose Reports > Create long term

statistics report. The Create long term statistics report window is displayed.
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2. From the Node selection pane, select a node from the Selected node:
dropdown list, or select All for all of the nodes in the system.

3. From the Profile selection pane, select a statistics profile from the Selected
profile: dropdown list. The following options are available:

Profile name Description

All (for support) Collects all of the statistical data from the
system. The report can be sent as a file to
IBM Service for analysis.

ProtecTIER VTL Statistics Report Displays statistics data for monitoring
purposes.

The following table displays the information included in the ProtecTIER
Statistics report. Each record measures the data from the timestamp of the
previous record to the timestamp of the current record.

Contents of the ProtecTIER VTL Statistics Report:

Column Description

processId The ID number of the process.

pollId The time according to the Unix timestamp
conversion.

Timestamp The readable date and time of the sampling.

SamplingTimeSeconds The duration, in seconds, between samples.

nSamplesPerPoll The number of samples used for each poll.

Physical Size of Repository (bytes) The physical size of the repository.

Nominal Data Size (bytes) The amount of nominal data on the
repository.

Used Physical Space (bytes) The amount of space on the repository
currently containing physical data.
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Figure 64. Create long term statistics report window
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Contents of the ProtecTIER VTL Statistics Report:

Column Description

Allocable Space (bytes) The amount of free physical space on the
repository that is available for new
allocations.

Non-Allocable Space (bytes) The amount of fragmented space on the
repository that has to be defragmented to be
available for new allocations.

Average Write Throughput (bytes/sec) The average throughput of nominal data
written to this node, in bytes/second.

Average Number of Writing Streams The average amount of write streams on this
node.

Average Read Throughput (bytes/sec) The average throughput of nominal data
read from this node, in bytes/second.

Average Number of Reading Streams The average amount of read streams on this
node.

Nominal Deleted Size (bytes) The amount of nominal data deleted from
the repository during the last poll.

Average Delete Throughput (bytes/sec) The average throughput of nominal data
that has been deleted.

Average Delete Backlog Per Node (bytes) The average amount of nominal data
backlog per node, in bytes, that still needs to
be deleted from the repository.

Factoring Ratio The ratio of the total amount of nominal
data size over the used physical space.

Number of Defraggers tasks Finished The number of defraggers tasks that have
completed during this poll.

Defraggers Defragmented Size Bytes (cluster
wide)

The amount of space freed up after
defragmentation operations.

Nominal Incoming Throughput Average
(KB/sec)

The average amount of incoming nominal
throughput from the different sources
replicating to this node.

Physical Incoming Throughput Average
(KB/sec)

The average amount of incoming physical
throughput from the different sources
replicating to this node.

Nominal Outgoing Throughput Average
(KB/sec)

The average amount of outgoing nominal
throughput sent from this node to the
destination(s).

Physical Outgoing Throughput Average
(KB/sec)

The average amount of outgoing physical
throughput sent from this node to the
destination(s).

Total Replication Backlog Average (bytes) The average of the total amount of nominal
data in the queue pending replication.

Replication Backlog Average Dest RID 0-3
(bytes)

The average of the total amount of nominal
data in the queue pending replication per
destination repository ID.

4. From the Dates range pane, select the start and end dates to filter the report
data by date range.

5. Click OK. The long term statistics report file is created on the ProtecTIER
server and a standard save dialog box is displayed.
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6. Click Yes to download the report and save the file on the ProtecTIER Manager
workstation.

Creating a system activities statistics report
This task describes how to generate a statistics report of the system activities in
frequent and short-term intervals..

About this task

Create a system activities statistics report for each node in your system when you
want to analyze your short-term system activities.

Procedure
1. From the Systems Management view, choose Reports > Create system activites

statistics report. The Create system activities statistics report window is
displayed.

2. From the Node selection pane, select a node from the Selected node: list.
3. Click OK. The system activities statistics report file is created on the ProtecTIER

server and a standard save window is displayed.
4. Click Yes to download the report and save the .csv file on the ProtecTIER

Manager workstation.
5. Click Ok to complete the procedure.

The following table displays the information included in the System Activities
Statistics report. Each record measures the data from the timestamp of the
previous record to the timestamp of the current record.

Contents of the System Activities Statistics Report:

Column Description

poll-id The time according to the UNIX timestamp
conversion.

friendly-poll-id The readable date and time of the sampling.

timestamp The time according to the UNIX timestamp
conversion.

Deletion throughput (bytes/sec) The rate at which data is deleted.

Defragmented throughput (bytes/sec) The rate at which data is defragmented.

FSI write throughput (bytes/sec) The average throughput of nominal data
that is written to the repository, in bytes.

Writing streams The average number of writing streams on
the system.

FSI read throughput (bytes/sec) The average throughput of nominal data
that is read from the repository, in bytes.

Reading streams The average number of reading streams on
the system.

Physical in-replication throughput
(bytes/sec)

The average throughput of incoming
physical data from the different sources that
replicate to this node.

Nominal in-replication throughput
(bytes/sec)

The average throughput of incoming
nominal data from the different sources that
replicate to this node.
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Contents of the System Activities Statistics Report:

Column Description

In-replication activities The average number of replication streams
in to the system.

Physical out-replication throughput
(bytes/sec)

The average throughput of outgoing
physical data that is sent from this node to
the destination(s).

Nominal out-replication throughput
(bytes/sec)

The average throughput of outgoing
nominal data that is sent from this node to
the destination(s).

Out-replication activities The average number of replication streams
out of the system.

Viewing machine reported product data (MRPD)
This topic explains how to view machine reported product data, or MRPD.

MRPD is the sub process that provides the capability of a system to report its own
current hardware and software configuration information and vital product data,
and make it available to those IBM processes and applications that need timely
and accurate machine configuration information. Product data is gathered by a
machine and sent to a destination, such as an IBM support server.

You can display machine product data using ProtecTIER Manager:
1. From the Systems Management view, choose Reports > View product data

(MRPD). The View product data (MRPD) window is displayed:
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Figure 65. View product data (MRPD) window
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2. Analyze the data to determine the required action. When you are finished, click
Ok to close the window.

Monitoring ProtecTIER backup and deduplication activities
This topic describes how to collect and analyze ProtecTIER backup and
deduplication data using CLI tools.

About this task

Use the analyze_sessions utility, under the /opt/dtc/app/utils/ directory, to
monitor the data statistics for the backup and deduplication sessions of your
ProtecTIER system.

Procedure
1. Change to the /opt/dtc/app/utils/ directory.
2. Type ./analyze_sessions at the command prompt.

Usage options Explanation

-n Number of previous months back to scan.

-sd The <source directory> option is for
working on compressor (.csv) files in
locations other than the compressor
miscellaneous directory (or, the default
directory).

-io (I/O throttle in MB/s) This tool runs on
the machine, so that the available
resources from the machine are not
depleted. The default value is 5MB/s.

-daily Adds a section with a line for each day.

-hourly Add a section with a line for each hour.

-d If the session is idle for more than <x>
(1-20 minutes) amount of time, a new
session is started.

-s (Start date) Date format is
YYYY-MM-DD-HH-MM, e.g.
2006-09-30-05-23. The processed times are
startTime <= time <= endTime.

-e (End date) Date format is
YYYY-MM-DD-HH-MM, e.g.
2006-09-30-05-23. The processed times are
startTime <= time <= endTime

-i <cart_list_file> is the file name (full path)
of the file that contains a list of cartridges
names. The file report format contains
each cartridge name on a separate line.
The file format must be a Unix text file
(and not Windows).
Note: Make sure there are no empty lines
at the end of the cartridge list. If an empty
line exists at the end of the cartridge list,
the data will not filter.
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Usage options Explanation

-c This option is only relevant with the -i
option. Creates a file with the name of the
cartridge file + __.csv that contains the
rows from the original compressor .csv
files, related to the cartridges in the list.
The .csv file is saved in the /pt_work
directory.

-o <output file name> The output data is
dumped into this file, instead of the
default file (<machine name> + <time> in
the /pt_work directory)

-min Minimal output displays "all" with the
grand totals and headers. The daily and
hourly flags are overridden.

-l This option is only relevant with the -i
option. Adds a section to the regular
report file with a line of the totals for each
cartridge in the list (limited to 4K
cartridges). If there are more than 4K
cartridges with the -l option, an error
message will be displayed and the utility
will exit.

Nosessionfilter Includes all sessions, even the small ones,
in the sessions list. For example, if you
have a session that is smaller than 1MB, it
is included in the output. (The minimum
file size with the session filter is 1MB.)

3. An output file containing statistics for the recent sessions is generated at the
following location: /ptwork/<server name>-<date>-<time>.csv during the
respective time period.

Results

The following is an example of running the analyze_sessions utility with the -l
and -i server options to display a list of the cartridge names and their totals in the
report:

[root@ny utils]# ./analyze_sessions -d 5 -s 2012-12-01-00-00 -e 2012-12-31-01-00
-l -i /pt_work/cart_list

analyze_sessions: this program analyzes the logs on the current
ProtecTIER server. Its output is the change rate between each
session and data that was available in the repository at the time.

This program and its output contain proprietary information of
International Business Machines Corporation.

(c) Copyright International Business Machines Corporation 113. All rights reserved.

startDate date: 2012-12-1 00:00:00
endDate date: 2012-12-31 01:00:59

Read 167MB, throughput: 5.21MB/s
Output file is /pt_work/ny-2013-01-03-16-27-09.csv
[root@ny utils]#

The .csv file looks similar to the following:
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Analysis of factoring
results from ny

03/01/2013
16:27

This output was generated by analyze_sessions and contains proprietary information of International Business
Machines Corporation.

(c) Copyright International Business Machines Corporation 2013. All rights reserved.

SAMBA
Release
7.133.94

There are 6
temporary
fixes:

81022100.25

81023626.5

81023644.2

81023656.1

81023661.5

81023713.1

Name Total data
(TB)

Total data
(GB)

System
change rate

Factoring
ratio

compressed
Bytes
Count (GB)

start time end time

Grand totals

all 0.146472 149.988 35.13% 2.84659 31.2975 23/12/2012
12:31

30/12/2012
04:05

carts total

B00000 0.0360501 36.9153 35.84% 2.79007 7.85946 23/12/2012
12:32

30/12/2012
04:01

B00001 0.0367187 37.6 34.50% 2.8982 7.70792 23/12/2012
12:31

30/12/2012
03:49

B00002 0.0366516 37.5312 36.33% 2.75257 8.09903 23/12/2012
12:33

30/12/2012
04:05

B00003 0.0370518 37.9411 33.87% 2.95244 7.63114 23/12/2012
12:33

30/12/2012
04:05

By session
(summary)

2012-12-23
12:31:32 to
2012-12-23
13:04:19

0.0490185 50.195 100% 1 29.8033 23/12/2012
12:31

23/12/2012
13:04
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Analysis of factoring
results from ny

03/01/2013
16:27

2012-12-27
12:16:30 to
2012-12-27
12:24:06

0.0247249 25.3183 0.05% 2145.05 0.00807142 27/12/2012
12:16

27/12/2012
12:24

2012-12-27
12:39:27 to
2012-12-27
12:47:20

0.0237776 24.3483 5.52% 18.1139 0.803133 27/12/2012
12:39

27/12/2012
12:47

2012-12-30
03:45:10 to
2012-12-30
04:05:31

0.0489512 50.126 2.27% 43.9995 0.683006 30/12/2012
03:45

30/12/2012
04:05

A summary of statistical information is included by session:

Table 42. Recent backup session and deduplication statistics

Statistic Description

Total data (TB) Total amount of data backed up during the
session, in terabytes.

Total data (KB) Total amount of data backed up during the
session, in kilobytes.

System change rate Percentage of nominal data in the backup
session that was factored and recognized as
changed relative to the previous backup
session.

Factoring ratio The ratio of the total amount of nominal
data size over the used physical space.

compressedBytesCount (GB) The amount of data that was written to the
disk after factoring and compression.

Start time Start time of the backup session.

End time End time of the backup session.
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Chapter 14. Troubleshooting

The topics in this section provide tips, guidelines, and procedures for handling
error situations that might arise within the ProtecTIER system.

Errors that occur in your ProtecTIER system can be monitored using the Alerts
dialog and the Event Log dialog. All errors within the ProtecTIER system should
be reported to a trained ProtecTIER specialist. A trained ProtecTIER specialist can
guide you in determining the cause of the error and finding a solution. In addition,
the Check and recover wizard, included in ProtecTIER Manager, can find and
repair some errors.

Common troubleshooting tasks
The topics in this section describe common troubleshooting tasks you might
perform while working with a trained ProtecTIER specialist.

Miscellaneous tasks that a trained ProtecTIER specialist might ask you to perform
during the troubleshooting process are listed here.

Attention: Do not perform these tasks unless you are directed to do so by IBM
Support.
v Disabling defragmentation - Enables you to stop the defragmentation process.

For more information, see “Disabling defragmentation.”
v Disabling compression - Enables you to stop the data compression process. For

more information, see “Disabling data compression” on page 180.
v Changing the HyperFactor mode - Enables you to stop the HyperFactoring

process. For more information, see “Changing the HyperFactor mode” on page
180.

v Modifying the trace buffer - Enables you to dump or reset the trace buffer, or to
change the trace settings. For more information, see “Modifying the trace buffer”
on page 181.

v Resetting devices - Enables you to reset a robot or tape drive in a virtual library.
For more information, see “Resetting devices” on page 183.

v Unloading and moving cartridges - Enables you to manually move virtual
cartridges between slots and tape drives. For more information, see “Unloading
and moving cartridges” on page 184.

Disabling defragmentation
Complete this task to disable defragmentation.

About this task

The ProtecTIER system automatically defragments fragmented repository disk
space as a background task at a rate that does not cause the system to slow down.
Stop defragmentation to free the resources used by the defragmentation process.

Procedure
1. Choose Repository > Defragmentation control. The Defragmentation control

dialog is displayed.
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2. Select Disable defragmentation and click Ok. The Defragmentation control
pane closes and defragmentation is disabled.

Results

Note: Selecting Enable defragmentation in the Defragmentation control pane
resumes system defragmentation.

Disabling data compression
Complete this task to disable data compression.

About this task

Under normal circumstances, the ProtecTIER system compresses data. Stop
compression on a specific virtual library to free the resources usually demanded by
the compression process.

Perform the following steps to disable data compression for a specified Virtual
Tape (VT) library.

Procedure
1. Choose VT > VT Library > Set compression type. The ProtecTIER

compression mode dialog is displayed.
2. Select VT, VT Library, and finally Set compression type. The compression

mode dialog box is displayed.
3. Select Disable compression and click Ok. The ProtecTIER compression mode

dialog closes and compression is stopped.

Note: Selecting Enable compression in the ProtecTIER compression mode
dialog box resumes data compression.

Changing the HyperFactor mode
Complete this task to change the HyperFactor mode for a specified library.

About this task

By default, ProtecTIER factors all new incoming data, detecting recurring data and
storing only the data segments that have not previously been written to the
repository. You can change the default HyperFactor mode for each library.

Perform the following steps to change the HyperFactor mode on a specified VT
library.

Procedure
1. Choose VT > VT Library > Set HyperFactor mode. The ProtecTIER VT

HyperFactor mode dialog is displayed.
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2. Select one of the following options, as directed by a trained ProtecTIER
specialist:
v Hyperfactor enabled. HyperFactor operates as normal.
v HyperFactor disabled. HyperFactor stops. When you restart HyperFactor, the

HyperFactor process proceeds as normal based on the data stored from
before HyperFactor stopped.

v Baseline. HyperFactor stops factoring incoming data and uses the newly
stored non-factored data as the reference for factoring new data after
Hyperfactor is resumed.

3. Click Ok. The ProtecTIER VT HyperFactor mode dialog closes and
HyperFactor stops.

Modifying the trace buffer
The ProtecTIER system stores runtime information in a cyclic memory buffer. A
trained ProtecTIER specialist might direct you to dump the trace buffer for
analysis, set the trace recording levels, or reset the trace buffer.

Note: You can manage the trace buffer for only one node at a time.

Dumping the trace buffer
Complete this task to create a file of the trace buffer contents for a specified node
and save it to the ProtecTIER server.

About this task

Dumping the trace buffer saves a file of the trace buffer contents to the ProtecTIER
server. Attach this file to a support ticket to send to a trained ProtecTIER specialist.

Procedure
1. In the Systems Management view, select a node from the navigation pane.
2. Choose Node > Trace > Dump trace. A confirmation message box is displayed.
3. Click Yes. The trace buffer information is saved to the ProtecTIER server.

The trace buffer report is generated for the node and saved to the ProtecTIER
server.

Note: Record the file name so that you can find it when IBM Service asks you
to send it in with an attached support ticket.
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Figure 66. ProtecTIER VT HyperFactor mode dialog
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Setting the trace levels
Complete this task to change the trace levels for a specified node.

About this task

The ProtecTIER system traces and records many types of operation information at
various levels of detail. These trace levels are initially set in manufacturing.

IBM Support might direct you to reduce the level of detail traced for certain
components. This request is made so that system resources are freed up or to
increase the level of detail for system components that are suspected to be
problematic.

Perform the following steps to set the trace levels for a specified node.

Procedure
1. From the Systems Management view, select a node in the navigation pane.
2. Choose Node > Trace > Set trace levels. The Set trace levels window is

displayed.

3. Change the trace level settings, as directed by IBM Support.
4. Click Ok. The Set trace levels window closes and the new trace levels are set.

Resetting the trace buffer
About this task

Resetting the trace buffer empties the buffer.

Procedure
1. From the Systems Management view, select a node from the navigation pane.
2. Choose Node > Trace > Reset trace. A confirmation message box is displayed.

ts
7
6
1
3
8
8

Figure 67. Set trace levels window
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3. Click Yes. The trace buffer is reset for the designated node and new
information begins to be gathered for that node.

Resetting devices
If a virtual robot or tape drive is locked, reset the device to break any existing SCSI
reservations on the device.

Attention: Resetting a robot or tape drive while the backup application is
accessing the library can harm the backup operations. Do not reset a device unless
directed to do so by a trained ProtecTIER specialist.

Resetting robots
Complete this task to reset a robot.

About this task

There might be times when a virtual robot is locked and you need to reset the
robot to break any existing SCSI reservations on the robot.

Note:

1. Do not initiate this action unless directed to do so by a trained ProtecTIER
specialist.

2. Resetting a robot while the backup application is accessing the library can harm
the backuphost operations.

Perform the following steps to reset a robot:

Procedure
1. From the Systems Management view, select a library from the navigation pane.
2. Choose VT > VT Library > Reset robot. A confirmation message box is

displayed.
3. Click Yes. The robot is reset.

Resetting the virtual tape drives
Complete this task to reset a virtual tape drive.

About this task

There might be times when a virtual tape drive is locked and you need to reset the
drive to break any existing SCSI reservations on the robot.

Note:

1. Do not initiate this action unless directed to do so by a trained ProtecTIER
specialist.

2. Resetting a virtual tape drive while the backup application is accessing the
library can harm the backup operations.

Perform the following steps to reset a virtual tape drive.

Procedure
1. From the Systems Management view, select a library in the navigation pane.
2. Click the Drives tab.
3. Select a drive.
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4. Choose VT > VT Drive > Reset drive. A confirmation message box is
displayed.

5. Click Yes. The tape drive is reset.

Unloading and moving cartridges

Attention: Manual unloading and moving of cartridges is not detected by your
backup application and can result in the loss of synchronization between your
backup application and ProtecTIER. Furthermore, unloading or moving cartridges
while the backup application is using the library can harm the backup operations.
Do not unload or move a cartridge manually unless directed by a trained
ProtecTIER specialist.

Unloading cartridges
Complete this task to unload a cartridge by using ProtecTIER Manager.

About this task

You must unload a cartridge from its drive before you can move it to a slot.

Perform the following steps to disconnect (unload) a cartridge from a drive:

Procedure
1. From the Systems Management view, select a library from the navigation pane.
2. Click the Drives tab.
3. Select a drive that contains a loaded cartridge.

Note: Loaded drives are indicated with .
4. Choose VT > VT Drive > Unload drive. A confirmation message box is

displayed.
5. Click Ok. The drive is unloaded.

Note: Unloaded drives are indicated with ts
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.

Moving cartridges
Complete this task to move a cartridge after it has been disconnected (unloaded)
from a virtual tape drive.

Procedure
1. From the Systems Management view, select a library from the navigation pane.
2. Navigate to the Services pane and select a library.
3. Click the Drives tab.
4. Select a drive that contains an unloaded cartridge.

Note: When moving cartridges from a slot, select the Slot tab and select a slot
that contains a cartridge.

5. Choose VT > VT Cartridge > Move cartridge. The Move cartridge window is
displayed.
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6. In the Destination Type field, select one of the following destinations:
v Drive
v Slot
v Import / Export

7. In the Destination area, select one of the following options:
v Next Available - The cartridge is placed in the next available location of the

selected type.
v Slot/Drive No. - The cartridge is placed in the slot or drive with the number

specified in the field. The name of this field depends on your selection in the
Destination Type field.

8. Click Ok. The cartridge is moved to the specified location.

Viewing the alerts and events log windows
This topic describes how to view alerts and events in the ProtecTIER system logs
using the ProtecTIER Manager application.

About this task

If an error occurs, the Alerts button on the bottom-right of the View pane turns red
and features a blinking exclamation mark.

Click Alerts to view the list of error events in the Alerts Log dialog.
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Figure 68. Move cartridge window
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Click Events Log on the bottom-right of the View pane to view all the events
occurring in the ProtecTIER system.

The Alerts Log and Events Log dialogs only display information for one node at a
time. In addition, the Alerts Log and Events Log dialogs only display up to 200
alert events at one time. Navigate to a previous set of 200 alert events by clicking
Previous lines. Navigate to a later set of 200 alert events by clicking Next lines.

Note: View the error log directly on a ProtecTIER server by opening the
/pt_work/log/vtf_error.log file. View the alerts log by opening the
/pt_work/log/vtf_event.log file.

Wizard error messages
ProtecTIER Manager wizards feature a Message area to inform you of issues that
relate to each wizard screen.
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Figure 69. Alerts log
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Messages can be of the following types:

You cannot continue the wizard until this problem is resolved.

You can continue the wizard without resolving this issue, but it is not
recommended.

Checking and repairing errors
Before checking and recovering errors with ProtecTIER Manager, ensure that the
file systems are stable and free of errors that require fsck. Running the ProtecTIER
Manager check and recovery wizard on inconsistent file systems can impair the
consistency of the repository.

Checking for errors requiring fsck
Complete this task to check for file system consistency.

About this task

The purpose of this task is to discover all error messages that indicate the need to
run fsck. Perform the following steps to check for file system consistency errors:
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Figure 70. Message area
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Procedure
1. Open the /var/log/messages file.
2. Search for error messages of the following types:
v GFS: fsid=<cluster name>:<file system name>: fatal filesystem consistency

error
v GFS: fsid=<cluster name>:<file system name>: about to withdraw from the

cluster
v GFS: fsid=<cluster name>:<file system name>: telling LM to withdraw
v GFS: fsid=<cluster name>:<file system name>: withdrawn
v kernel: [<ffffffff887e8094>] :gfs:gfs_lm_withdraw+0xc4/0xd3
v gfs_controlId[2905]: <file system name> finish: needs recovery jjd 0 nodeid 2

status 1

Results

If you find these types of error messages, run fsck on the file systems referenced
by the error messages.

Determining the volume names of file systems
Complete this task to find the volume names for file systems.

Procedure
1. Run gfs_tool df. Summary information for all Global File Systems (GFS) in

your repository is displayed.
2. Locate the appropriate file system names and determine their mount points.

The following output file is an example of the system output when you run
gfs_tool df. The file system name is in bold and the mount point name is
italicized:
/mnt/vgfs0113-lvfs0113
SB lock proto = "lock_dlm"
SB lock table = "lurebimepegoco:gfs_0113"
SB ondisk format = 1309
SB multihost format = 1401
Block size = 4096
Journals = 3
Resource Groups = 16384
Mounted lock proto = "lock_dlm"
Mounted lock table == "lurebimepegoco:gfs_0113"
Mounted host data = "jid=0:id=14876673:first=0"
Journal number = 0
Lock module flags = 0
Local flocks = FALSE
Local caching = FALSE
Oopses OK = FALSE
Type Total Blocks Used Blocks Free Blocks use%
------------------------------------------------------------------
inodes 512 512 0 100%
metadata 5176264 4223508 952756 82%
data 2142060068 2111434535 30625533 99%

3. Open /etc/fstab and determine the corresponding logical volumes names. The
following output is an example of the fstab entry format:
/dev/mapper/<logical volume name> /<mount point> gfs defaults,noatime,nodiratime,noquota,acl 0 0"
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Running fsck online
ProtecTIER Version 3.3.7 includes the capability of running fsck online. You do not
need to take the system offline while you run fsck. The system stays operational so
that backups and restores continue while you check the consistency of the file
systems.

Before you begin

Before you run fsck, run the procedure in “Checking and repairing errors” on
page 187 to check for errors that require the use of fsck. Also, ensure that the file
system on which you intend to run fsck is unmounted.

To run the Online fsck Recovery, your system must meet the following
requirements:
v ProtecTIER must be configured as a 2-node cluster.
v Each node in the ProctecTIER cluster must be configured with at least 64 GB of

RAM.
v One of the following criteria must be true:

– Medium changer is active on the node that is up during the FSCK Recovery
process, OR

– Control Path Failover (CPF) is enabled if you use Tivoli Storage Manager as
its backup application.

If your system does not meet this criteria, use the procedure that is described in
“Running fsck” on page 190.

Procedure
1. Select one of the ProtecTIER nodes.
2. At the login: prompt, log in with the ID root and the password admin.
3. Shut down the vtfd and ptcluster services in the following order:

# service vtfd shutdown
# service ptcluster shutdown

Attention: Make sure to use the shutdown option and not the stop option. If
you use stop, the services restart automatically if a reboot occurs.

4. Start the cman and clvmd services in the following order:
# service cman start
# service clvmd start

5. For each of the problematic file systems, run the gfs_fsck –yv command in the
background with high verbosity and direct the output to a file:
# gfs_fsck -yv logical volume name > /pt_work/vgxx_fsck.out 2>&1 &

For example, the following command runs gfs_fsck on the logical volume
/dev/mapper/vg0-lv_vg0:
# gfs_fsck -yv /dev/mapper/vg0-lv_vg0 > /pt_work/vg0_fsck.out 2>&1 &

The output is saved in the file "/pt_work/vg0_fsck.out."

Note: ProtecTIER supports up to 10 parallel gfs_fsck instances.
6. When all the gfs_fsck processes are complete, remove the /etc/pt/

dont_start_vtfd and /etc/pt/dont_start_ptcluster.
# rm –f /etc/pt/dont_start_vtfd
# rm –f /etc/pt/dont_start_ptcluster
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7. Restart the node.
# reboot –nf

ProtecTIER is now up and running.
8. Send the fsck output to trained ProtecTIER specialist to determine the next

step.

Running fsck
Complete this task to run fsck to check the consistency of the file systems before
you run ProtecTIER Manager to check and repair any ProtecTIER system errors.

Before you begin

Before you run fsck, run the procedure in “Checking and repairing errors” on
page 187 to check for errors that require the use of fsck. Also, ensure that the file
system on which you intend to run fsck is unmounted.

Procedure
1. On a two-node cluster, select one of the ProtecTIER nodes. If you have a

single node system begin with step 7 on page 191.
2. At the login: prompt, log in with the ID root and the password admin.
3. Type menu on the command line and press Enter. The ProtecTIER Service main

menu appears.

------------------------------------------------------------------------------
ProtecTIER Service Menu running on rassmx

------------------------------------------------------------------------------
1) ProtecTIER Configuration (...)
2) Manage ProtecTIER services (...)
3) Health Monitoring (...)
4) Problem Alerting (...)
5) Version Information (...)
6) Generate a service report
7) Generate a system view
8) Update ProtecTIER code

E) Exit
------------------------------------------------------------------------------
>>> Your choice?

4. Select Manage ProtecTIER services (...). The Manage ProtecTIER services (...)
menu is displayed.

------------------------------------------------------------------------------
ProtecTIER Service Menu running on rassmx
Manage ProtecTIER Services (...)

------------------------------------------------------------------------------
1) Display services status
2) Start all services
3) Stop all services
4) Stop ProtecTIER services only (including GFS)
5) Stope VTFD service only (indluding GFS)
6) Poweroff This Node
7) Reboot This Node

B) Back
E) Exit

------------------------------------------------------------------------------
>>> Your choice?

5. Select Stop all services to stop the ProtecTIER services on the node.
6. Shut down the stopped node.
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7. On the active node, shut down the vtfd and ptcluster services in the
following order:
# service vtfd shutdown
# service ptcluster shutdown

Attention: Make sure to use the shutdown option and not the stop option. If
you use stop, the services restart automatically if a reboot occurs.

8. Start the cman and clvmd services in the following order:
# service cman start
# service clvmd start

9. For each of the problematic file systems, run the gfs_fsck –yv command in
the background with high verbosity and direct the output to a file:
# gfs_fsck -yv logical volume name > /pt_work/vgxx_fsck.out 2>&1 &

For example, the following command runs gfs_fsck on the logical volume
/dev/mapper/vg0-lv_vg0:
# gfs_fsck -yv /dev/mapper/vg0-lv_vg0 > /pt_work/vg0_fsck.out 2>&1 &

The output is saved in the file "/pt_work/vg0_fsck.out."

Note: ProtecTIER supports up to 10 parallel gfs_fsck instances.
10. When all the gfs_fsck processes are complete, remove the

/etc/pt/dont_start_vtfd and /etc/pt/dont_start_ptcluster so that these
services begin again when you restart the node.
# rm –f /etc/pt/dont_start_vtfd
# rm –f /etc/pt/dont_start_ptcluster

11. Restart the node.
# reboot –nf

12. Restart the inactive node.
ProtecTIER is now up and running.

13. Send the fsck output to trained ProtecTIER specialist to determine the next
step.

Checking and repairing with ProtecTIER Manager
After any problematic file systems have been repaired, scan the ProtecTIER system
for errors, and attempt to repair them, using the Check and recover wizard.

Note: The check and recovery process is time-consuming and the ProtecTIER
system goes offline for the duration of the process. IBM therefore recommends that
you use the Check and recover wizard only for severe problems.

Checking the system
Complete this task to check the system for errors.

About this task

Attention: The check and recovery process is time-consuming and is to be used
only when you suspect a severe problem. Running the ProtecTIER Manager check
and recovery wizard on top of inconsistent file systems can impair the consistency
of the repository.

Perform the following steps to use ProtecTIER Manager to check for errors:
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Procedure
1. Choose System > Check and recover. A confirmation message box is displayed.
2. Click Yes. The ProtecTIER system goes offline and scans itself. The Check and

recover dialog is displayed with the results of the scan.

Results

The Diagnostic results pane displays each element of the ProtecTIER system in one
of the following lists:
v Positive checks - no errors.
v ProtecTIER recoverable errors - has errors that the ProtecTIER system might be

able to repair.
v Support required errors - has errors that cannot be repaired by the ProtecTIER

system without the assistance of a trained ProtecTIER specialist.

In the Category subpane, filter the list contents by selecting individual categories.

Categories that contain errors of the type ProtecTIER recoverable errors feature an
empty check box.

Repairing the system
About this task

If the checking process discovers errors of the type ProtecTIER recoverable errors,
attempt to repair the errors using ProtecTIER Manager.

Attention: Make sure to allot sufficient down-time for system recovery. The
recovery process is time-consuming and the ProtecTIER system goes offline for the
duration of that process.

ts
7
6
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8
3

Figure 71. Check and recover dialog
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Procedure
1. In the Categories sub-pane, select the checkbox for each category for which you

want to repair errors. All list items of the type ProtecTIER recoverable errors
in each selected category appear in the Selected errors to recover pane and are
labeled with a red X.

2. Click Recover. ProtecTIER Manager attempts to repair the errors. Errors that
are successfully repaired are labeled with a green checkmark. Errors that cannot
be repaired remain labeled with a red X.

Note: For assistance with errors that cannot be repaired, contact a trained
ProtecTIER specialist.
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Part 4. System Recovery

This part of the guide describes system recovery procedures for the TS7610 or
TS7620 Appliance Express.

© Copyright IBM Corp. 2011, 2015 195



196 IBM TS7610 and TS7620 ProtecTIER Deduplication Appliance Express: ProtecTIER User's Guide for VTL Systems



Chapter 15. ProtecTIER system recovery procedures

The topics in this section provide instructions for recovering a ProtecTIER server.
This procedure should be used for node replacement with the same server model
in a Disaster Recovery scenario.

If you want to perform a node replacement and the server model of the new node
is different from the server being replaced, contact IBM. This replacement must be
ordered as an RPQ.

The recovery process described in these topics define the customer responsibilities
and includes the following procedures:
1. Preparing to reload a node
2. Installing the Red Hat Enterprise Linux Advanced Platform operating system

v5.6
3. Installing the ProtecTIER code v3.3
4. Recovering the TS7610 or TS7620 Appliance Express server
5. Activating ProtecTIER Replication Manager (if the Replication Manager was

originally installed on the designated server before node replacement)
6. Backing up the configuration files
7. Analyzing and restoring the replication manager

Preparing to reload a node
Complete this task to prepare to reload a node as part of the system recovery
process.

About this task

To reload a node, you must first install the Red Hat Enterprise Linux Server release
5.6. If this is a standalone server that is being recovered, proceed to “Installing Red
Hat Linux version 5.6 and ProtecTIER version 3.3.6.1.”

If the node you are recovering is still running, perform the following steps to
prepare to reload the node:

Procedure
1. If a KVM is installed in the rack unit and a connection exists to the node to be

recovered, press the <PrtSc> key and select the node from the list. -OR- If a
KVM is not installed in the rack, attach a graphics capable monitor and a USB
keyboard to the server to be reloaded.

2. Proceed to “Installing Red Hat Linux version 5.6 and ProtecTIER version
3.3.6.1.”

Installing Red Hat Linux version 5.6 and ProtecTIER version 3.3.6.1
This task is part of the recovery process. Complete this task to install Red Hat
Linux version 5.6 and ProtecTIER version 3.3.6.1 on the server that you are
reloading.
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Procedure
1. Power on the server if it is not already powered on.
2. Insert the IBM ProtecTIER Maintenance and Recovery Disk into the

DVD/CD-ROM drive on the server.

ts
7

6
1

2
8

9

IBM System Storage   ProtecTIER
Maintenance & Recovery Disk

for 3958-AP1/DDx & 3959-SM1/SM2

® ®

TS7610 / TS7620

TS7650 / TS7650G

Engineering-RHEL5.6-NoQlgLpfc-SMB-PT-7.05-x86_64-DTC.iso

3. Reboot the server by entering in the following command at the command line:
reboot.
a. To boot from the IBM ProtecTIER Maintenance and Recovery Disk , during

the start-up sequence, press the Delete key when the IBM logo screen
appears.

b. Select the CD/DVD ROM drive as the Boot Device. After the selection is
made, it will boot from the specified device.

ts
7
6
0
9
9
2

Select one time Boot Device

PXE Network
CD/DVD Rom
Floppy Disk
Hard Disk 0
Hard Disk 1
Hard Disk 2
Hard Disk 3
Hard Disk 4
USB Storage
Diagnostics

iSCSI
iSCSI Critical
Legacy Only

Embedded Hypervisor

Device Path :
VenMedia(0C588DB8-6AF4-1
1DD-A992-00197D890238, OC
)

=Move Highlight <Enter>=Select Entry Esc=Exit

4. After a few minutes, the Red Hat Linux version 5.6 splash screen opens. At
the text prompt at the bottom of the screen, there are options for install or
upgrade.
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®

RED HAT

ENTERPRISE LINUX 5

ts
7

6
1
1
1

3

Type 1 to install OR 2 to upgrade

Type 'local' to boot from the local disk

boot:

5. Type 1 to select the Install option.
6. Type yes to confirm the installation and press Enter to view the license

agreement.
7. Press Enter to read the next page, repeating until you reach the end of the

license agreement.
8. When prompted to accept the software license agreement, type yes and press

Enter to continue.
9. The installation begins. The installation takes approximately 30 minutes to

complete.
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10. The server restarts automatically at the end of the installation process.
Manually eject and remove the IBM ProtecTIER Maintenance and Recovery Disk
from the DVD drive during the restart.

Note: If you do not remove the disk during the reboot cycle, it will attempt to
boot to the Recovery DVD again, and as long as no option (1.install or
2.upgrade) is selected, it will time out and boot to the hard drives in the
server that were just reloaded.

11. At the login: prompt, log in with the ID ptconfig and the password ptconfig.
12. The slim version of the ProtecTIER Service menu is displayed.

ts
7
6
0
9
9
6

13. Type the number for the option to Install/Update ProtecTIER and press Enter.
14. The system displays the following message:

Locating the CDROM device...done

Place the ProtecTIER code disc in the DVD tray, close the tray
and press <enter>.

15. Insert the DVD that contains the appropriate file for TS7620 or TS7610. For
TS7620 use one of the following: for 6 TB use PT_MD5_TS7620_6TB_V3.3.0.0-
full.x86_64.tar, for 12 TB use PT_MD5_TS7620_12TB_V3.3.0.0-

ts
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5

Figure 72. Red Hat Linux Installation Progress Screen
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full.x86_64.tar, for 23 TB use PT_MD5_TS7620_23TB_V3.3.0.0-
full.x86_64.tar, for 35 TB use PT_MD5_TS7620_35TB_V3.3.0.0-
full.x86_64.tar. For TS7610 use PT_TS7610_Medium_V3.3.x.x.x86_64.tar.
After the DVD is loaded for whatever configuration is being reloaded into the
server CD/DVD drive press Enter. The system displays the following
message:
Mounting... done
Extracting the code package...

16. Press Enter. The system shows the following message:
Copying files...
Copied.... 100% Done
Please remove the disc from the drive, and press <enter> to continue.

Note: This process will take about 7 minutes to complete. The progress is
displayed until it reaches 100%, as shown in the example message.

17. After the operation is done, follow the instructions and remove the disk from
the CD/DVD-ROM drive.

18. Press Enter to continue. The ProtecTIER code installation begins.
19. When the ProtecTIER installation is complete. You are prompted to restart the

server. Press Enter to restart.
20. When the reboot completes, the login: prompt is shown. Verify the Microcode

version on the server by using the ProtecTIER Service menu.
a. At the login: prompt, log in with the ID ptconfig and the password

ptconfig.
b. The ProtecTIER Service menu is displayed:

------------------------------------------------------------------------------
ProtecTIER Service Menu running on rassmx

------------------------------------------------------------------------------
1) ProtecTIER Configuration (...)
2) Manage ProtecTIER services (...)
3) Health Monitoring (...)
4) Problem Alerting (...)
5) Version Information (...)
6) Generate a service report
7) Generate a system view
8) Update ProtecTIER code

E) Exit
------------------------------------------------------------------------------
>>> Your choice?

c. From the main menu, select Version information.
d. The Version information menu is displayed.

------------------------------------------------------------------------------
ProtecTIER Service Menu running on rassmx
Version Information (...)

------------------------------------------------------------------------------
1) Display version information
2) Display Machine Reported Product Data (MRPD)
3) Display Firmware Versions

B) Back
E) Exit

------------------------------------------------------------------------------
>>> Your choice?

e. Select Display version information. The ProtecTIER version is shown in
the first line of output, in the first three digits after the colon. The version
information looks similar to the following message:

Chapter 15. ProtecTIER system recovery procedures 201

|
|



PT version : 3.3.6

If the ProtecTIER version is correct, continue to the next step. If the
ProtecTIER version is incorrect, the installation has failed. Contact IBM
Support for assistance.

Results

The re-installation process for Red Hat Linux version 5.6 and ProtecTIER version
3.3.6.1 is complete. Proceed to “Recovering the configuration of a replaced server.”

Recovering the configuration of a replaced server
Complete this task to recover the configuration of a replaced server as part of the
recovery process.

Procedure
1. After the system boots up from installing the ProtecTIER package, type

ptconfig at the login as: prompt and ptconfig at the password: prompt. The
ProtecTIER Service Menu is displayed:

2. From the ProtecTIER Service Menu, select ProtecTIER Configuration (...).
Type the corresponding number and press <Enter>. The ProtecTIER
Configuration (...) menu is displayed:

------------------------------------------------------------------------------
ProtecTIER Service Menu running on rassmx

------------------------------------------------------------------------------
1) ProtecTIER Configuration (...)
2) Manage ProtecTIER services (...)
3) Health Monitoring (...)
4) Problem Alerting (...)
5) Version Information (...)
6) Generate a service report
7) Generate a system view
8) Update ProtecTIER code

E) Exit
------------------------------------------------------------------------------
>>> Your choice?
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3. Select the Recover Configuration for a replaced server option. Type the
corresponding number and press <Enter>.
The server type and application are automatically detected where Application
is OST_1G if replacing a server in an OpenStorage environment, VTL if replacing
a VTL server, or FSI_1G if replacing a server in an FSI environment.

4. On a TS7610 and TS7620 Appliance Express, the ProtecTIER configuration
command set that is entered next is dependant on the amount of cache that is
connected to the server.
Choose the model. Type the corresponding number and press <Enter>.
The following sample output is displayed:

5. Type yes to continue.

Note: When prompted to select the node to be replaced, enter the proper node
option number. Only the valid options for replacement are displayed. Meaning,
the system will identify the components installed, and make a determination of
the model you are trying to recover.

6. Type yes.
7. The procedure will prompt you to enter the option of the server you are

recovering. Enter the option number and press <Enter>.
8. Press <Enter> to continue. The replacement procedure will restore the

configuration files from the server's repository, and this will take several
minutes to complete.

9. Once the information has been provided, proceed to “Activating ProtecTIER
Replication Manager” on page 205.

------------------------------------------------------------------------------
ProtecTIER Service Menu running on rassmx
ProtecTIER Configuration (...)

------------------------------------------------------------------------------
1) Configure ProtecTIER node
2) Recover Configuration for a replaced server
3) Configure enclosure serial number for a replaced enclosure
4) Update Time, Date, Timezone & Timeserver(s)
5) Configure replication (...)
6) IP Network configuration (...)
7) Update Firmware
8) Update the System’s name
9) Validate configuration

10) Single node - code upgrade (For Support Use ONLY)

B) Back
E) Exit

------------------------------------------------------------------------------
>>> Your choice?

Your choice? 2
Begin Processing Procedure

About to execute:
Operation: replace
Model: TS76200_23TB
Application: VTL

Continue? (yes|no) yes
This will stop the VTFD service. Do you wish to continue? (yes|no)
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Activating, analyzing and restoring ProtecTIER Replication Manager
This section describes the procedure for activating, analyzing and restoring an
inactive or "lost" ProtecTIER Replication Manager server using ProtecTIER
Manager.

The ProtecTIER Replication Manager restore procedure is done grid by grid and
can be done in either of the following ways:
v Using an existing backup file:

PtReplicationManager_<hostName>_<customerName>_time_ConfigurationBackup.zip

v Using an accessible repository that was once a member of a grid.

Important: Use the most updated file determined by the newest time value.

Go on to “Activating ProtecTIER Replication Manager” on page 205.

Backing up the configuration files
The ProtecTIER Replication Manager configuration files are automatically backed
up and saved by default. However, you can choose to cancel the automatic
configuration file backups and perform the operation manually. The following task
explains how to manually back up the Replication Manager configuration files.

About this task

Backups of the configuration files from ProtecTIER Replication Manager are saved
as a .zip file.

Automatic backups can be cancelled by deselecting the Backup configuration files
checkbox found on the Backup tab under the Tools > Preferences window in the
Grids Management view.

From the Preferences window, you can also specify the number of backup files to
save (the default is 20). The backup is done by rotation on the saved files. For
instance, the backup files are named consecutively from gm_backup.0 to
gm_backup.20. When a new backup is generated, gm_backup.0 is renamed to
gm_backup.1 and the new backup is saved as gm_backup.0. This continues until the
backups reach the total number saved and the old backups are deleted.

To manually back up the configuration files:

Procedure
1. From the Grids Management view, select Replication Manager > Backup

configuration files. The Backup configuration files dialog is displayed.
2. Enter the customer name in the Customer name field for which to provide

backup information and click Ok. A message is displayed that the backup .zip
file was saved on the ProtecTIER Replication Manager server in the /tmp
directory.

3. Click Yes if you want to download the backup file to a specific directory or No
to close the window.

4. If Yes, browse to the directory in which you want to save the backup
configuration file and click Save. The file is saved to the respective directory
and the Save window closes.
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Activating ProtecTIER Replication Manager
Use this procedure to reactivate the ProtecTIER Replication Manager application on
a replaced server in your replication grid in a disaster recovery scenario. This
procedure should only be used if the Replication Manager was originally installed
on the designated server before node replacement and if there is no Replication
Manager running on any other node in the replication grid.

About this task

The Replication Manager should be activated on the server that remotely manages
the replication grid or grids within an organization. IBM recommends activating
the ProtecTIER Replication Manager on the target server at the remote (destination)
site. By doing so, the Replication Manager remains available in a disaster recovery
situation.

This task might be completed at any time during the replication configuration
process. However, creation of the replication grid and verification of the replication
configuration, cannot take place until ProtecTIER Replication Manager is up and
running on the designated server.

Procedure
1. If it is not already displayed, access the ProtecTIER System menu on the

designated ProtecTIER Replication Manager server.
2. From the main menu, select ProtecTIER Configuration (...). Type the

corresponding number and press <Enter>. The ProtecTIER Configuration
(...) menu is displayed.

------------------------------------------------------------------------------
ProtecTIER Service Menu running on rassmx
ProtecTIER Configuration (...)

------------------------------------------------------------------------------
1) Configure ProtecTIER node
2) Recover Configuration for a replaced server
3) Configure enclosure serial number for a replaced enclosure
4) Update Time, Date, Timezone & Timeserver(s)
5) Configure replication (...)
6) IP Network configuration (...)
7) Update Firmware
8) Update the System’s name
9) Validate configuration

10) Single node - code upgrade (For Support Use ONLY)

B) Back
E) Exit

------------------------------------------------------------------------------
>>> Your choice?

3. Select Configure replication (...) . Type the corresponding number and
press <Enter>. The Configure replication (...) menu is displayed.
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------------------------------------------------------------------------------
ProtecTIER Service Menu running on rassmx
ProtecTIER Configuration (...)
Configure Replication (...)

------------------------------------------------------------------------------

1) Configure/Unconfigure ProtecTIER Replication Manager on this node
2) Configure Static Routes

B) Back
E) Exit

------------------------------------------------------------------------------
>>> Your choice?

4. Select Configure/Unconfigure ProtecTIER Replication Manager on this node.
Type the corresponding number and press <Enter>.

5. When the Replication Manager is currently deactivated, do you wish to
activate it? (yes|no) prompt displays, type: yes <Enter>.
The system displays the following warning displays:
Warning: You should not activate Replication Manager on more than one
server in a grid, as doing so may cause conflicts within the grid. It is
recommended that you designate the Target server (Hub) as the
Replication Manager.

6. When the Are you sure you want to activate the ProtecTIER Replication
Manager on this node? (yes|no) prompt displays, type: yes <Enter>.
The system displays the following message:
Gathering information [ Done ]

The "activatePTReplicationManager ended successfully" message displays.
7. When the Press the ENTER key to continue... prompt displays, press

<Enter>. You are returned to the Configure replication (...) menu.
8. Type E and press <Enter> to exit.
9. After activating ProtecTIER Replication Manager, you must restore the

replication grid using the Restore grid procedure. Go on to “Restoring the
ProtecTIER Replication Manager.”

Restoring the ProtecTIER Replication Manager
The following tasks describe the different methods for restoring the processed grid
using the Restore grid procedure.

The ProtecTIER Replication Manager server automatically handles grid analysis.
Grid analysis validates and checks the integrity of the grid in relation to its grid
members. To begin restoring a grid, import a grid for analysis by selecting one of
the tabs appearing on the Restore grid window:
v File (see “The File tab”)
v IP Address (see “The IP Address tab” on page 207)

The File tab
The following task describes how to restore the Replication Manager from the File
tab.
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About this task

If you are restoring a grid from a backup .zip file, follow the steps below to
import a grid for analysis and restore:

Procedure
1. Select the Restore grid option from the Replication Manager menu. The

Restore grid dialog is displayed.
2. Select the File tab.
3. Browse to the backup filename from which you want to analyze and restore the

grid, or enter a filename in the Backup .ZIP file name field.
4. Click Read file.
5. Select a grid to analyze from the dropdown list. The grid analysis is displayed.
6. Click Restore. The current grid is restored and removed from the grid analysis

list.
7. Select the next grid for analysis from the dropdown list. Continue restoring,

grid by grid, until the entire Replication Manager is restored.

What to do next

If there are inconsistencies and ProtecTIER Replication Manager does not recognize
the repository as part of the grid, proceed with “Forcing a repository to leave a
grid” on page 208.

If the Restore grid procedure was successfully completed, proceed to “Working
with ProtecTIER Replication Manager” on page 89.

The IP Address tab
The following task describes how to restore a grid from the Replication IP address
of a repository from the IP Address tab.

About this task

If you search for a backup file and cannot find one, then you can restore a grid on
which the repository was previously a member. With a given replication IP
address, the analysis phase is done with the respective repository's grid data in
relation to the other grid members.

Follow the steps below to import a grid for analysis and restore:

Procedure
1. Select the Restore grid option from the Replication Manager menu. The

Restore grid dialog is displayed.
2. Select the IP Address tab.
3. Enter the Replication IP address of the accessible repository that was

previously a member of the grid.
4. Click Analyze grid. The grid analysis is displayed.
5. Click Restore. The current grid is restored.
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What to do next

If there are inconsistencies and ProtecTIER Replication Manager does not recognize
the repository as part of the grid, proceed with “Forcing a repository to leave a
grid.”

If the Restore grid procedure was successfully completed, proceed to “Working
with ProtecTIER Replication Manager” on page 89.

Forcing a repository to leave a grid
Complete this task to force a repository to leave a grid.

About this task

Important: Do not perform this procedure without instruction from a trained
ProtecTIER specialist.

Note: A repository can be removed from a replication grid without the
"cooperation" of the repository. However, it is preferable to remove a repository
from a grid with coordination between the two. A temporary network
disconnection between the replication manager and the repository is not enough
reason for forcing a repository from a grid.

Force a repository to leave a grid only if the repository has been destroyed and
should not be part of the grid or is inconsistent with the grid. This situation might
arise if the Replication Manager was permanently destroyed, or if the repository
was removed from the grid without coordination due to temporary network
disconnection.

For example, if the Replication Manager was installed on a Target repository which
was destroyed, the replication grid can be restored from a Source repository that
was a member of the now destroyed grid. After restore, the repository "thinks" it is
part of the grid, but the Replication Manager might not recognize the repository as
part of the grid. The repository will, therefore, be marked as inconsistent and must
be forcibly removed from the replication grid via the Grids Management view.

Procedure

From the Grids Management view, select Repository > Uncoordinated repository
removal to forcibly remove a repository from a grid.

Note:

If this procedure is being performed in a Disaster Recovery (DR) mode scenario,
the repository can be forcibly removed from the grid from the Systems
Management view. Select Replication > Uncoordinated repository removal from
grid.

For more information, see Chapter 11, “Disaster recovery (DR) mode operations,”
on page 143.

What to do next

Once the repository has been removed from the replication grid, add the new
repository to the replication grid. Go to “Adding a repository to a replication grid”
on page 92
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on page 92 and “Replacing a destroyed VTL repository ” on page 146.
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Chapter 16. Call Home

IBM recommends that you enable the Call Home feature on each of your
ProtecTIER servers. Doing so speeds-up problem determination and fault
resolution of hardware-related issues. When enabled on the TS7610 and TS7620
Appliance Express, Call Home uses a connection on your Ethernet network to
transmit hardware-specific problem reports to IBM. For detailed instructions on
enabling Call Home on your TS7610 and TS7620 Appliance Express servers, see
IBM TS7610 ProtecTIER Deduplication Appliance Express Installation and Setup Guide
for VTL, OpenStorage, and FSI Systems, v3.3, GA32-0914 or IBM TS7620 ProtecTIER
Deduplication Appliance Express Installation and Setup Guide for VTL, and OpenStorage
Systems, v3.3, GA32-0914.

When the Reliability, Availability, and Serviceability (RAS) software on the TS7610
or TS7620 servers detect an error condition on a hardware component, Call Home
sends detailed error information to IBM (home). If the error indicates a problem
with a field replaceable unit (FRU), and IBM Remote Service Representative and an
IBM Service Representative can then prepare an action plan to handle the problem
before traveling to your site.

The TS7610 and TS7620 Appliance Express provide three Call Home capabilities:
Problem Call Home, Heartbeat Call Home, and Test Call Home; described below.
RAS sends data files that may be helpful to IBM Support Center personnel for all
three types of Call Home. These data files include error logs and configuration
information, such as the Machine Reported Product Data (MRPD) log.

Test Call Home

After enabling the Call Home feature, you can send a Test Call Home to ensure
that the setup is correct and that the TS7610 and TS7620 can successfully open a
Problem Management Record (PMR) in the IBM Remote Technical Assistance
Information Network (RETAIN).

Note: The Call Home test can take up to 10 minutes to complete. While the test is
in progress, the Testing Call Home dialog box displays. When the test completes
successfully, the Call Home test succeeded dialog box displays.

Problem Call Home

When RAS detects a problem, RAS initiates a Call Home operation to create a
PMR in RETAIN. The PMR is a single page of text data that enables the Support
Center or the Service Representative to access an action plan and a list of
applicable FRU components.

Heartbeat Call Home

To ensure proper ongoing Call Home functionality, the system sends a Heartbeat
Call Home on a regularly-scheduled basis. The heartbeat interval is user-defined.
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Using the ProtecTIER Manager Configuration menu to enable IBM Call
Home

About this task

Use these procedures to enable IBM Call Home using the Configuration menu:

i
 

Typically, hardware faults are reported in ProtecTIER Manager. However,
certain conditions can keep ProtecTIER Manager from communicating with the
server, and prevent the reporting of fault information for the failed component. By
enabling SNMP traps, email alerts, and IBM Call Home, you have greater
assurance that hardware faults, including exceeded thresholds and software alerts,
do not go undetected.

Accessing the Configuration menu
Procedure
1. If it is not already running, launch ProtecTIER Manager and log in to your

TS7610 Appliance Express system. Refer to “Logging in and out of the
ProtecTIER Manager application” on page 29 for instructions, and then return
to this page and go on to step 2. To access and use the menu, you must be
logged in as ptadmin/ptadmin.

2. In the ProtecTIER Manager window, verify that the Systems Management
heading (as opposed to Grids Management) displays at the top of the left-side
navigation pane. :

i
 

If the Grids Management heading is displayed, go to the bottom of the
navigation pane and select Systems Management to switch management
modes.

3. Open the ProtecTIER Manager Configuration menu. From the menu bar at the
top of the ProtecTIER Manager window, click: System > Configuration.
The Configuration menu displays with the Registration option selected in the
navigation pane, and the Registration window open. ).

4. Continue to “Enable Call Home.”

Enable Call Home
Before you begin

i Before you enable Call Home, make sure that ports 80 and 443 in your
firewall (if one is in use) are configured to allow outgoing traffic. If ports 80 and
443 are blocked, Call Home cannot transmit hardware-specific problem reports to
IBM. This causes the test in step 3 on page 213 to return an error, and Call Home
enablement to fail.

Procedure
1. From the navigation pane, select the Call Home option.

The Call Home window opens, with the Enable Call Home check box cleared,
as shown in Figure 73 on page 213:
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i
 

If you did not enter a Country Code and Customer Number in the
Registration window, warning notifications display at the top of the Call
Home window. To remedy this situation, return to the Registration window
and enter the missing information, and then continue to step 2.

2. Read the information provided in the Call Home pane to determine whether
you want to use Call Home.
v If you do not want to use Call Home, leave the Enable Call Home check box

clear, and go on to “Starting the configuration process” on page 214.
v If you do want to use Call Home, select the Enable Call Home check box,

and then go on to step 3.
3. Click Test to verify that Call Home is configured correctly.

Note: The Call Home test can take up to 10 minutes to complete. While the test
is in progress, the Testing Call Home dialog box displays.

4. Proceed accordingly, based on the outcome of the test:
v If the Call Home Test dialog box (shown in Figure 74 on page 214) opens,

the Call Home configuration is correct.
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Figure 73. Call Home
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a. Click Ok to close the Call Home Test dialog box and return to the
ProtecTIER Manager Configuration menu window.

b. Go on to “Starting the configuration process.”
v If an error message displays, the Call Home configuration is incorrect.

a. Resolve the problem that caused the error.
b. Repeat steps 3 on page 213 and 4 on page 213:

– If the Call Home Test Succeeded dialog box (see Figure 74) opens, you
resolved the problem.
1) Click Ok to dismiss the dialog box.
2) Go on to “Starting the configuration process.”

– If you receive the same (or a different) error message, contact IBM for
assistance. Refer to “Getting information, help, and service” on page
xx, for guidelines and instructions.

Starting the configuration process
About this task

When you have finished with the menu, you can initiate the configuration process.

Procedure
1. At the bottom of the active window, click Submit.

The system configuration process begins. Configuration can take a few minutes
to complete.

i
 

During processing, you are unable to use ProtecTIER Manager to access
the system being configured. However, by selecting Run in Background, you
can access other systems while configuration is in progress.

2. The processing window closes when configuration is complete.

Enabling or disabling Call Home from the Service Menu
Use the Service Menu to enable or disable the server's ability to place a Call Home
call and alert IBM if a system problem occurs.

About this task

i If this is the first time Call Home is being enabled on the server, you must
do so using the Configuration menu. See “Using the ProtecTIER Manager
Configuration menu to enable IBM Call Home” on page 212.
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Figure 74. Call Home test succeeded
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Accessing the Service Menu
Procedure
1. If necessary, power-on the server and the monitor, and wait for the login

prompt to display.
2. At the login prompt, type: ptconfig and press <enter>.
3. At the Password prompt, type: ptconfig and press <enter>

The Service Menu displays.
4. Go to “Enabling Call Home” or “Disabling Call Home” on page 216.

Enabling Call Home
About this task

Use the procedure below to enable Call Home functionality.

Procedure
1. On the Service Menu, select Enable/Disable Call Home. Type the

corresponding number and press <enter>.
The following messages, display:
Getting Call Home state [ Done ]

Call Home successfully set.

2. When the Call Home is currently Disabled, do you wish to enable it?
(yes|no) prompt displays, type: y <enter>.
The Configuring Call Home [ Done ] message displays.

3. When the Press the ENTER key to continue... message displays, press
<enter>. You are returned to the Service Menu.

4. Select Problem Alerting.

The system Problem Alerting contains the following options:
v Enable/Disable Call Home - depending on your current Call Home state,

select this option to either enable or disable Call Home
v Send a Test Call Home
v Configure Call Home Heartbeat frequency - sets how often the Call Home

communication path is checked
v Send a Heartbeat Call Home - this option checks the Call Home

communication path
v Enable/Disable Notification by email - depending on your current

Notification by email state, select this option to either enable or disable
Notification by email

v Test Email Notification - sends a test email to verify email address
v Activate Call Home Polling Function
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------------------------------------------------------------------------------
ProtecTIER Service Menu running on rassmx
Problem Alerting (...)

------------------------------------------------------------------------------
1) Enable/Disable Call Home
2) Send a Test Call Home
3) Configure Call Home Heartbeat frequency
4) Send a Heartbeat Call Home
5) Enable/Disable Notification by email
6) Test Email Notification
7) Activate Call Home Polling Function

B) Back
E) Exit

------------------------------------------------------------------------------
>>> Your choice?

5. To exit the Problem Alerting menu, type: E <enter>.
You are then returned to the server command prompt.

Disabling Call Home
About this task

Use the procedure below to disable Call Home functionality.

Procedure
1. Access the Service Menu.
2. Select the Enable/Disable Call Home option, as described in step 1 on page

215, above.
3. When the Call Home is currently Disabled, do you wish to enable it?

(yes|no) prompt displays, type: y <enter>.
The Configuring Call Home [ Done ] message displays.

4. When the Press the ENTER key to continue... message displays, press
<enter>. You are returned to the Service Menu.
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Appendix A. Verifying your replication configuration using the
Replication Manager GUI

About this task

This procedure describes how to use the Replication Manager GUI (installed on the
ProtecTIER Manager workstation) to verify the success of the connection between
one SOURCE server and the TARGET server. You can use this method to verify the
single connection in a 1:1 configuration, or each SOURCE-to-TARGET connection
in a many-to-one (2:1, 3:1, or 4:1) configuration.

Instructions for using ProtecTIER's Replication Network Performance Validation
Utility (pt_net_perf_util) are also provided as an alternative method of verifying
your replication configuration. Use of this utility requires a higher level of
technical expertise and familiarity with Linux. Note that in the pt_net_perf_util
instructions, the term "client" is used to indicate the SOURCE (Spoke) server in
your replication configuration.

i
 

The following procedure references the SOURCE server "Alexander" and the
TARGET server "Idaho". These server names and their respective IP addresses are
provided as examples, only. Your actual server names and IP address will differ.

Procedure
1. Log into the PT Manager GUI, as described in “Logging in and out of the

ProtecTIER Manager application” on page 29, return to this page, and go on
to step 2.

2. In the left navigation pane, under the Systems Management heading, click the
Nodes tab.

3. Click the name of the SOURCE server on which you configured replication,
and then click Login.
For example, click Idaho.

The Login to system dialog box opens.
4. Login to the server:
v If the Username and Password fields are already completed, click Ok, and

go on to step 5.
v Otherwise, do the following:

a. In the Username field, type: ptadmin.
b. In the Password field, type: ptadmin.
c. Click Ok and go on to step 5.

5. If the Configuration Wizard reminder dialog box displays, click Ok to dismiss
the message and continue.

6. In the lower corner of the left-side navigation pane, click Grids Management.
The display switches to Grids Management view and the Add new
ProtecTIER Grid Manager dialog box opens. See Figure 75 on page 220.
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7. Click Add.
The Add Replication Manager dialog box opens. See Figure 76.

8. In the IP address field, enter the local area network (LAN) IP address of the
TARGET (Hub) server.
For example, the LAN IP address for the TARGET server "Alexander" is:
9.11.201.56..

9. Leave the Port field set to the default value.
10. Click Ok.

The Login dialog box opens.
11. Login to the Replication Manager:

a. In the Username field, type: gmadmin.
b. In the Password field, type: gmadmin.

12. Click Ok.
13. In the left-side navigation pane, click the TARGET (Hub) server.

For example, click Alexander.

The Login to system dialog box opens.
14. From the menu bar at the top of the window, click Repository > Add

Repository to Grid.
15. When prompted, enter the IP address of one of the SOURCE (Spoke) server's

replication ports. (Only one IP address is required.)
For example, for the SOURCE server "Idaho", enter the replication IP address:
9.11.201.57..
The Login dialog box opens.

16. Login to the server:
a. In the Username field, type: ptadmin.
b. In the Password field, type: ptadmin.
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Figure 75. Add new ProtecTIER Replication Manager
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Figure 76. Add Replication Manager
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17. In the Repositories pane, right-click the repository of the SOURCE (Spoke)
server.

18. Click Connect Spoke to Hub.
A diagram of your replication configuration displays, with arrows pointing
from the SOURCE (Spoke) server to the TARGET (Hub) server.
For example, the grid configuration diagram for the SOURCE server Idaho, and the
TARGET server Alexander, would look similar to the following:

19. Using the legend at the bottom of the window (see Figure 78, verify that the
newly added system is online and correctly identified as a Hub (TARGET) or
non-Hub (SOURCE (Spoke)).

20. In the lower-right corner of the window, check for the presence of an
exclamation point (!) on the Replication Alerts button:
v If no exclamation point exists, the replication configuation is problem-free.
v If an exclamation point is present, click the Replication Alerts button to

view problem information.
Attempt to resolve the problem using the information provided in the
Alerts window. For additional problem-resolution information, see
Chapter 14, “Troubleshooting,” on page 179.

21. Proceed as appropriate:
v If you have only one SOURCE server and the TARGET server (in a 1:1

replication configuration), you can now define your replication policies and
schedules. .

v If you have two, three, or four SOURCE servers (in a many-to-one
replication configuration):
a. Repeat the procedures in Chapter 3, “Configuring replication,” on page

21 and Appendix A, “Verifying your replication configuration using the
Replication Manager GUI,” on page 219, until you have configured and
verified all of your SOURCE-to-TARGET combinations.

b. Define your replication policies and schedules. For more information,
see “Creating a replication policy” on page 99.
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Figure 77. Replication Manager configuration grid diagram
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Figure 78. Replication Manager legend
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ProtecTIER Network Performance Validation Utility
The objective of the pt_net_perf_util is to test maximal network performance in
order to discover potential performance bottlenecks. On VTL systems, the utility
tests maximal replication performance between two future ProtecTIER VTL
repositories by emulating the network usage patterns of the ProtecTIER Native
Replication component. On OpenStorage systems, the utility tests network
performance between an OpenStorage host and a ProtecTIER server to identify
possible bottlenecks in a backup and restore scenario.

ProtecTIER Replication Network Performance Validation Utility for VTL
Systems

The objective of the VTL pt_net_perf_util utility is to test maximal replication
performance between two future ProtecTIER VTL repositories by emulating the
network usage patterns of the ProtecTIER Native Replication component. This
utility can not predict replication performance, but it can discover performance
bottlenecks.

Before you begin

The requirements of this utility are as follows:
v Red Hat Linux version 5.6 or Red Hat Linux version 5.4
v Standard external utilities expected to be in the current path: ping, netstat,

getopt, echo.

The pt_net_perf_util utility and the iperf tool are part of the ProtecTIER software
installation. To test the replication performance, use the following tool:
v iperf 2.0.4

/usr/local/bin/iperf

This utility has two modes of operation, client and server. The server has to be
started before the client. Before running the utility, shut down all other programs
on both the client and server ProtecTIER systems. The client is the ProtecTIER
system that transmits the test data and the server is the ProtecTIER system that
receives the data (also known as the target server). Based on the data sent by the
client and received by the server, the script outputs key network parameter values
which indicate certain attributes of the network. The goal of these tests is to
benchmark the throughput of the network. The most important benchmark is the
direction that replication actually takes place, that is, test the target as the server
since the flow of data will be to that server from the client. However, it is also
important to also test the reverse direction to measure the bandwidth performance
during disaster recovery failback. Network bandwidth is not always the same in
both directions.

Before you can run the utility you must configure the replication ports on both the
source and destination servers and define static routes between them in both
directions.

About this task

In the following procedure, the goal is to test network performance between two
machines on a WAN, server1 and server2. Each test runs for five minutes. Since
there are five tests, the process takes a total of 25 minutes.
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Repeat these tests for each server and for each replication port on the server (two
tests total per server, one for each replication port).

Procedure
1. At the login prompt, log in with user name ptconfig and password ptconfig.

Press Enter. On the command line, type menu and press Enter. The ProtecTIER
Service Menu is displayed.

------------------------------------------------------------------------------
ProtecTIER Service Menu running on rassmx

------------------------------------------------------------------------------
1) ProtecTIER Configuration (...)
2) Manage ProtecTIER services (...)
3) Health Monitoring (...)
4) Problem Alerting (...)
5) Version Information (...)
6) Generate a service report
7) Generate a system view
8) Update ProtecTIER code

E) Exit
------------------------------------------------------------------------------
>>> Your choice?

2. Stop the VTFD services.
a. Select the option to Manage ProtecTIER services.
b. The Manage ProtecTIER services menu is displayed.

------------------------------------------------------------------------------
ProtecTIER Service Menu running on rassmx
Manage ProtecTIER Services (...)

------------------------------------------------------------------------------
1) Display services status
2) Start all services
3) Stop all services
4) Stop ProtecTIER services only (including GFS)
5) Stope VTFD service only (indluding GFS)
6) Poweroff This Node
7) Reboot This Node

B) Back
E) Exit

------------------------------------------------------------------------------
>>> Your choice?

c. Select the option to Stop ProtecTIER services only (including GFS).

Note: You can also stop the VTFD services from the command line. From the
command line on the server, type the following command and press Enter:
service vtfd stop

3. Wait for the services to stop. A message similar to the following displays:
Shutting down vtfd: [ OK ]

Please wait ...........................................................
[root@austin ~]#

4. Start the server mode of the utility on server1 by entering the following
commands on the command line:
cd /opt/dtc/app/sbin
./pt_net_perf_util -s

5. Start the client mode of the utility on server2 by entering the following
command on the command line:
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cd /opt/dtc/app/sbin
./pt_net_perf_util -c <x.x.x.x> -t 300

Where <x.x.x.x> is the IP address of the server replication port.
6. The utility automatically performs the tests in sequence. The client output

(server2 in the example shown) looks similar to the following:

Note: In the sample output below the test ran for only 5 seconds instead of
300.
*** Latency
PING 9.5.53.33 (9.5.53.33) 56(84) bytes of data.

--- 9.5.53.33 ping statistics ---
5 packets transmitted, 5 received, 0% packet loss, time 4001ms
rtt min/avg/max/mdev = 0.257/0.406/0.484/0.079 ms

*** Throughput - Default TCP
[ 3] 0.0- 5.0 sec 56.6 MBytes 94.8 Mbits/sec

*** Throughput - 1 TCP stream(s), 1MB send buffer
[ 3] 0.0- 5.0 sec 57.0 MBytes 95.0 Mbits/sec

*** Throughput - 16 TCP stream(s), 1MB send buffer
[SUM] 0.0- 5.8 sec 65.0 MBytes 94.3 Mbits/sec

*** Throughput - 127 TCP stream(s), 1MB send buffer
[SUM] 0.0-11.3 sec 127 MBytes 94.1 Mbits/sec

Number of TCP segments sent: 230536
Number of TCP retransmissions detected: 21 (0%)

Done.

See the next section for information about interpreting the results of the tests.

Interpreting the results

The utility performs five foreground tests (Tests 1-5 below), and one background
test (Test 6 below). The example outputs shown are from the client side. Each of
the first five tests ran for 300 seconds (-t 300), while the last test monitored TCP
performance during that time.

Test 1: Latency

This test checks the nominal network link latency and packet loss. Example result:
*** Latency
PING 10.0.13.194 (10.0.13.194) 56(84) bytes of data.

--- 10.0.13.194 ping statistics ---
120 packets transmitted, 120 received, 0% packet loss, time 119060ms
rtt min/avg/max/mdev = 57.403/78.491/104.451/9.872 ms

Interpreting the results:
v The average round-trip-time (rtt) was 78.4 ms and there was 0% packet loss.
v The latency in WAN topologies can vary, but should never exceed 200 ms.

Contact your network administrator if latency reports more than 200 ms, as it
can significantly decrease replication throughput.

v Higher latency values can cause a major deterioration in replication throughput.
v Packet loss should be 0%. Any other value indicates a major network problem.
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Test 2: Throughput - default settings

This test checks maximal TCP throughput of a single data stream with default TCP
settings. Example result:

*** Throughput - Default TCP
[ 3] 0.0-120.1 sec 2.41 GBytes 173 Mbits/sec

Interpreting the results:
v The test ran for 120.1 seconds, transferred 2.41 GB (2.24 GiB), with an average

throughput of 173 Mbits/sec.

Note: 1 MByte = 1,048,576 bytes. 1 Mbit/sec = 1,000,000 bits/sec.

Test 3: Throughput - single stream, 1 MB send buffer

This test checks maximal TCP throughput of a single data stream with a 1 MB
(0.95 MiB) send buffer. Example result:

*** Throughput - 1 TCP stream(s), 1MB send buffer
[ 3] 0.0-120.0 sec 2.51 GBytes 180 Mbits/sec

Interpreting the results:
v The test ran for 120.0 seconds, transferred 2.51 GB (2.34 GiB), with an average

throughput of 180 Mbits/sec.
v There might be an improvement here on high-latency links.

Test 4: Throughput - 16 streams, 1 MB send buffer

Example result:
*** Throughput - 16 TCP stream(s), 1MB send buffer
[SUM] 0.0-121.4 sec 5.91 GBytes 418 Mbits/sec

Interpreting the results:
v The test ran for 121.4 seconds, transferred 5.91 GB (5.5 GiB), with an average

throughput of 418 Mbits/sec.
v The extra streams yielded higher utilization of the connection.
v The Mbits/sec reported in this test is the maximum replication performance

your system will achieve if your is using up to 2-3 cartridges in parallel.

Test 5: Throughput - 127 streams, 1 MB send buffer

Example result:
*** Throughput - 127 TCP stream(s), 1MB send buffer
[SUM] 0.0-126.1 sec 8.08 GBytes 550 Mbits/sec

Interpreting the results:
v The test ran for 126.1 seconds, transferred 8.08 GB (7.53 GiB), with an average

throughput of 550 Mbits/sec.
v TCP takes a while to reach its maximal throughput. Longer testing times, 300

seconds or more, produces more accurate results.
v The throughput value given by this test is the potential physical replication

throughput for this system. It is directly affected by the available bandwidth,
latency, packet loss, and retransmission rate.
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v The Mbits/sec reported in this test is the maximum replication performance
your system might achieve. If this number is lower than anticipated, contact
your network administrator.

Test 6: TCP Retransmissions versus Total TCP segments sent

Example result:
Number of TCP segments sent: 1619061
Number of TCP retransmissions detected: 201038 (12%)

Interpreting the results:
v A total of 1619061 TCP segments were sent during the five tests, out of which,

201038 were lost and retransmitted.
v The retransmission rate imposes a direct penalty on the throughput, as the

retransmission of these packets takes up bandwidth. The retransmission can be
caused by the underlying network (for example, packet dropping by an
overflowed router) or by the TCP layer itself (for example, retransmission due to
packet reordering).

v Segment loss can be caused by each of the network layers.
v TCP retransmission larger than 2% can cause performance degradation and

unstable network connectivity. Contact your network administrator to resolve
this issue and reduce it to approximately 0%.

What to do next

You might want to run these tests again to test the reverse throughput in the
network. To run the tests in reverse, change server1 to the client and server2 to the
server and repeat the procedures.
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Appendix B. Planning for replication

Use the information in this appendix to plan your replication configuration.

About this task

Here you will find overview information, guidelines, and planning tools, provided
to help you understand the basic concepts of replication and assist you in the
configuration process.

Replication overview
This section provides a basic overview of replication configuration concepts and
terminology.

Below is a list of points to keep in mind when planning for replication:
v Servers used for replication are designated as being either a SOURCE or a

TARGET.
– SOURCE servers are also referred to as Spokes.
– TARGET servers are also referred to as Hubs.

i
 

The terms SOURCE and SPOKE, and TARGET and HUB; are used
interchangeably throughout the ProtecTIER graphical user interfaces (GUIs),
command line prompts, and documentation.

v A replication configuration has only one TARGET server. All other servers in the
configuration are SOURCE servers.

v The TS7610 or TS7620 Appliance Express supports configurations consisting of
one TARGET server and up to four SOURCE servers.

v The SOURCE servers transmit an image of their data repository, file system
configuration, and other system settings; to the TARGET server.
– The SOURCE servers are used for day-to-day operations. They may be

located in a single building or complex, or distributed among multiple
“branch” offices or facilities.

– The TARGET server resides in a remote location and is not used for daily
transactions.

v All servers must be fully configured before they can be connected (via the
Replication Manager application) to establish the replication network.
– The replication network is are also referred to as a grid.

v Once the grid, is established, the rules that determine how replication is
performed can be established.
– A set of replication rules is referred to as a policy.

v Once the policy is created, you can begin using replication.

The pages that follow further explain the above concepts, and illustrate the
relationships among the SOURCE and TARGET servers. The M:1 examples and
illustrations depict the maximum SOURCE-to-TARGET configuration (4:1):
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OVERVIEW

In an OpenStorage environment, each server that is configured for replication can replicate with up to

f fthree other servers. This type o replication con iguration is called Many-to-Many. You use the

ProtecTIER Replication Manager application to connect the servers to each other and define a

replication grid. Multiple grids can be established, with a limit of four servers per grid.

MANY-TO-MANY CONFIGURATION

CHICAGO DENVER

MIAMI BOSTON

The replication servers can reside in a single building or complex, or be distributed among multiple

offices or facilities. They can exist in different parts of town, in different states, or even in different

countries. As long as the servers are able to communicate over your Ethernet replication network,

there is no restriction on proximity.

During replication, each server transmits an image of its data repository, file system configuration, and

other system settings; to one or more servers in its grid. In the event of data corruption or a hardware

failure, you can retrieve the stored image from one of the servers with which the affected server

replicates, and restore the affected server to its previous configuration with minimal risk of data loss. ts
7
6
0
8
2
0

Figure 79. M:1 replication overview
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Examples
Refer to the examples to learn what network settings information you will need to
configure your SOURCE and TARGET servers.

The example sheets that follow indicate what information is required to configure
the SOURCE (Spoke) and TARGET (Hub) servers in a M:1 configuration. The
examples also explain how to determine what you are being prompted for as you
complete the replication configuration options on the ProtecTIER Configuration
Menu, and where to find the corresponding information.
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Examples

M:1 Replication Setup

NETWORK SETTINGS

Before you can configure the SOURCE and TARGET servers for replication, you must obtain the information

shown below for each server’s Replication Ports (ETH1 and ETH2). You will use this information as you use

options on the PT Configuration Menu to configure the system for replication.

Note: The IP Address, Network Netmask, Gateway Address, and Hostname, values used below are

for example only. The actual values for your SOURCE and TARGET servers will differ.

Replication Port 1 (ETH1) Replication Port 1 (ETH1) Replication Port 1 (ETH1) Replication Port 1 (ETH1)

SOURCE

[S]

Chicago

SOURCE

[S]

Denver

SOURCE

[S]

Miami

SOURCE

[S]

Boston

(ETH1)

IP Address: 10.11.195.50 [S]

Network Netmask: 255.255.255.0 [S]

Gateway Address: 10.11.195.1 [S]

Hostname: chicago_source_1 [S]

Replication Port 2 (ETH2)

IP Address: 10.11.197.26 [S]

S

(ETH1)

10.11.190.21 [S]

255.255.255.0 [S]

10.11.190.1 [S]

denver_source_1 [S]

Replication Port 2 (ETH2)

10.11.193.62 [S]

S

(ETH1)

10.11.191.77 [S]

255.255.255.0 [S]

10.11.191.1 [S]

miami_source_1 [S]

Replication Port 2 (ETH2)

10.11.198.14 [S]

S

(ETH1)

10.11.192.34 [S]

255.255.255.0 [S]

10.11.192.1 [S]

boston_source_1 [S]

Replication Port 2 (ETH2)

10.11.199.88 [S]

SNetwork Netmask: 255.255.255.0 [S]

Gateway Address: 10.11.197.1 [S]

Hostname: chicago_source_2 [S]

255.255.255.0 [S]

10.11.193.1 [S]

denver_source_2 [S]

255.255.255.0 [S]

10.11.198.1 [S]

miami_source_2 [S]

255.255.255.0 [ ]

10.11.199.1 [S]

boston_source_2 [S]

Replication Port 1 (ETH1)

TARGET

[T]

Atlanta

IP Address: 10.11.194.36 [T]

Network Netmask: 255.255.255.0 [T]

Gateway Address: 10.11.194.1 [T]

Hostname: atlanta_target_1 [T]

Replication Port 2 (ETH2)

IP Address: 10.11.196.40 [T]

Network Netmask: 255.255.255.0 [T]

Gateway Address: 10.11.196.1 [T]

Hostname: atlanta_target_2 [T]

ts
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Figure 80. Network settings example
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M:1 Replication Setup

UPDATE REPLICATION NETWORK

Using the Update Replication Network option, you will specify the network settings for the replication ports

of your SOURCE servers by entering each server’s IP Address, Network Netmask, Gateway Address, and

Hostname in response to the option’s prompts. You will complete this option on each SOURCE server at its

respective location. You will not complete this option on the TARGET server.

The scenario below demonstrates how you would respond to the Update Replication Network prompts.

The scenario contains example network settings for one SOURCE server. You would respond to the

prompts in the same manner for each additional SOURCE server substituting each server’s unique network,

settings. Your actual responses to the prompts will differ.

Replication Port 1 (ETH1)

IP Address: 10.11.195.50 [S]

Network Netmask: 255 255 255 0 [S]

SOURCE

[S]

. . .

Gateway Address: 10.11.195.1 [S]

Hostname: chicago_source_1 [S]

Replication Port 2 (ETH2)

IP Address: 10.11.197.26 [S]

Network Netmask: 255.255.255.0 [S]

Gateway Address: 10 11 197 1 [S]

Replication Port 1, IP Address: 10.11.195.50 [S]

Replication Port 1, Netmask: 255.255.255.0 [S]

Update Replication Network prompts and example responses for the SOURCE server, above:

. . .

Hostname: chicago_source_2 [S]Chicago

Replication Port 1, Hostname: chicago_source_1 [S]

Replication Port 2, IP Address: 10.11.197.26 [S]

Replication Port 2, Netmask: 255.255.255.0 [S]

Replication Port 2, Hostname: chicago_source_2 [S]

ts
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Figure 81. Update replication network example
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M:1 Replication Setup

CONFIGURE STATIC ROUTES

Using the Configure Static Routes option, you will to specify the path that the replicated data will follow

during transmission between the SOURCE and TARGET servers. This path is called the static route.

I t t! Y t l t thi tiImpor an ou mus comple e s op on h SOURCE t it ti l ti d theac server a s respec ve loca on, an on e

TARGET server at its location.

Tip: In the Configure Static Routes prompts, the term “target” refers to the remote server’s Network

Address and Netmask (not necessarily the replication TARGET server.) Also, you will be prompted to enter

the Target Network Address, which represents the server’s starting network address. To determine the

starting network address, simply replace the digits after the last (.) in the server’s IP Address, with a zero (0).

For example: you would change the IP Address: 10.33.125.45 to: 10.33.125.0

The scenario below shows how you would respond to the Configure Static Routes prompts. The scenario

contains example network settings for one SOURCE server and the TARGET server. You would respond to

the prompts in the same manner for each additional SOURCE server, substituting each server’s unique

network settings. Your actual responses to the prompts will differ.

TARGETSOURCE

[T]

Replication Port 1 (ETH1)

IP Address: 10.11.195.50 [S]

Network Netmask: 255.255.255.0 [S]

Gateway Address: 10.11.195.1 [S]

Hostname: chicago_source_1 [S]

Replication Port 2 (ETH2)

IP Address 10 11 197 26 [S]

Replication Port 1 (ETH1)

IP Address: 10.11.194.36 [T]

Network Netmask: 255.255.255.0 [T]

Gateway Address: 10.11.194.1 [T]

Hostname: atlanta_target_1 [T]

Replication Port 2 (ETH2)

IP Address 10 11 196 40 [T]

[S]

W ki SOURCE t it l ti W ki th TARGET t it l ti

Configure Static Routes prompts and example responses for the SOURCE and TARGET servers, above:

: . . .

Network Netmask: 255.255.255.0 [S]

Gateway Address: 10.11.197.1 [S]

Hostname: chicago_source_2 [S]

: . .

Network Netmask: 255.255.255.0 [T]

Gateway Address: 10.11.196.1 [T]

Hostname: atlanta_target_2 [T]
Chicago Atlanta

Enter information for the first destination

(target – ETH1) and the local network.

Please provide the following information:

Target Network Address: 10.11.194.0 [T]

Target Network Netmask: 255.255.255. [T]

or ng on a server a s oca on –

Enter information for the first destination

(target – ETH1) and the local network.

Please provide the following information:

Target Network Address: 10.11.195.0 [S]

Target Network Netmask: 255.255.25 [S]

or ng on e server a s oca on –

Enter information for the second destination

(target – ETH2) and the local network.

Please provide the following information:

Target Network Address: 10.11.196. [T]

Local Gateway Address: 10.11.195.1 [S]

[ ]

Local Gateway Address: 10.11.194. [T]

Enter information for the second destination

(target – ETH2) and the local network.

Please provide the following information:

Target Network Address: 10.11.197.0 [S]

Target Network Netmask: 255.255.255. [T]

Local Gateway Address: 10.11.19 [S]

Target Network Netmask: 255.255.255.0 [S]

Local Gateway Address: 10.11.196. [T]
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Figure 82. Configure static routes example
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Worksheets
Use the completed worksheets as a guide when responding to the menu prompts
during M:1 replication configuration.

Complete the worksheets with the necessary information about your SOURCE
(Spoke) and TARGET (Hub) servers. You will use the completed worksheets as a
guide when responding to the system prompts during replication configuration.

i
 

It is strongly recommended that the worksheets be filled out, in advance, by
someone with extensive knowledge of your organization's network and TCP/IP
configuration. This will ensure that the information is technically accurate and
readily available during replication setup.

M:1 Replication Setup

TARGET SERVER UPDATE REPLICATION NETWORK WORKSHEET

Use the blank spaces below to write in your TARGET server’s Server Name; and the IP Address, Network

Netmask, Gateway Address, and Hostname for your TARGET server’s replication ports. You will use this

information as you complete the Update Replication Network option on the PT Configuration Menu.

Refer to Example 1. Network Settings, for a reminder of the information required to complete this worksheet.

Replication Port 1 (ETH1)

IP Address: _______._______._______._______ [T]

Network Netmask: _______._______._______._______ [T]

My TARGET server’s network settings –TARGET

[T]

Gateway Address: _______._______._______._______ [T]

Hostname: ______________________________ [T]

Replication Port 2 (ETH2)
Server Name

IP Address: _______._______._______._______ [T]

Network Netmask: _______._______._______._______ [T]

Gateway Address: _______._______._______._______ [T]

Hostname: _____________________________ [T]

ts
7
6
0
8
2
6

Figure 83. Update replication network worksheet – TARGET
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M:1 Replication Setup

SOURCE SERVER UPDATE REPLICATION NETWORK WORKSHEET

Use the blank spaces below to write in one SOURCE server’s Server Name; and the IP Address, Network

Netmask, Gateway Address, and Hostname of that server’s replication ports. You will use this information as

you complete the Update Replication Network option on the PT Configuration Menu.

Tip: Fill out a separate worksheet for each SOURCE server in your replication network. Individual worksheets

are provided to accommodate entries for up to four SOURCE servers. Depending upon your replication

environment, you may not need to complete all four worksheets.

Refer to Example 1. Network Settings, for a reminder of the information required to complete this worksheet.

Replication Port 1 (ETH1)

My SOURCE server’s network settings –SOURCE

[S]

p

IP Address: _______._______._______._______ [S]

Network Netmask: _______._______._______._______ [S]

Gateway Address: _______._______._______._______ [S]

Hostname: [S]______________________________

Replication Port 2 (ETH2)

IP Address: _______._______._______._______ [S]

Network Netmask: [S]

Server Name

_______._______._______._______

Gateway Address: _______._______._______._______ [S]

Hostname: ______________________________ [S]
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Figure 84. Update replication network worksheet – SOURCE 1
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M:1 Replication Setup

SOURCE SERVER UPDATE REPLICATION NETWORK WORKSHEET

Use the blank spaces below to write in one SOURCE server’s Server Name; and the IP Address, Network

Netmask, Gateway Address, and Hostname of that server’s replication ports. You will use this information as

you complete the Update Replication Network option on the PT Configuration Menu.

Tip: Fill out a separate worksheet for each SOURCE server in your replication network. Individual worksheets

are provided to accommodate entries for up to four SOURCE servers. Depending upon your replication

environment, you may not need to complete all four worksheets.

Refer to Example 1. Network Settings, for a reminder of the information required to complete this worksheet.

Replication Port 1 (ETH1)

My SOURCE server’s network settings –SOURCE

[S]

p

IP Address: _______._______._______._______ [S]

Network Netmask: _______._______._______._______ [S]

Gateway Address: _______._______._______._______ [S]

Hostname: [S]______________________________

Replication Port 2 (ETH2)

IP Address: _______._______._______._______ [S]

Network Netmask: [S]

Server Name

_______._______._______._______

Gateway Address: _______._______._______._______ [S]

Hostname: ______________________________ [S]
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Figure 85. Update replication network worksheet – SOURCE 2
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M:1 Replication Setup

SOURCE SERVER UPDATE REPLICATION NETWORK WORKSHEET

Use the blank spaces below to write in one SOURCE server’s Server Name; and the IP Address, Network

Netmask, Gateway Address, and Hostname of that server’s replication ports. You will use this information as

you complete the Update Replication Network option on the PT Configuration Menu.

Tip: Fill out a separate worksheet for each SOURCE server in your replication network. Individual worksheets

are provided to accommodate entries for up to four SOURCE servers. Depending upon your replication

environment, you may not need to complete all four worksheets.

Refer to Example 1. Network Settings, for a reminder of the information required to complete this worksheet.

Replication Port 1 (ETH1)

My SOURCE server’s network settings –SOURCE

[S]

p

IP Address: _______._______._______._______ [S]

Network Netmask: _______._______._______._______ [S]

Gateway Address: _______._______._______._______ [S]

Hostname: [S]______________________________

Replication Port 2 (ETH2)

IP Address: _______._______._______._______ [S]

Network Netmask: [S]

Server Name

_______._______._______._______

Gateway Address: _______._______._______._______ [S]

Hostname: ______________________________ [S]
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Figure 86. Update replication network worksheet – SOURCE 3
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M:1 Replication Setup

SOURCE SERVER UPDATE REPLICATION NETWORK WORKSHEET

Use the blank spaces below to write in one SOURCE server’s Server Name; and the IP Address, Network

Netmask, Gateway Address, and Hostname of that server’s replication ports. You will use this information as

you complete the Update Replication Network option on the PT Configuration Menu.

Tip: Fill out a separate worksheet for each SOURCE server in your replication network. Individual worksheets

are provided to accommodate entries for up to four SOURCE servers. Depending upon your replication

environment, you may not need to complete all four worksheets.

Refer to Example 1. Network Settings, for a reminder of the information required to complete this worksheet.

Replication Port 1 (ETH1)

My SOURCE server’s network settings –SOURCE

[S]

p

IP Address: _______._______._______._______ [S]

Network Netmask: _______._______._______._______ [S]

Gateway Address: _______._______._______._______ [S]

Hostname: [S]______________________________

Replication Port 2 (ETH2)

IP Address: _______._______._______._______ [S]

Network Netmask: [S]

Server Name

_______._______._______._______

Gateway Address: _______._______._______._______ [S]

Hostname: ______________________________ [S]
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Figure 87. Update replication network worksheet – SOURCE 4
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M:1 Replication Setup

CONFIGURE STATIC ROUTES WORKSHEET

Use the blank spaces below to write in the information required to complete the Configure Static Routes

option on the PT Configuration Menu.

Important! The Configure Static Routes option must be completed on each SOURCE server and on the

TARGET server, at their respective locations.

Fill out a separate worksheet for each SOURCE server in your replication network. Individual worksheets are

provided to accommodate entries for up to four SOURCE servers. Depending upon your replication

environment, you may not need to complete all four worksheets.

Tip: In the prompts below, the term Target Network Address refers to the server’s starting network address.p p ,

To determine the starting network address, replace the digits after the last (.) in the server’s IP Address, with a

zero (0). See the related Tip: in Example 3. Configure Static Routes for more information.

Refer to your completed Network Settings Worksheets for the IP Address, Network Netmask, and Gateway

Address, of the SOURCE and TARGET servers’ replication ports.

Working at a SOURCE server at its location –

Enter information for the first destination (target – ETH1)

and the local network.

Target Network Address: _______._______._______._______ [T]

Target Network Netmask: _______._______._______._______ [T]

Local Gateway Address: _______._______._______._______ [S]

SOURCE

[S]

Server Name

Enter information for the second destination (target – ETH2)

and the local network.

Target Network Address: _______._______._______._______ [T]

Target Network Netmask: _______._______._______._______ [T]

[S]

Working at the TARGET server at its location –

Local Gateway Address: _______._______._______._______

TARGET

[T]

Enter information for the first destination (target – ETH1)

and the local network.

Target Network Address: _______._______._______._______ [S]

Target Network Netmask: _______._______._______._______ [S]

Local Gateway Address: _______._______._______._______ [T]

Enter information for the second destination (target – ETH2)

and the local network.

Server Name

Target Network Address: _______._______._______._______ [S]

Target Network Netmask: _______._______._______._______ [S]

Local Gateway Address: _______._______._______._______ [T]
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Figure 88. Configure static routes worksheet – SOURCE 1 and TARGET
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M:1 Replication Setup

CONFIGURE STATIC ROUTES WORKSHEET

Use the blank spaces below to write in the information required to complete the Configure Static Routes

option on the PT Configuration Menu.

Important! The Configure Static Routes option must be completed on each SOURCE server and on the

TARGET server, at their respective locations.

Fill out a separate worksheet for each SOURCE server in your replication network. Individual worksheets are

provided to accommodate entries for up to four SOURCE servers. Depending upon your replication

environment, you may not need to complete all four worksheets.

Tip: In the prompts below, the term Target Network Address refers to the server’s starting network address.p p ,

To determine the starting network address, replace the digits after the last (.) in the server’s IP Address, with a

zero (0). See the related Tip: in Example 3. Configure Static Routes for more information.

Refer to your completed Network Settings Worksheets for the IP Address, Network Netmask, and Gateway

Address, of the SOURCE and TARGET servers’ replication ports.

Working at a SOURCE server at its location –

Enter information for the first destination (target – ETH1)

and the local network.

Target Network Address: _______._______._______._______ [T]

Target Network Netmask: _______._______._______._______ [T]

Local Gateway Address: _______._______._______._______ [S]

SOURCE

[S]

Server Name

Enter information for the second destination (target – ETH2)

and the local network.

Target Network Address: _______._______._______._______ [T]

Target Network Netmask: _______._______._______._______ [T]

[S]

Working at the TARGET server at its location –

Local Gateway Address: _______._______._______._______

TARGET

[T]

Enter information for the first destination (target – ETH1)

and the local network.

Target Network Address: _______._______._______._______ [S]

Target Network Netmask: _______._______._______._______ [S]

Local Gateway Address: _______._______._______._______ [T]

Enter information for the second destination (target – ETH2)

and the local network.

Server Name

Target Network Address: _______._______._______._______ [S]

Target Network Netmask: _______._______._______._______ [S]

Local Gateway Address: _______._______._______._______ [T]
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Figure 89. Configure static routes worksheet – SOURCE 2 and TARGET
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M:1 Replication Setup

CONFIGURE STATIC ROUTES WORKSHEET

Use the blank spaces below to write in the information required to complete the Configure Static Routes

option on the PT Configuration Menu.

Important! The Configure Static Routes option must be completed on each SOURCE server and on the

TARGET server, at their respective locations.

Fill out a separate worksheet for each SOURCE server in your replication network. Individual worksheets are

provided to accommodate entries for up to four SOURCE servers. Depending upon your replication

environment, you may not need to complete all four worksheets.

Tip: In the prompts below, the term Target Network Address refers to the server’s starting network address.p p ,

To determine the starting network address, replace the digits after the last (.) in the server’s IP Address, with a

zero (0). See the related Tip: in Example 3. Configure Static Routes for more information.

Refer to your completed Network Settings Worksheets for the IP Address, Network Netmask, and Gateway

Address, of the SOURCE and TARGET servers’ replication ports.

Working at a SOURCE server at its location –

Enter information for the first destination (target – ETH1)

and the local network.

Target Network Address: _______._______._______._______ [T]

Target Network Netmask: _______._______._______._______ [T]

Local Gateway Address: _______._______._______._______ [S]

SOURCE

[S]

Server Name

Enter information for the second destination (target – ETH2)

and the local network.

Target Network Address: _______._______._______._______ [T]

Target Network Netmask: _______._______._______._______ [T]

[S]

Working at the TARGET server at its location –

Local Gateway Address: _______._______._______._______

TARGET

[T]

Enter information for the first destination (target – ETH1)

and the local network.

Target Network Address: _______._______._______._______ [S]

Target Network Netmask: _______._______._______._______ [S]

Local Gateway Address: _______._______._______._______ [T]

Enter information for the second destination (target – ETH2)

and the local network.

Server Name

Target Network Address: _______._______._______._______ [S]

Target Network Netmask: _______._______._______._______ [S]

Local Gateway Address: _______._______._______._______ [T]
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Figure 90. Configure static routes worksheet – SOURCE 3 and TARGET
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M:1 Replication Setup

CONFIGURE STATIC ROUTES WORKSHEET

Use the blank spaces below to write in the information required to complete the Configure Static Routes

option on the PT Configuration Menu.

Important! The Configure Static Routes option must be completed on each SOURCE server and on the

TARGET server, at their respective locations.

Fill out a separate worksheet for each SOURCE server in your replication network. Individual worksheets are

provided to accommodate entries for up to four SOURCE servers. Depending upon your replication

environment, you may not need to complete all four worksheets.

Tip: In the prompts below, the term Target Network Address refers to the server’s starting network address.p p ,

To determine the starting network address, replace the digits after the last (.) in the server’s IP Address, with a

zero (0). See the related Tip: in Example 3. Configure Static Routes for more information.

Refer to your completed Network Settings Worksheets for the IP Address, Network Netmask, and Gateway

Address, of the SOURCE and TARGET servers’ replication ports.

Working at a SOURCE server at its location –

Enter information for the first destination (target – ETH1)

and the local network.

Target Network Address: _______._______._______._______ [T]

Target Network Netmask: _______._______._______._______ [T]

Local Gateway Address: _______._______._______._______ [S]

SOURCE

[S]

Server Name

Enter information for the second destination (target – ETH2)

and the local network.

Target Network Address: _______._______._______._______ [T]

Target Network Netmask: _______._______._______._______ [T]

[S]

Working at the TARGET server at its location –

Local Gateway Address: _______._______._______._______

TARGET

[T]

Enter information for the first destination (target – ETH1)

and the local network.

Target Network Address: _______._______._______._______ [S]

Target Network Netmask: _______._______._______._______ [S]

Local Gateway Address: _______._______._______._______ [T]

Enter information for the second destination (target – ETH2)

and the local network.

Server Name

Target Network Address: _______._______._______._______ [S]

Target Network Netmask: _______._______._______._______ [S]

Local Gateway Address: _______._______._______._______ [T]

ts
7
6
0
8
2
4

Figure 91. Configure static routes worksheet – SOURCE 4 and TARGET
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Appendix C. Worldwide time zone codes

Use the information in the following table to help you set the system's time zone.

Time zone codes

The following table lists all of the worldwide time zone codes and the associated
time zone descriptions. Additional information about the time zone is located in
the Comments column.

Code Time zone Comments

AD Europe/Andorra

AE Asia/Dubai

AF Asia/Kabul

AG America/Antigua

AI America/Anguilla

AL Europe/Tirane

AM Asia/Yerevan

AN America/Curacao

AO Africa/Luanda

AQ Antarctica/McMurdo McMurdo Station, Ross Island

AQ Antarctica/South_Pole Amundsen-Scott Station, South Pole

AQ Antarctica/Rothera Rothera Station, Adelaide Island

AQ Antarctica/Palmer Palmer Station, Anvers Island

AQ Antarctica/Mawson Mawson Station, Holme Bay

AQ Antarctica/Davis Davis Station, Vestfold Hills

AQ Antarctica/Casey Casey Station, Bailey Peninsula

AQ Antarctica/Vostok Vostok Station, S Magnetic Pole

AQ Antarctica/DumontDUrville Dumont-d'Urville Station, Terre Adelie

AQ Antarctica/Syowa Syowa Station, E Ongul I

AR America/Argentina/Buenos_Aires Buenos Aires (BA, CF)

AR America/Argentina/Cordoba most locations (CB, CC, CN, ER, FM, LP, MN, NQ,
RN, SA, SE, SF, SL)

AR America/Argentina/Jujuy Jujuy (JY)

AR America/Argentina/Tucuman Tucuman (TM)

AR America/Argentina/Catamarca Catamarca (CT), Chubut (CH)

AR America/Argentina/La_Rioja La Rioja (LR)

AR America/Argentina/San_Juan San Juan (SJ)

AR America/Argentina/Mendoza Mendoza (MZ)

AR America/Argentina/Rio_Gallegos Santa Cruz (SC)

AR America/Argentina/Ushuaia Tierra del Fuego (TF)

AS Pacific/Pago_Pago
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Code Time zone Comments

AT Europe/Vienna

AU Australia/Lord_Howe Lord Howe Island

AU Australia/Hobart Tasmania - most locations

AU Australia/Currie Tasmania - King Island

AU Australia/Melbourne Victoria

AU Australia/Sydney New South Wales - most locations

AU Australia/Broken_Hill New South Wales - Yancowinna

AU Australia/Brisbane Queensland - most locations

AU Australia/Lindeman Queensland - Holiday Islands

AU Australia/Adelaide South Australia

AU Australia/Darwin Northern Territory

AU Australia/Perth Western Australia - most locations

AU Australia/Eucla Western Australia - Eucla area

AW America/Aruba

AX Europe/Mariehamn

AZ Asia/Baku

BA Europe/Sarajevo

BB America/Barbados

BD Asia/Dhaka

BE Europe/Brussels

BF Africa/Ouagadougou

BG Europe/Sofia

BH Asia/Bahrain

BI Africa/Bujumbura

BJ Africa/Porto-Novo

BL America/St_Barthelemy

BM Atlantic/Bermuda

BN Asia/Brunei

BO America/La_Paz

BR America/Noronha Atlantic islands

BR America/Belem Amapa, E Para

BR America/Fortaleza NE Brazil (MA, PI, CE, RN, PB)

BR America/Recife Pernambuco

BR America/Araguaina Tocantins

BR America/Maceio Alagoas, Sergipe

BR America/Bahia Bahia

BR America/Sao_Paulo S & SE Brazil (GO, DF, MG, ES, RJ, SP, PR, SC, RS)

BR America/Campo_Grande Mato Grosso do Sul

BR America/Cuiaba Mato Grosso

BR America/Porto_Velho W Para, Rondonia

BR America/Boa_Vista Roraima
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Code Time zone Comments

BR America/Manaus E Amazonas

BR America/Eirunepe W Amazonas

BR America/Rio_Branco Acre

BS America/Nassau

BT Asia/Thimphu

BW Africa/Gaborone

BY Europe/Minsk

BZ America/Belize

CA America/St_Johns Newfoundland Time, including SE Labrador

CA America/Halifax Atlantic Time - Nova Scotia (most places), PEI

CA America/Glace_Bay Atlantic Time - Nova Scotia - places that did not
observe DST 1966-1971

CA America/Moncton Atlantic Time - New Brunswick

CA America/Goose_Bay Atlantic Time - Labrador - most locations

CA America/Blanc-Sablon Atlantic Standard Time - Quebec - Lower North
Shore

CA America/Montreal Eastern Time - Quebec - most locations

CA America/Toronto Eastern Time - Ontario - most locations

CA America/Nipigon Eastern Time - Ontario & Quebec - places that did
not observe DST 1967-1973

CA America/Thunder_Bay Eastern Time - Thunder Bay, Ontario

CA America/Iqaluit Eastern Time - east Nunavut - most locations

CA America/Pangnirtung Eastern Time - Pangnirtung, Nunavut

CA America/Resolute Eastern Time - Resolute, Nunavut

CA America/Atikokan Eastern Standard Time - Atikokan, Ontario and
Southampton I, Nunavut

CA America/Rankin_Inlet Central Time - central Nunavut

CA America/Winnipeg Central Time - Manitoba & west Ontario

CA America/Rainy_River Central Time - Rainy River & Fort Frances, Ontario

CA America/Regina Central Standard Time - Saskatchewan - most
locations

CA America/Swift_Current Central Standard Time - Saskatchewan - midwest

CA America/Edmonton Mountain Time - Alberta, east British Columbia &
west Saskatchewan

CA America/Cambridge_Bay Mountain Time - west Nunavut

CA America/Yellowknife Mountain Time - central Northwest Territories

CA America/Inuvik Mountain Time - west Northwest Territories

CA America/Dawson_Creek Mountain Standard Time - Dawson Creek & Fort
Saint John, British Columbia

CA America/Vancouver Pacific Time - west British Columbia

CA America/Whitehorse Pacific Time - south Yukon

CA America/Dawson Pacific Time - north Yukon

CC Indian/Cocos
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CD Africa/Kinshasa west Dem. Rep. of Congo

CD Africa/Lubumbashi east Dem. Rep. of Congo

CF Africa/Bangui

CG Africa/Brazzaville

CH Europe/Zurich

CI Africa/Abidjan

CK Pacific/Rarotonga

CL America/Santiago most locations

CL Pacific/Easter Easter Island & Sala y Gomez

CM Africa/Douala

CN Asia/Shanghai east China - Beijing, Guangdong, Shanghai, etc.

CN Asia/Harbin Heilongjiang (except Mohe), Jilin

CN Asia/Chongqing central China - Sichuan, Yunnan, Guangxi, Shaanxi,
Guizhou, etc.

CN Asia/Urumqi most of Tibet & Xinjiang

CN Asia/Kashgar west Tibet & Xinjiang

CO America/Bogota

CR America/Costa_Rica

CU America/Havana

CV Atlantic/Cape_Verde

CX Indian/Christmas

CY Asia/Nicosia

CZ Europe/Prague

DE Europe/Berlin

DJ Africa/Djibouti

DK Europe/Copenhagen

DM America/Dominica

DO America/Santo_Domingo

DZ Africa/Algiers

EC America/Guayaquil mainland

EC Pacific/Galapagos Galapagos Islands

EE Europe/Tallinn

EG Africa/Cairo

EH Africa/El_Aaiun

ER Africa/Asmara

ES Europe/Madrid mainland

ES Africa/Ceuta Ceuta & Melilla

ES Atlantic/Canary Canary Islands

ET Africa/Addis_Ababa

FI Europe/Helsinki

FJ Pacific/Fiji
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FK Atlantic/Stanley

FM Pacific/Truk Truk (Chuuk) and Yap

FM Pacific/Ponape Ponape (Pohnpei)

FM Pacific/Kosrae Kosrae

FO Atlantic/Faroe

FR Europe/Paris

GA Africa/Libreville

GB Europe/London

GD America/Grenada

GE Asia/Tbilisi

GF America/Cayenne

GG Europe/Guernsey

GH Africa/Accra

GI Europe/Gibraltar

GL America/Godthab most locations

GL America/Danmarkshavn east coast, north of Scoresbysund

GL America/Scoresbysund Scoresbysund / Ittoqqortoormiit

GL America/Thule Thule / Pituffik

GM Africa/Banjul

GN Africa/Conakry

GP America/Guadeloupe

GQ Africa/Malabo

GR Europe/Athens

GS Atlantic/South_Georgia

GT America/Guatemala

GU Pacific/Guam

GW Africa/Bissau

GY America/Guyana

HK Asia/Hong_Kong

HN America/Tegucigalpa

HR Europe/Zagreb

HT America/Port-au-Prince

HU Europe/Budapest

ID Asia/Jakarta Java & Sumatra

ID Asia/Pontianak west & central Borneo

ID Asia/Makassar east & south Borneo, Celebes, Bali, Nusa Tengarra,
west Timor

ID Asia/Jayapura Irian Jaya & the Moluccas

IE Europe/Dublin

IL Asia/Jerusalem

IM Europe/Isle_of_Man
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IN Asia/Calcutta

IO Indian/Chagos

IQ Asia/Baghdad

IR Asia/Tehran

IS Atlantic/Reykjavik

IT Europe/Rome

JE Europe/Jersey

JM America/Jamaica

JO Asia/Amman

JP Asia/Tokyo

KE Africa/Nairobi

KG Asia/Bishkek

KH Asia/Phnom_Penh

KI Pacific/Tarawa Gilbert Islands

KI Pacific/Enderbury Phoenix Islands

KI Pacific/Kiritimati Line Islands

KM Indian/Comoro

KN America/St_Kitts

KP Asia/Pyongyang

KR Asia/Seoul

KW Asia/Kuwait

KY America/Cayman

KZ Asia/Almaty most locations

KZ Asia/Qyzylorda Qyzylorda (Kyzylorda, Kzyl-Orda)

KZ Asia/Aqtobe Aqtobe (Aktobe)

KZ Asia/Aqtau Atyrau (Atirau, Gur'yev), Mangghystau (Mankistau)

KZ Asia/Oral West Kazakhstan

LA Asia/Vientiane

LB Asia/Beirut

LC America/St_Lucia

LI Europe/Vaduz

LK Asia/Colombo

LR Africa/Monrovia

LS Africa/Maseru

LT Europe/Vilnius

LU Europe/Luxembourg

LV Europe/Riga

LY Africa/Tripoli

MA Africa/Casablanca

MC Europe/Monaco

MD Europe/Chisinau
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ME Europe/Podgorica

MF America/Marigot

MG Indian/Antananarivo

MH Pacific/Majuro most locations

MH Pacific/Kwajalein Kwajalein

MK Europe/Skopje

ML Africa/Bamako

MM Asia/Rangoon

MN Asia/Ulaanbaatar most locations

MN Asia/Hovd Bayan-Olgiy, Govi-Altai, Hovd, Uvs, Zavkhan

MN Asia/Choibalsan Dornod, Sukhbaatar

MO Asia/Macau

MP Pacific/Saipan

MQ America/Martinique

MR Africa/Nouakchott

MS America/Montserrat

MT Europe/Malta

MU Indian/Mauritius

MV Indian/Maldives

MW Africa/Blantyre

MX America/Mexico_City Central Time - most locations

MX America/Cancun Central Time - Quintana Roo

MX America/Merida Central Time - Campeche, Yucatan

MX America/Monterrey Central Time - Coahuila, Durango, Nuevo Leon,
Tamaulipas

MX America/Mazatlan Mountain Time - S Baja, Nayarit, Sinaloa

MX America/Chihuahua Mountain Time - Chihuahua

MX America/Hermosillo Mountain Standard Time - Sonora

MX America/Tijuana Pacific Time

MY Asia/Kuala_Lumpur peninsular Malaysia

MY Asia/Kuching Sabah & Sarawak

MZ Africa/Maputo

NA Africa/Windhoek

NC Pacific/Noumea

NE Africa/Niamey

NF Pacific/Norfolk

NG Africa/Lagos

NI America/Managua

NL Europe/Amsterdam

NO Europe/Oslo

NP Asia/Katmandu
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NR Pacific/Nauru

NU Pacific/Niue

NZ Pacific/Auckland most locations

NZ Pacific/Chatham Chatham Islands

OM Asia/Muscat

PA America/Panama

PE America/Lima

PF Pacific/Tahiti Society Islands

PF Pacific/Marquesas Marquesas Islands

PF Pacific/Gambier Gambier Islands

PG Pacific/Port_Moresby

PH Asia/Manila

PK Asia/Karachi

PL Europe/Warsaw

PM America/Miquelon

PN Pacific/Pitcairn

PR America/Puerto_Rico

PS Asia/Gaza

PT Europe/Lisbon mainland

PT Atlantic/Madeira Madeira Islands

PT Atlantic/Azores Azores

PW Pacific/Palau

PY America/Asuncion

QA Asia/Qatar

RE Indian/Reunion

RO Europe/Bucharest

RS Europe/Belgrade

RU Europe/Kaliningrad Moscow-01 - Kaliningrad

RU Europe/Moscow Moscow+00 - west Russia

RU Europe/Volgograd Moscow+00 - Caspian Sea

RU Europe/Samara Moscow+01 - Samara, Udmurtia

RU Asia/Yekaterinburg Moscow+02 - Urals

RU Asia/Omsk Moscow+03 - west Siberia

RU Asia/Novosibirsk Moscow+03 - Novosibirsk

RU Asia/Krasnoyarsk Moscow+04 - Yenisei River

RU Asia/Irkutsk Moscow+05 - Lake Baikal

RU Asia/Yakutsk Moscow+06 - Lena River

RU Asia/Vladivostok Moscow+07 - Amur River

RU Asia/Sakhalin Moscow+07 - Sakhalin Island

RU Asia/Magadan Moscow+08 - Magadan

RU Asia/Kamchatka Moscow+09 - Kamchatka
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RU Asia/Anadyr Moscow+10 - Bering Sea

RW Africa/Kigali

SA Asia/Riyadh

SB Pacific/Guadalcanal

SC Indian/Mahe

SD Africa/Khartoum

SE Europe/Stockholm

SG Asia/Singapore

SH Atlantic/St_Helena

SI Europe/Ljubljana

SJ Arctic/Longyearbyen

SK Europe/Bratislava

SL Africa/Freetown

SM Europe/San_Marino

SN Africa/Dakar

SO Africa/Mogadishu

SR America/Paramaribo

ST Africa/Sao_Tome

SV America/El_Salvador

SY Asia/Damascus

SZ Africa/Mbabane

TC America/Grand_Turk

TD Africa/Ndjamena

TF Indian/Kerguelen

TG Africa/Lome

TH Asia/Bangkok

TJ Asia/Dushanbe

TK Pacific/Fakaofo

TL Asia/Dili

TM Asia/Ashgabat

TN Africa/Tunis

TO Pacific/Tongatapu

TR Europe/Istanbul

TT America/Port_of_Spain

TV Pacific/Funafuti

TW Asia/Taipei

TZ Africa/Dar_es_Salaam

UA Europe/Kiev most locations

UA Europe/Uzhgorod Ruthenia

UA Europe/Zaporozhye Zaporozh'ye, E Lugansk / Zaporizhia, E Luhansk

UA Europe/Simferopol central Crimea
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UG Africa/Kampala

UM Pacific/Johnston Johnston Atoll

UM Pacific/Midway Midway Islands

UM Pacific/Wake Wake Island

US America/New_York Eastern Time

US America/Detroit Eastern Time - Michigan - most locations

US America/Kentucky/Louisville Eastern Time - Kentucky - Louisville area

US America/Kentucky/Monticello Eastern Time - Kentucky - Wayne County

US America/Indiana/Indianapolis Eastern Time - Indiana - most locations

US America/Indiana/Vincennes Eastern Time - Indiana - Daviess, Dubois, Knox &
Martin Counties

US America/Indiana/Knox Eastern Time - Indiana - Starke County

US America/Indiana/Winamac Eastern Time - Indiana - Pulaski County

US America/Indiana/Marengo Eastern Time - Indiana - Crawford County

US America/Indiana/Vevay Eastern Time - Indiana - Switzerland County

US America/Chicago Central Time

US America/Indiana/Tell_City Central Time - Indiana - Perry County

US America/Indiana/Petersburg Central Time - Indiana - Pike County

US America/Menominee Central Time - Michigan - Dickinson, Gogebic, Iron &
Menominee Counties

US America/North_Dakota/Center Central Time - North Dakota - Oliver County

US America/North_Dakota/New_Salem Central Time - North Dakota - Morton County
(except Mandan area)

US America/Denver Mountain Time

US America/Boise Mountain Time - south Idaho & east Oregon

US America/Shiprock Mountain Time - Navajo

US America/Phoenix Mountain Standard Time - Arizona

US America/Los_Angeles Pacific Time

US America/Anchorage Alaska Time

US America/Juneau Alaska Time - Alaska panhandle

US America/Yakutat Alaska Time - Alaska panhandle neck

US America/Nome Alaska Time - west Alaska

US America/Adak Aleutian Islands

US Pacific/Honolulu Hawaii

UY America/Montevideo

UZ Asia/Samarkand west Uzbekistan

UZ Asia/Tashkent east Uzbekistan

VA Europe/Vatican

VC America/St_Vincent

VE America/Caracas

VG America/Tortola

VI America/St_Thomas
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VN Asia/Saigon

VU Pacific/Efate

WF Pacific/Wallis

WS Pacific/Apia

YE Asia/Aden

YT Indian/Mayotte

ZA Africa/Johannesburg

ZM Africa/Lusaka

ZW Africa/Harare
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Appendix D. Country codes

Use the information in the Country codes table to convert a country to a
two-character code. For example, code for Spain = es.

If you are planning to enable the Call Home feature, you must enter your country
code (see Table 43) on the Registration page of the ProtecTIER Manager
Configuration menu.

Table 43. Country codes

Country Code Country Code Country Code Country Code Country Code

Afghanistan af Cook Islands ck Iceland is Nauru nr Solomon Islands sb

Albania al Costa Rica cr India in Nepal np Somalia so

Algeria dz Croatia hr Indonesia id Netherlands nl South Africa za

American
Samoa

as Cuba cu Iran ir Netherlands
Antilles

an South Korea kr

Andorra ad Cyprus cy Iraq iq Neutral Zone nt Spain es

Angola ao Czech Republic cz Ireland ie New
Caledonia
(French)

nc Sri Lanka lk

Anguilla ai Denmark dk Israel il New Zealand nz Sudan sd

Antarctica aq Djibouti dj Italy it Nicaragua ni Suriname sr

Antigua and
Barbuda

ag Dominica dm Ivory Coast
(Cote
D'Ivoire)

ci Niger ne Svalbard and Jan
Mayen Islands

sj

Argentina ar Dominican
Republic

do Jamaica jm Nigeria ng Swaziland sz

Armenia am East Timor tp Japan jp Niue nu Sweden se

Aruba aw Ecuador ec Jordan jo Norfolk Island nf Switzerland ch

Australia au Egypt eg Kazakhstan kz North Korea kp Syria sy

Austria at El Salvador sv Kenya ke Northern
Mariana
Islands

mp Tajikistan tj

Azerbaijan az Equatorial
Guinea

gq Kiribati ki Norway no Taiwan tw

Bahamas bs Eritrea er Kuwait kw Oman om Tanzania tz

Bahrain bh Estonia ee Kyrgyzstan kg Pakistan pk Thailand th

Bangladesh bd Ethiopia et Laos la Palau pw Togo tg

Barbados bb Falkland
Islands

fk Latvia lv Panama pa Tokelau tk

Belarus by Faroe Islands fo Lebanon lb Papua New
Guinea

pg Tonga to

Belgium be Fiji fj Lesotho ls Paraguay py Trinidad and
Tobago

tt

Belize bz Finland fi Liberia lr Peru pe Tunisia tn

Benin bj Former
Czechoslovakia

cs Libya ly Philippines ph Turkey tr

Bermuda bm Former USSR su Liechtenstein li Pitcairn Island pn Turkmenistan tm

Bhutan bt France fr Lithuania lt Poland pl Turks and Caicos
Islands

tc
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Country Code Country Code Country Code Country Code Country Code

Bolivia bo France
(European
Territory)

fx Luxembourg lu Polynesia
(French)

pf Tuvalu tv

Bosnia-
Herzegovina

ba French Guyana gf Macau mo Portugal pt Uganda ug

Botswana bw French
Southern
Territories

tf Macedonia mk Puerto Rico pr Ukraine ua

Bouvet
Island

bv Gabon ga Madagascar mg Qatar qa United Arab
Emirates

ae

Brazil br Gambia gm Malawi mw Reunion
(French)

re United Kingdom uk

British
Indian
Ocean
Territory

io Georgia ge Malaysia my Romania ro United States of
America

us

Brunei
Darussalam

bn Germany de Maldives mv Russian
Federation

ru Uruguay uy

Bulgaria bg Ghana gh Mali ml Rwanda rw USA Minor
Outlying Islands

um

Burkina
Faso

bf Gibraltar gi Malta mt S. Georgia &
S. Sandwich
Isles

gs Uzbekistan uz

Burundi bi Great Britain gb Marshall
Islands

mh Saint Helena sh Vanuatu vu

Cambodia kh Greece gr Martinique
(French)

mq Saint Kitts &
Nevis
Anguilla

kn Vatican City State va

Cameroon cm Greenland gl Mauritania mr Saint Lucia lc Venezuela ve

Canada ca Grenada gd Mauritius mu Saint Pierre
and Miquelon

pm Vietnam vn

Cape Verde cv Guadeloupe
(French)

gp Mayotte yt Saint Tome
(Sao Tome)
and Principe

st Virgin Islands
(British)

vg

Cayman
Islands

ky Guam (USA) gu Mexico mx Saint Vincent
& Grenadines

vc Virgin Islands
(USA)

vi

Central
African
Republic

cf Guatemala gt Micronesia fm Samoa ws Wallis and
Futuna Islands

wf

Chad td Guinea gn Moldavia md San Marino sm Western Sahara eh

Chile cl Guinea Bissau gw Monaco mc Saudi Arabia sa Yemen ye

China cn Guyana gy Mongoliar mn Senegal sn Yugoslavia yu

Christmas
Island

cx Haiti ht Montserrat ms Seychelles sc Zaire zr

Cocos
(Keeling)
Islands

cc Heard and
McDonald
Islands

hm Morocco ma Sierra Leon sl Zambia zm

Colombia co Honduras hn Mozambique mz Singapore sg Zimbabwe zw

Comoros km Hong Kong hk Myanmar mm Slovak
Republic

sk

Congo cg Hungary hy Namibia na Slovenia si
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Accessibility

The publications for this product are in Adobe Portable Document Format (PDF)
and should be compliant with accessibility standards.

If you experience difficulties when you use the PDF files and want to request a
Web-based format for a publication, send your request to the following address:

International Business Machines Corporation
Information Development
Department GZW
9000 South Rita Road
Tucson, Arizona 85744-001 U.S.A

In the request, be sure to include the publication number and title. When you send
information to IBM, you grant IBM a nonexclusive right to use or distribute the
information in any way it believes appropriate without incurring any obligation to
you.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATIONS "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurement may have been
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estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

Trademarks

The following terms are trademarks of the International Business Machines
Corporation in the United States, other countries, or both:
v AIX®

v DS4000®

v Enterprise Storage Server®

v ESCON
v FICON
v i5/OS™

v iSeries
v IBM
v ProtecTIER
v pSeries
v S/390®

v ServeRAID
v System x
v System Storage
v TotalStorage
v Wake on LAN
v z/OS®

v zSeries

IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of
International Business Machines Corporation in the United States, other countries,
or both. If these and other IBM trademarked terms are marked on their first
occurrence in this information with a trademark symbol ((R) or (TM)), these
symbols indicate U.S. registered or common law trademarks owned by IBM at the
time this information was published. Such trademarks may also be registered or
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common law trademarks in other countries. A current list of IBM trademarks is
available on the Web at "Copyright and trademark information" at
http://www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States,
and/or other countries.

Java™ and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in
the United States, other countries, or both.

Microsoft, Windows, and Windows NT are trademarks of Microsoft Corporation in
the United States, other countries, or both.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States
and other countries.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

Other company, product, and service names may be trademarks or service marks
of others.

Electronic emission notices
This section contains the electronic emission notices or statements for the United
States and other countries.

Federal Communications Commission statement
This explains the Federal Communications Commission's (FCC) statement.

This equipment has been tested and found to comply with the limits for a Class A
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment. This equipment generates, uses, and can
radiate radio frequency energy and, if not installed and used in accordance with
the instruction manual, might cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful
interference, in which case the user will be required to correct the interference at
his own expense.

Properly shielded and grounded cables and connectors must be used in order to
meet FCC emission limits. IBM is not responsible for any radio or television
interference caused by using other than recommended cables and connectors, or by
unauthorized changes or modifications to this equipment. Unauthorized changes
or modifications could void the user's authority to operate the equipment.
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This device complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1) this device might not cause harmful interference, and
(2) this device must accept any interference received, including interference that
might cause undesired operation.

Industry Canada compliance statement
This Class A digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe A est conform à la norme NMB-003 du
Canada.

European Union Electromagnetic Compatibility Directive
This product is in conformity with the protection requirements of European Union
(EU) Council Directive 2004/108/EC on the approximation of the laws of the
Member States relating to electromagnetic compatibility. IBM cannot accept
responsibility for any failure to satisfy the protection requirements resulting from a
non-recommended modification of the product, including the fitting of non-IBM
option cards.

Attention: This is an EN 55022 Class A product. In a domestic environment this
product might cause radio interference in which case the user might be required to
take adequate measures.

Responsible Manufacturer:

International Business Machines Corp.
New Orchard Road
Armonk, New York 10504
914-499-1900

European community contact:

IBM Deutschland GmbH
IBM Technical Regulations, Department M456
IBM-Allee 1, 71139 Ehningen, Germany

Australia and New Zealand Class A Statement
Attention: This is a Class A product. In a domestic environment this product
might cause radio interference in which case the user might be required to take
adequate measures.

Germany Electromagnetic compatibility directive
Deutschsprachiger EU Hinweis: Hinweis für Geräte der Klasse A EU-Richtlinie
zur Elektromagnetischen Verträglichkeit

Dieses Produkt entspricht den Schutzanforderungen der EU-Richtlinie
2004/108/EG zur Angleichung der Rechtsvorschriften über die elektromagnetische
Verträglichkeit in den EU-Mitgliedsstaaten und hält die Grenzwerte der EN 55022
Klasse A ein.

Um dieses sicherzustellen, sind die Geräte wie in den Handbüchern beschrieben zu
installieren und zu betreiben. Des Weiteren dürfen auch nur von der IBM
empfohlene Kabel angeschlossen werden. IBM übernimmt keine Verantwortung für
die Einhaltung der Schutzanforderungen, wenn das Produkt ohne Zustimmung der
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IBM verändert bzw. wenn Erweiterungskomponenten von Fremdherstellern ohne
Empfehlung der IBM gesteckt/eingebaut werden.

EN 55022 Klasse A Geräte müssen mit folgendem Warnhinweis versehen werden:

"Warnung: Dieses ist eine Einrichtung der Klasse A. Diese Einrichtung kann im
Wohnbereich Funk-Störungen verursachen; in diesem Fall kann vom Betreiber
verlangt werden, angemessene Mabnahmen zu ergreifen und dafür
aufzukommen."

Deutschland: Einhaltung des Gesetzes über die elektromagnetische
Verträglichkeit von Geräten

Dieses Produkt entspricht dem "Gesetz über die elektromagnetische Verträglichkeit
von Geräten (EMVG)." Dies ist die Umsetzung der EU-Richtlinie 2004/108/EG in
der Bundesrepublik Deutschland.

Zulassungsbescheinigung laut dem Deutschen Gesetz über die
elektromagnetische Verträglichkeit von Geräten (EMVG) (bzw. der EMC EG
Richtlinie 2004/108/EG) für Geräte der Klasse A

Dieses Gerät ist berechtigt, in übereinstimmung mit dem Deutschen EMVG das
EG-Konformitätszeichen - CE - zu führen.

Verantwortlich für die Einhaltung der EMV Vorschriften ist der Hersteller:
International Business Machines Corp.
New Orchard Road
Armonk,New York 10504
Tel: 914-499-1900

Der verantwortliche Ansprechpartner des Herstellers in der EU ist:

IBM Deutschland GmbH
Technical Regulations, Abteilung M456
IBM-Allee 1, 71139 Ehningen, Germany

Generelle Informationen:

Das Gerät erfüllt die Schutzanforderungen nach EN 55024 und EN 55022 Klasse
A.

People's Republic of China Class A Electronic Emission
statement
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Taiwan Class A compliance statement

Taiwan contact information

This topic contains the product service contact information for Taiwan.
IBM Taiwan Product Service Contact Information:
IBM Taiwan Corporation
3F, No 7, Song Ren Rd., Taipei Taiwan
Tel: 0800-016-888

Japan Voluntary Control Council for Interference (VCCI) Class
A Statement

Japan Electronics and Information Technology Industries
Association (JEITA) Statement (less than or equal to 20 A per
phase)
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Korean Communications Commission (KCC) Class A
Statement

Russia Electromagnetic Interference (EMI) Class A Statement
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